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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Introduction

Overview of Implementing Oracle Financials Cloud  
You can use the rapid implementation features to implement users, security, enterprise structures, banks, tax, ledgers,
and financial subledgers. This document provides a high-level introduction to Oracle Financials.

Note:  This guide covers the basic requirements used to create an implementation project. The tasks presented in this
document are intended for a quick introduction or pilot implementation. This document doesn't include all setup and
security tasks that are appropriate for a complete implementation.

The rapid implementation setups for Financials include implementing:

• Users

• Enterprise structures

• Bank, branches, and bank accounts

• Tax

• Ledgers

• Business units

• Financial reporting

• Payables and payments

• Assets

• Expense reporting

• Receivables and payments

References to related help accompany each of the steps. Help and additional information are available from:

• Oracle Cloud Help Center (docs.oracle.com)

• Oracle Fusion Applications Help embedded in the applications

Overview of Oracle Financials Cloud  
Oracle Financials delivers a complete solution that includes:

• General Ledger

• Intercompany Accounting

• Payables

• Receivables

• Payments

• Cash Management

1
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• Tax

• Expenses

• Assets

Use these applications with business intelligence, compliance reporting, and mobile data access for:

• Financial accounting

• Transaction processing

• Payment delivery

• Cash reconciliation

• Employee expense processing

• Asset management

2



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 1
Introduction

Access data through pages that contain:

• Navigation tools in the global area of the Home page.

• Icons to navigate to pages.

3
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• Infolets in an Infolets page or work area.

4
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• Panel tabs for tasks, searching, and analytics accessed by icons on the page.

5
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• Transaction details in a work area.

• Transaction details as a separate page.

From the application pages, access:

• Embedded analytics, which enables you to complete a transaction or analyze data.

• Interactive infolets and work areas to view:

◦ Information summaries for a high-level overview.

◦ Information monitoring and drill-down capability.

◦ Transaction information that's central to one or more business processes.

◦ Business intelligence content that's complementary to one or more business processes.

• Real-time reporting for:

◦ Viewing reports and analytics for each individual work area.

◦ Exploring predefined analyses.

6
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◦ Creating and editing analyses from the Reports and Analytics panel tab or work area.

◦ Accessing the Oracle Business Intelligence (BI) Enterprise Edition through the Reports and Analytics
panel tab. See the new objects and changes to existing objects that you made in Oracle BI Enterprise
Edition, which are then available from Oracle Financials.

◦ Viewing and running financial reports from the Financial Reporting Center, which is a single point of
entry for general ledger financial reporting functions. The Financial Reporting Center includes:

- Tools to create and format financial reports, including Financial Reporting Studio and Workspace.
- Live and interactive financial reports with multiple output options, including HTML, PDF, Excel, or

Excel in Query Ready mode using Smart View Enabled formats.
- Drill downs to underlying journals and subledger transactions with the Account Inspector.
- Multiple reporting methods for ad hoc analysis, efficient monitoring, and tracking of key account

balances in real time with the Account Monitor.

Overview of Using Infolets to Identify Issues and
Prioritize Tasks  
Use infolets to gain real-time insight into common financial activities and prioritize your daily activities. Understand
your organization's status using graphs and indicators to focus on issues in general accounting and cash transactions.

This overview gives a brief outline of the General Accounting infolets and the tasks you can accomplish using them.

Navigate to the General Accounting Infolets page using the page control icons on the home page. You can perform the
following activities using infolets:

• Configure individual infolets according to your financial specifications. For example, you can adjust the
thresholds by flipping the infolet to expose the filtering criteria. When you flip the infolet back, the data now
represents the new thresholds.

• Configure infolets in other ways to align with your business practices. For example, you can edit a title using the
Actions icon on the infolet. You can also select what views you want to enable, such as a summary front and
back view or an expanded view displaying additional details.

• Access underlying reports and pages from the information displayed on the infolet. For example, you can drill
down to review the detailed information and make corrections on that same page, if necessary.

• Use the Infolets Repository to enable or disable individual infolets available to you. For example, you can
deselect infolets that you don't need and when you go back to the infolets page, those infolets are hidden.

Overview of Using Work Areas to Streamline Business
Processes  
Use work areas to gain instant insight into your business and identify potential problems with processing transactions.
Work areas are available in areas such as Accounts Payable Invoices, Accounts Receivable, Billing, Advanced Collections,
and Fixed Assets.

7
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Work areas can include the following:

• Infotiles

• Content area

• Actions toolbar

• Tasks panel tab

• Search panel tab

• Reports and Analytics panel tab

Infotiles
Infotiles summarize a high volume of transactional information. You can quickly identify potential problems and
prioritize your daily activities by scanning the infotiles and accessing transaction details.

For example, select an infotile to display corresponding transactional information in the content area. You can also click
links in the infotile to filter the records in greater detail in the content area.

Content Area
The content area displays transactional information related to the infotile you select. You can review the detailed
information and take the necessary action.

For example, click the item link in the table to drill down to transaction-level information. You can perform multiple
actions on the transaction, such as editing the invoice, approving or rejecting the transaction, and posting the invoice to
the ledger.

Actions Toolbar
Use the actions toolbar to perform a range of activities on one or more rows you select in the content area.

For example, select a transaction row and use the View menu to view the transaction in more detail. You can export the
data to an Excel worksheet, detach the pane, approve or reject one or more transactions, as well as apply additional
filters.

Tasks Panel Tab
The Tasks pane includes tasks that are related to the work area and that you have access to perform.

For example, create an invoice, review journal entries, create mass additions, and manage accounting periods within a
task pane.

Search Panel Tab
Search enables you to find a specific transaction using search criteria related to the work area.

For example, search on an invoice number or supplier in the Invoices work area to find a specific transaction.

Reports and Analytics Panel Tab

8
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The Reports and Analytics panel tab contains predefined reports as well as a folder for you to set up your own reports.

For example, use the predefined reports to perform a deeper analysis on invoices above a certain dollar amount without
a PO. You can also access reports that you have copied and modified and stored in your own folder.

Overview of Your System Integrator  
After you determine the applications to implement, complete any steps that are needed for your implementation plan in
Oracle Global Human Resources first to address any dependencies with Oracle Financials.

Your system integrator uses his or her implementation expertise to help you with a smooth transition to Oracle
Financials. They also use the Rapid Implementation task list to help you achieve a successful implementation in the
shortest time possible.

Related Topics

Purchase and Activation of Oracle Cloud Application
Services  
Purchase and activate Oracle Cloud Application Services from the Oracle Cloud website, https://cloud.oracle.com.

The process involves:

• Purchasing and activating your services.

• Verifying that the services are activated, monitoring the services, and performing other administrative tasks.

Purchasing and activating any Oracle Cloud service is described in the Oracle Cloud: Getting Started with Oracle Cloud
guide. Many administrative tasks are covered in the Oracle Cloud: Managing and Monitoring Oracle Cloud guide. All of
the following references in this section point to one of these guides.

Note:  Not everything in these guides is relevant to Oracle Cloud Application Services, for example details about
Oracle Java Cloud Service and Oracle Database Cloud Service.

Terminology and User Privileges
• Before you proceed, you should understand terms that are used in documentation about Oracle Cloud. Refer to

the Oracle Cloud: Getting Started with Oracle Cloud guide.

See: Oracle Cloud Terminology

• You should also be familiar with privileges for users of the Oracle Cloud website or of the actual service. Refer to
the Oracle Cloud: Getting Started with Oracle Cloud guide.

See: Oracle Cloud User Roles and Privileges

9
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Service Purchase and Activation
• Your buyer or an Oracle sales representative order a cloud service and specifies information about the account

administrator during the ordering process. Refer to the Oracle Cloud: Getting Started with Oracle Cloud guide.

See: Oracle Cloud: Getting Started with Oracle Cloud

• The account administrator receives an email with a link to activate the service. As part of activation, the account
administrator provides information about the administrator who performs the functions of both the service
administrator and the identity domain administrator. Refer to the Oracle Cloud: Getting Started with Oracle
Cloud guide.

See: Oracle Cloud: Getting Started with Oracle Cloud

Service Availability in US Government Regions
If you are in noncommercial regions within the US, contact your Oracle account or sales representative for details about
service and feature availability in your regions.

Alternative Versions of Specified Oracle Services
From time to time, at Oracle’s sole discretion, Oracle may make alternative versions of specified Oracle services
available for customers to access on a limited basis. These alternative versions may not have the same feature sets as
the versions of these services for which a fee is paid, and Oracle may terminate and no longer make available these
alternative versions at any time.

Next Steps
• The administrator who was identified during the activation process:

◦ Manages and monitors the service. Refer to the Oracle Cloud: Managing and Monitoring Oracle Cloud
guide.

See: My Account Administration

See: Performing Service-Specific Tasks

◦ Optionally create initial administrator and implementation users before enterprise structures setup.

- Alternatively, the administrator sets up enterprise structures and then creates service users,
including functional implementors.

• Functional implementors perform configuration and setup steps.

• Developers can add features to extend the application.

• Your cloud service will be updated on a regular basis. See Oracle Applications Cloud - Fusion Applications
Update Policy (Doc ID 1966109.1) on My Oracle Support.

10
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2  Oracle Cloud Security

Overview of Implementing Financials Security  
Oracle Financials provides common job roles such as Accounts Payable Manager and General Accounting Manager. You
can use these roles, modify them, or create job roles as needed.

Note:  Since you can assign multiple roles to a user, don't define a role that includes all the accesses needed for every
user.

To review the predefined job roles in Oracle Financials, see the Oracle Fusion Cloud Financials Security Reference guides
in the Oracle Help Center (http://docs.oracle.com).

To find more information on securing your applications, see the Oracle Fusion Cloud ERP Securing ERP guide in the
Oracle Help Center (http://docs.oracle.com).

Related Topics

Other Financials Security Considerations  
Common functionality that's not job specific, such as creating expense reports and timecards, are granted to the
abstract role Enterprise Resource Planning Self Service User. Abstract roles like Employee, Contingent Worker, and
Line Manager also grant access to common functionalities across a wide collection of Oracle Fusion Cloud Applications.

A library of duty roles, packaging access to respective Transaction Business Intelligence subject areas and
corresponding drilldowns, are also available as building blocks to provide self-service reporting access.

Oracle Fusion Cloud Financials includes the following roles that are designed for initial implementation and the ongoing
management of setup and reference data:

• Application Implementation Manager: Used to manage implementation projects and assign implementation
tasks.

• Application Implementation Consultant: Used to access all setup tasks.

• IT Security Manager: Used to access the Security Console to manage roles, users, and security.

• Financial Integration Specialist: Used to plan, coordinate, and supervise all activities related to the integration
of financials information systems.

Note:  For the ongoing management of setup and reference data, the predefined Financial Application
Administrator role provides access to all financial setup tasks.

Separation of Duties Considerations

Separation of duties (SOD) separates activities such as approving, recording, processing, and reconciling results so you
can more easily prevent or detect unintentional errors and willful fraud.

11
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Oracle Financials includes prebuilt roles that can accelerate deployment. To find out whether they could be valuable to
your organization:

1. Gather your FIN stakeholders, for example, the owners of business processes, IT security administrators, and
internal audit / financial governance teams.

2. Identify the prebuilt roles that are relevant to your FIN activities.
3. Determine whether those roles should be used as is, or fine-tuned to suit your operational, security, and

compliance requirements. For example, if a user has the Create Payments and Approve Invoice privileges, you
might consider it an SoD conflict. The predefined Accounts Payable Manager role has the privileges of Force
Approve Invoices and Create Payments. When you assess and balance the cost of duty separation against
reduction of risk, you might determine that the Accounts Payable Manager role should not be allowed to
perform Force Approve Invoices and remove that privilege.

To learn more about SoD, see Using Advanced Controls in the Oracle Help Center (http://docs.oracle.com). To learn
more about the policies and roles, see the Security Reference Manuals in the Oracle Help Center.

Data Security Considerations

• Use segment value security rules to restrict access to transactions, journal entries, and balances based on
certain values in the chart of accounts, such as specific companies and cost center values, to individual roles.

• Use data access set security for Oracle General Ledger users to control read or write access to entire ledgers
or portions of the ledger represented as primary balancing segment values, such as specific legal entities or
companies.

For more information on securing your applications, see the Oracle Fusion Cloud ERP Securing ERP guide in the Oracle
Help Center (http://docs.oracle.com).

Related Topics

Security for Country-Specific Features  
For new implementations, you must assign the country-specific duty roles to your enterprise job roles or users to use
the features specific to these regions.

You must assign country-specific duty roles to FSCM application and OBI application stripe. After assigning these roles
you can view the country-specific reports on the Scheduled Processes page, and open the Parameters page of the
selected process.

This table describes the duty roles for each region:

Region Duty Role Role Code

Europe, the Middle East, and Africa (EMEA)
 

EMEA Financial Reporting
 

ORA_JE_EMEA_FINANCIAL_REPORTING_DUTY
 

Asia Pacific (APAC)
 

APAC Financial Reporting
 

ORA_JA_APAC_FINANCIAL_REPORTING_DUTY
 

Asia Pacific (APAC)
 

Enterprise Financial Data Export Management
for China
 

ORA_JA_CN_ENTERPRISE_FINANCIAL_DATA_
EXPORT_ONLY_FOR_CHINA_DUTY_OBI
 

12
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Region Duty Role Role Code

Asia Pacific (APAC)
 

Golden Tax Management for China
 

ORA_JA_GOLDEN_TAX_MANAGEMENT_FOR_
CHINA_DUTY_OBI
 

General Ledger  

Overview of General Ledger Security  
General ledger functions and data are secured through job roles, data access sets, and segment value security rules.

Functional Security
Functional security, which is what you can do, is managed using job roles. The following job roles are predefined for
Oracle General Ledger:

• General Accounting Manager

• General Accountant

• Financial Analyst

Each job role includes direct privilege grants, as well as duty role assignments, to provide access to application functions
that correspond to their responsibilities. For example, the General Accounting Manager role grants comprehensive
access to all General Ledger functions to the general accounting manager, controller, and chief financial officer in your
organization.

Data Security
Data security, which controls what action can be taken against which data, is managed using:

• Data access sets

• Segment value security rules

Data access sets can be defined to grant access to a ledger, ledger set, or specific primary balancing segment values
associated with a ledger. You decide whether each data access set provides read-only access or read and write access
to the ledger, ledger set, or specific primary balancing segment values, which typically represent your legal entities that
belong to that ledger. Primary balancing segment values without a specific legal entity association can also be directly
assigned to the ledger.

Segment value security rules control access to data that's tagged with the value set values associated with any segment
in your chart of accounts.

Security Assignment

Use the Security Console to assign users roles (job roles, as well as roles created for segment value security rules or
others). Use the Manage Data Access Set Data Access for Users task to assign users data access sets as the security
context paired with their General Ledger job role assignments.

13
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For more information about security assignments and managing data access for users, see the Oracle ERP Cloud
Securing ERP guide.

Related Topics
• Data Access

Overview of Data Access Set Security  
Data Access Sets secure access to ledgers, ledger sets, and portions of ledgers using primary balancing segment values.

If you have primary balancing segment values assigned to a legal entity, then you can use this feature to secure access
to specific legal entities.

You can combine ledger and ledger set assignments in single data access sets if the ledgers share a common chart of
accounts and calendar. If you have primary balancing segment values assigned to a legal entity within the ledger, then
you can use data access sets to secure access to specific legal entities. You can also secure access to primary balancing
segments assigned directly to the ledger.

When a ledger or ledger set is created, a data access set for that ledger or ledger set is automatically created, giving full
read and write access to those ledgers. You can also manually create data access sets to give read and write access, or
read-only access to entire ledgers or portions of the ledger represented as primary balancing segment values.

The following figure shows that a data access set consists of an access set type and an access level. The access set type
can be set to full ledger or primary balancing segment value. The access level can be read only or read and write.

The Full Ledger access set type provides access to the entire ledger or ledger set. This could be for read-only access or
both read and write access to the entire ledger.

The Primary Balancing Segment Value access set type provides access to one or more primary balancing segment
values for that ledger. This access set type security can be specified by parent or detail primary balancing segment
values. The parent value must be selected from the tree that's associated with the primary balancing segment of your
chart of accounts. The specified parent value and all its descendants, including middle level parents and detail values

14
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are secured. You can specify read only, read and write access, or combination of both, for different primary balancing
segment values for different ledgers and ledger sets.

For more information about security assignments and managing data access for users, see the Oracle ERP Cloud
Securing ERP guide.

Examples of Data Access Set Security  
This example shows a data access set that secures access by using primary balancing segment values that correspond
to legal entities.

Scenario
The following figure shows a data access set for the US Financial Services Ledger. The access set type is Primary
Balancing Segment Value, with each primary balancing segment value representing different legal entities. Read-only
access has been assigned to primary balancing segment value 131, which represents the Insurance legal entity. Read
and write access has been assigned to primary balancing segment values 101 and 102, which represent the Banks and
Capital legal entities.

For this data access set, the user can:

• View the journals, balances, and reports for primary balancing segment value 131 for the Insurance legal entity.

• Create journals and update balances, as well as view journals, balances and reports for primary balancing
segment value 101 and 102 for legal entities Banks and Capital.

15
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Note:  In financial reporting, the list of ledgers isn't secured by data access sets when viewing a report in Preview
mode. Users can view the names of ledgers they don't have privileges to view. However, the data from a secured
ledger doesn't appear on the report.

For more information about security assignments and managing data access for users, see the Oracle ERP Cloud
Securing ERP guide.

Segment Value Security  
Set up segment value security rules on value sets to control access to parent or detail segment values for chart of
accounts segments, also called flexfield segments. Segment value security rules restrict data entry, online inquiry, and
reporting.

Secured Value Sets
When you enable security on a value set, access to all values for that value set is denied. To control access to value set
values, you enable security on the value set, create conditions, and then assign the conditions to roles. The roles should
be created solely for the purpose of segment value security. The roles are then assigned to users.

Note:  To ensure segment value security applies properly throughout Oracle General Ledger, make sure that every
user who's working with that secured value set is assigned at least one of those roles.

If a value set is secured, every usage of that value set in a chart of accounts structure instance is secured. The same
security applies if that value set is:

• Used for two or more segments in the same chart of accounts, such as the primary balancing and
intercompany segments

• Shared across different segments of different charts of accounts

If you want to secure only the primary balancing segment and not the intercompany segment, then these two segments
must use different value sets.

Secured Segment Values
Segment value security applies mainly when data is created or updated, and when account combinations are queried.
When you have access to secured account values, you can view and use those secured values across all modules of the
applications where there are references to accounting flexfields including:

• Transaction entry pages

• Balances and transactions inquiry pages

• Setup pages

• Reports

On setup pages, you can still view referenced account combinations with secured account values, even if you haven't
been granted access to those secured values. However, if you try to update such references, you can't use those secured
values. On reports, you can view balances for secured account values only if you have access to those secured values.
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Note:  You can enforce segment value security for inquiries and reporting based on any hierarchy, even hierarchies
that aren't published to the reporting cube.

Segment Value Security Implementation
You can implement segment value security using the Security Console and these pages: Manage Value Sets, Manage
Chart of Accounts Structures, Publish Account Hierarchies.

Note:  If you're enabling security on a value set for the very first time and haven't created any segment value security
rules for it yet, you can also use the Manage Segment Value Security Rules spreadsheet to create, edit, and delete your
rules. Use the Manage Chart of Accounts Configurations task and Edit Chart of Accounts Configuration page to
open the spreadsheet. Once you use this spreadsheet, you must continue to use it to manage the rules for that value
set.

The following figure shows the steps for defining and implementing security rules for segment values using the Security
Console, Manage Value Sets, Manage Chart of Accounts Structures, and Publish Account Hierarchies pages.
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To define segment value security roles:

1. Create segment value security roles.
2. Enable security on the value set.

Note:  You can enable security only on value sets with a type of Independent.

3. Create conditions for the rule.
4. Create policies to associate the conditions with the role.
5. Deploy the accounting flexfield.
6. Publish the account hierarchies.
7. Assign the role to users.

Whenever you assign segment value security roles to a user, the rules from the user's assigned roles can be applied
together. All of the segment value security roles assigned to a user pertaining to a given value set are simultaneously
applied when the user works with that value set. For example, one rule provides access to cost center 110 and another
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rule provides access to all cost centers. A user with both of these segment value security rules has access to all cost
centers when working in a context where that value set matters.

Note:  To ensure segment value security applies properly throughout General Ledger, make sure that every user who's
working with that secured value set is assigned at least one of those roles.

Segment Value Security Conditions
When you create a condition, you specify an operator. This table describes the operators you can use.

Operator What It Does

All values
 

Provides access to all account values in the value set.
 

Note:
This operator is only applicable to the Manage Segment Value Security Rules spreadsheet. If you're
creating rules using the Manage Segment Value Security Rules task, you can use the Row Set
attribute on the Rule tab of the Create Policy dialog box to provide access to all values.
 

Between
 

Provides access to the account values included in the range of values specified in the From and To
Value columns. When the range of values includes a parent account, access applies to that parent
value only, in all trees and tree versions that include that parent. The rule doesn't provide access to any
of its descendants, unless they're part of the specified range.
 

Contains
 

Provides access to account values that contain the specified value. When the matching value is a
parent account, access applies to that parent value only, in all trees and tree versions that include that
parent. It doesn't provide access to any of its descendants unless those descendants also happen to
match the condition.
 

Ends with
 

Provides access to account values that end with the specified value. When the matching value is a
parent account, access applies to that parent value only, in all trees and tree versions that include that
parent. It doesn't provide access to any of its descendants unless those descendants also happen to
match the condition.
 

Equal to
 

Provides access to a specific account value. When the specified value is a parent account, access
applies to that parent value only, in all trees and tree versions that include that parent. The rule doesn't
provide access to any of its descendants.
 

Is descendant of
 

Provides access to the specified parent account value and all of its descendants. Descendants include
middle level parent accounts and nonparent accounts throughout all of that parent's hierarchical
branches, from the root to the leaf nodes.
 

Is last descendant of
 

Provides access to the specified parent account value and to the account values at the leaf nodes of
that parent.
 

Not equal to
 

Provides access to all non-parent account values, except for the specified account.
 

19



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 2
Oracle Cloud Security

Operator What It Does

CAUTION:
Here are some important points about this operator.

• Use this operator carefully and sparingly.

• Don't use it in multiple condition rows for the same policy or in different policies for the same
secured value set. The different conditions could end up canceling each other out, resulting
in unintended access being granted to account values you want to secure. For example, let's
say you have a policy with two condition rows. You define the first condition as Not Equal To
account value 100 and the second condition as Not Equal To account value 200. The list of
values for the segment is going to show both 100 and 200. That's because an account value can
meet any one of the conditions for the rule to apply. The value of 100 meets the Not Equal To
200 condition and the value of 200 meets the Not Equal To 100 condition.

 
 

Starts with
 

Provides access to account values that start with the specified value. When the matching value is a
parent account, access applies to that parent value only, in all trees and tree versions that include that
parent. It doesn't provide access to any of its descendants unless the descendants also happen to
match the condition.
 

Note:  Best practice to improve rule efficiency is to use the tree operators (Is descendant of, Is last descendant of)
where possible and limit the number of conditions in a rule.

Note:  For the Is descendant of and Is last descendant of operators, the security rule applies across all tree versions
of the specified hierarchy, as well as all hierarchies associated with the same value set of the specified hierarchy.

Manage Segment Value Security Rules Spreadsheet  
You can control user access to chart of account segment values by defining segment value security rules. These rules
restrict data entry, online inquiry, and reporting. You can define segment value security rules in the application or
through desktop-integrated spreadsheets.

This topic describes the Manage Segment Value Security Rules spreadsheet, which you can use to create, edit, and
delete the segment value security rules for a value set. Once you use this spreadsheet, you must continue to use it to
manage the rules for that value set.

When to Use the Spreadsheet
You can only use the spreadsheet if you're enabling security on a value set for the very first time and haven't created
any segment value security rules for it yet.

CAUTION:  The rules that you define using this spreadsheet are stored differently than the rules you define using the
application pages or the Create Segment Value Security Rules spreadsheet. To maintain rule integrity, use compatible
methods to add new rules or edit existing rules to a secured value set as described in the following table.
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This table shows how the method you use to create the original rules for a value set determines which methods you can
use to manage the rules for that value set going forward.

Methods for Managing Segment Value Security Rules

Method Used to Create Original Rules Which methods can be used to create
additional rules?

Which methods can be used to edit or delete
the rules?

Manage Segment Value Security Rules
spreadsheet

Manage Segment Value Security Rules
spreadsheet

Manage Segment Value Security Rules
spreadsheet

Edit Data Security page • Edit Data Security page

• Create Segment Value Security Rules
spreadsheet

Edit Data Security page

Create Segment Value Security Rules
spreadsheet

• Edit Data Security page

• Create Segment Value Security Rules
spreadsheet

Edit Data Security page

How You Open the Spreadsheet

1. In the Setup and Maintenance work area, use the Manage Chart of Accounts Configurations task.

◦ Offering: Financials

◦ Functional Area: Financial Structures

◦ Task: Manage Chart of Accounts Configurations

2. On the Manage Chart of Accounts Configurations page, select the chart of accounts.
3. In the Segments section, select the value set.
4. In the Value Set tab, select the Enable security check box.

Note:  Since you're enabling security at the value set level, all charts of accounts that use that value set are
affected.

5. Enter a data security resource name.
6. Save your changes.
7. Click Manage Data Security.

What to Do After You Enable Security on a Value Set
You must deploy the accounting flexfield and publish the account hierarchies tied to the secured value set. These steps
are independent of working with the spreadsheet. You can deploy the flexfield from the Manage Chart of Accounts
Configurations page. Just click Deploy All Charts of Accounts.

To publish the account hierarchies, use the Publish Account Hierarchies task.

• Offering: Financials

• Functional Area: Financial Structures

• Task: Publish Account Hierarchies
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Note:  If you disable security on a value set, you must also deploy the accounting flexfield and publish the account
hierarchies.

What's in the Spreadsheet
The spreadsheet has rows for defining segment value security policies and assigning them to segment value security
roles. A policy can have one or more conditions, which consist of operators, values, and in some cases, tree codes
and tree versions. Some spreadsheet columns represent policy level attributes, and some represent condition level
attributes.

Here's a summary of the columns on the spreadsheet.

Column Is It Required? Can You Update It? Is It an Attribute of the Policy or
Condition?

Policy Name
 

Yes
 

No
 

Policy
 

Policy Description
 

No
 

Yes
 

Policy
 

Segment Value Security Role Name
 

Yes
 

No
 

Policy
 

Operator
 

Yes
 

Yes
 

Condition
 

From Value
 

Yes, for all operators other than All
Values
 

Yes
 

Condition
 

To Value
 

Yes, for the Between operator
 

Yes
 

Condition
 

Tree Code
 

Yes, for hierarchical operators
 

Yes
 

Condition
 

Tree Version
 

Yes, for hierarchical operators
 

Yes
 

Condition
 

Policy Start Date
 

Yes
 

No
 

Policy
 

Policy End Date
 

No
 

Yes
 

Policy
 

Mark for Deletion
 

No
 

Yes
 

Condition
 

Here's more information about the policy columns to help you prepare the spreadsheet.

Column What It Represents How to Use It

Policy Name
 

The name for a group of related condition rows.
 

When a policy has multiple conditions, you
must use the same policy name across all
related condition rows.
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Column What It Represents How to Use It

Policy Description
 

A brief summary of the scope and purpose for
the policy.
 

When a policy has multiple conditions, you
must use the same policy description across all
related condition rows.
 

Segment Value Security Role Name
 

The existing role that the policy is being
assigned to.
 

When a policy has multiple conditions, you
must use the same segment value security role
across all related condition rows.
 

Note:
To complete the segment value security rule
definition, the role must be assigned to the
users the policy applies to.
 

 

Policy Start Date
 

The effective start date of the policy.
 

You can specify a date in the future. When a
policy has multiple conditions, you must use
the same start date across all related condition
rows.
 

Policy End Date
 

The effective end date of the policy.
 

If you don't specify an end date, the policy is in
effect indefinitely. When a policy has multiple
conditions, you must use the same end date
across all related condition rows.
 

Note:
For audit purposes, you can't delete a policy.
Use the end date attribute to indicate when
the policy is no longer applicable.
 

Here's more information about the condition columns to help you prepare the spreadsheet.

Column What It Represents How To Use It

Operator
 

The method used to evaluate the values in the
condition.
 

When a policy has multiple conditions, you
can use different operators across all related
condition rows.
 

From Value
 

The value the operator evaluates in determining
what account values to provide access to.
 

You must enter a value for all operators, except
for the All Values operator. When a policy
has multiple conditions, you can use different
values across all related condition rows. The
account value must exist unless you're using
the Between operator. For that operator, the
value represents the starting value in the range.
 

To Value
 

The value the Between operator evaluates in
determining what account values to provide
access to.
 

You must enter a value when you're using the
Between operator and the value represents the
ending value in the range. The value doesn't
have to be an existing account.

23



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 2
Oracle Cloud Security

Column What It Represents How To Use It

 

Tree Code
 

The tree code for the parent account specified
in the From Value column. Used only with
hierarchical operators.
 

You must select a tree code when you use
hierarchy operators Is a descendant of and Is a
last descendant of. When a policy has multiple
hierarchical conditions, you can use different
tree codes across all related condition rows.
 

Tree Version
 

The tree version for the parent account
specified in the From Value column. Used only
with hierarchical operators.
 

You must select a tree version when you use
hierarchy operators Is a descendant of and Is a
last descendant of. When a policy has multiple
hierarchical conditions, you can use different
tree versions across all related condition rows.
 

Mark for Deletion
 

The indicator for whether to remove an
individual condition from the policy.
 

If a policy has only one condition and you mark
it for deletion, the policy is automatically end-
dated. It no longer appears in the spreadsheet
the next time you download the rules from the
application.
 

Operators are key attributes of a condition. They specify how the rule evaluates condition values in determining what
account values the role can access. When a policy has multiple conditions, an account value just has to meet any one of
the conditions for the rule to apply.

Here's the list of available operators. Use this information to help you prepare the spreadsheet.

Operator What It Does

All values
 

Provides access to all account values in the value set.
 

Between
 

Provides access to the account values included in the range of values specified in the From and To
Value columns. When the range of values includes a parent account, access applies to that parent
value only, in all trees and tree versions that include that parent. The rule doesn't provide access to any
of its descendants, unless they're part of the specified range.
 

Contains
 

Provides access to account values that contain the specified value. When the matching value is a
parent account, access applies to that parent value only, in all trees and tree versions that include that
parent. It doesn't provide access to any of its descendants unless those descendants also happen to
match the condition.
 

Ends with
 

Provides access to account values that end with the specified value. When the matching value is a
parent account, access applies to that parent value only, in all trees and tree versions that include that
parent.It doesn't provide access to any of its descendants unless those descendants also happen to
match the condition.
 

Equal to
 

Provides access to a specific account value. When the specified value is a parent account, access
applies to that parent value only, in all trees and tree versions that include that parent. The rule doesn't
provide access to any of its descendants.
 

Is descendant of
 

Provides access to the specified parent account value and all of its descendants. Descendants include
middle level parent accounts and nonparent accounts throughout all of that parent's hierarchical
branches, from the root to the leaf nodes.
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Operator What It Does

 

Is last descendant of
 

Provides access to the specified parent account value and to the account values at the leaf nodes of
that parent.
 

Not equal to
 

Provides access to all non-parent account values, except for the specified account.
 

CAUTION:
Here are some important points about this operator.

• Use this operator carefully and sparingly.

• Don't use it in multiple condition rows for the same policy or in different policies for the same
secured value set. The different conditions could end up canceling each other out, resulting
in unintended access being granted to account values you want to secure. For example, let's
say you have a policy with two condition rows. You define the first condition as Not Equal To
account value 100 and the second condition as Not Equal To account value 200. The list of
values for the segment is going to show both 100 and 200. That's because an account value can
meet any one of the conditions for the rule to apply. The value of 100 meets the Not Equal To
200 condition and the value of 200 meets the Not Equal To 100 condition.

 
 

Starts with
 

Provides access to account values that start with the specified value. When the matching value is a
parent account, access applies to that parent value only, in all trees and tree versions that include that
parent. It doesn't provide access to any of its descendants unless the descendants also happen to
match the condition.
 

Note:  Best practice to improve rule efficiency is to use the tree operators (Is descendant of, Is last descendant of)
where possible and limit the number of conditions in a rule.

How You Review or Edit Existing Rules
When you have to review or edit rules, it's important to always work with the most current version of the rules recorded
in the application. The way to do this is to always download the rules from the application.

1. Open the spreadsheet and connect to the application.
2. Click Search in the Manage Segment Value Security ribbon.
3. Search by policy name or assigned segment value security role, or both.
4. Review the rules or make changes and then upload them to the application.

Note:  You can also create rules in the same spreadsheet that you're reviewing or editing.

Related Topics
• What's the difference between the segment value security rule spreadsheets?

• Considerations for Planning Value Sets

• Set Up Desktop Integration for Excel
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Example of Segment Value Security  
You can set up segment value security rules on value sets to control access to parent or detail segment values for chart
of accounts segments. Segment value security rules restrict data entry, online inquiry, and reporting.

The following example describes why and how you might want to use segment value security.

Securing Values for the Cost Center and Account Segments
For this scenario, only certain users should have access to the Accounting cost center and the US Revenue account. To
create a complete data security policy that restricts segment value access to those users:

1. Plan for the number of roles that represent the unique segment value security profiles for your users. For this
scenario, you can create two roles, one for the cost center segment and one for the account segment.

2. Use the Security Console to create the roles. Append the text SVS-role to the role names so it's clear the roles
are solely for segment value security. For this scenario, you create roles Accounting Cost Center-SVS Role and
US Revenue Account-SVS Role.

3. Use the Manage Segment Value Security Rules task to enable security on the cost center and account value
sets associated with the chart of accounts.

4. Create a condition for each value set. For example, the condition for the Accounting cost center is that the cost
center is equal to Accounting.

5. Create a policy to associate the conditions to the roles. For example, create a policy to assign the condition for
the Accounting cost center to the role Accounting Cost Center-SVS Role.

6. Use the Security Console to assign the appropriate role to the appropriate user. For example, assign the role
Accounting Cost Center-SVS Role to the users who should have access to the Accounting cost center.

Note:  If you're enabling security on the value set for the very first time and haven't created any segment value
security rules for it yet, you can also use the Manage Segment Value Security Rule spreadsheet as an alternative to
steps 3 through 5.

Related Topics
• Segment Value Security

Enable Security on a Chart of Accounts  
This example demonstrates how to use the Security Console and the Manage Value Sets, Manage Chart of Accounts
Structures, and Publish Account Hierarchy pages to enable security on a chart of accounts to control access to specific
segment values.

The following table summarizes the key decisions for this scenario.

Decisions to Consider In This Example

Which segment in the chart of accounts
must be restricted?

Cost center
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Decisions to Consider In This Example

 

Which cost center values have to be
granted to different users?
 

• Child values 110 to 120

• Child value 310

• Parent value 400 and all its children

• All cost centers

What's the name of the value set for the
segment with the Cost Center label?
 
 

Cost Center Main
 

What's the name of the user who can
access cost centers 110 to 120?
 

Casey Brown
 

What's the name of the tree for the
accounting flexfield?
 

All Corporate Cost Centers
 

What version of the tree hierarchy does
the condition apply to?
 

V5
 

Summary of the Tasks and Prerequisites
This example includes details of the following tasks you perform when defining and implementing segment value
security.

1. Define roles for segment value security rules.
2. Enable segment value security for the value set.
3. Define the conditions.
4. Define the policies.
5. Deploy the accounting flexfield.
6. Publish the account hierarchies.
7. Assign segment value security roles to users.

Perform the following prerequisites before enabling security on a chart of accounts:

• To work with the Security Console, you need the IT Security Manager role assigned to your user setup.

• To work with value sets and profile options, you need the Financial Application Administrator role.

• Set the Enable Data Security Policies and User Membership Edit profile to Yes.

Defining Roles for Segment Value Security Rules
To create a complete data security policy, create the roles first so that they're available for assignment to the segment
value security rules.

1. In the Tools work area, open the Security Console.
2. Perform the following steps four times to create four roles.
3. Click Create Role.
4. On the Create Role page, complete the fields as shown in this table, and then click Next, Next, Next, Next,

Next, Save and Close.
5. Click OK and complete the fields, as shown in this table.
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Field Role 1 Role 2 Role 3 Role 4

Role Name
 

Cost Center 110-120 SVS
Role
 

Cost Center 310 SVS Role
 

Cost Center 400 SVS Role
 

Cost Center All SVS Role
 

Role Code
 

CC_110_120_SVS_ROLE
 

CC_310_SVS_ROLE
 

CC_400_SVS_ROLE
 

CC_ALL_SVS_ROLE
 

Role Category
 

Default
 

Default
 

Default
 

Default
 

Description
 

Access to cost centers 110
to 120.
 

Access to cost center 310.
 

Access to parent cost
center 400 and all its
children.
 

Access to all cost centers.
 

The following figure shows the Create Role page for the first role, which is Cost Center 110-120 SVS Role. The
role code, role category, and description fields are complete.

Enabling Segment Value Security for the Value Set
1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Financial Reporting Structures

◦ Task: Manage Segment Value Security Rules

2. In the Value Set Code field, enter Cost Center Main and click Search.
3. In the Search Results section, click Edit to open the Edit Value Set page.
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4. Select the Security enabled option.
5. In the Data Security Resource Name field, enter Secure_Main_Cost_Center_Values.
6. Click Save.

The following figure shows the Edit Value Set page for the Cost Center Main value set. Security is enabled and a
data security resource name has been entered.

Defining the Conditions
Use conditions to specify the segment values that require security.
Segment value security rules that provide access to all segment values, and segment value security rules that provide
access to single nonparent segment values, don't need a condition. Instead, you can define the policy to cover all values,
and you can define a policy to cover a single nonparent segment value provided that you know the internal ID for that
segment value. If you don't know the internal ID, you can create a condition for that single segment value.

In this scenario, the internal ID for segment value 310 isn't known, so the following steps create all of the conditions,
except for the access to all cost centers, which the policy definition can cover.

1. Click Edit Data Security to open the Edit Data Security page.
2. On the Condition tab, click Create to open the Create Database Resource Condition window.
3. Enter CC 110 - 120 in the Name field.
4. Enter Cost Centers 110 to 120 in the Display Name field.
5. Accept the default condition type of Filter.

Note:  SQL predicate isn’t a supported condition type.

6. Accept the default value of All for the Match field.

Matching to All means that all of the condition rows apply simultaneously and all of them must be met in
identifying the values.
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Matching to Any means that any of the condition rows could apply. For example, if you create multiple
condition rows, each of which on its own is an alternative scenario for identifying the values that apply, you
would select Match to Any.
Because this example only has one condition row, the Match selection doesn't matter. If however, you define
multiple condition rows for segment value security, you would have to select Match to Any, because a single
account value can't satisfy multiple account value-based conditions.

7. Click Add in the Conditions section.
8. Select VALUE for the Column Name field.
9. Select Between for the Operator field.

Note:  You can select one of the following operators: Between, Contains, Ends with, Equal to, Is descendant
of, Is last descendant of, Not equal to, Starts with.

10. Enter 110 in the first Value field and 120 in the second Value field.

The following figure shows the Create Database Resource Condition page for the condition named CC 110 - 120.
The display name is Cost Centers 110 to 120, and one condition is defined. The condition has a column name of
VALUE, an operator of Between, and the specified values are 110 and 120.

11. Click Save.
12. To create the next database resource condition for segment value 310, click Create on the Condition tab.
13. Enter CC 310 in the Name field.
14. Enter Cost Center 310 in the Display Name field.
15. Click Add in the Conditions section.
16. Select VALUE for the Column Name field.
17. Select Equal to for the Operator field.
18. In the Value field, enter 310.
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The following figure shows the Create Database Resource Condition page for the second condition named CC
310. The display name is Cost Center 310, and one condition is defined. The condition has a column name of
VALUE, an operator of Equal to, and the specified value is 310.

19. Click Save.
20. To create the next database resource condition for parent value 400, click Create on the Condition tab.
21. Enter CC 400 in the Name field.
22. Enter Parent Cost Center 400 in the Display Name field.
23. In the Condition section, click Add.
24. Select VALUE for the Column Name field.
25. Select the Tree Operators option.
26. For the Operator field, select Is a last descendant of, which restricts access to the parent cost center 400 and all

of its children, including intermediary parents.

Note:  For the Tree Operators field, you can only select Is a last descendant of or Is a descendant of.
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27. In the Value column, click the Select Tree Node icon to open the Select Tree Node window.

The following figure shows the Select Tree Node window. Values are required for the Tree Structure, Tree, and
Active Tree Version fields. The window also includes these Tree Node options: Specify primary keys, Select from
hierarchy.

28. In the Tree Structure field, select Accounting Flexfield Hierarchy. This signifies that you are choosing among
trees that are used as accounting flexfield, or charts of accounts, hierarchies.

29. In the Tree field, select All Corporate Cost Centers.
30. In the Active Tree Version field, select V5.
31. In the Tree Node field, select the Select from hierarchy button. The Tree Node section opens.
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32. In the Tree Node section, expand the nodes and select 400.

The following figure shows the Select Tree Node window after completing the fields in steps 27 through 31.

33. Click OK.

The following figure shows the resulting Create Database Resource Condition page for the condition named
CC 400. The display name is Parent Cost Center 400 and one condition is defined. The condition has a column
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name of VALUE, an enabled Tree Operators option, an operator called Is a last descendant of, and a value of
400.

34. Click Save.

Defining the Policies
Create policies to assign conditions to segment value security roles.

1. On the Edit Data Security page, click the Policy tab.
2. Click Create to open the Create Policy window.
3. On the General Information tab, enter Policy for 110-120 in the Name field.
4. Accept the default value of General Ledger in the Module field.
5. Enter 9/1/16 in the Start Date field.

The following figure shows the General Information tab on the Create Policy page for the policy named Policy
for 110-120. The start date for the policy is 9/1/16.

6. Select the Role tab and click Add to open the Select and Add window.
7. Enter 110 in the Role Name field.
8. Select hcm in the Application field.
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Roles with the Default category are created in the hcm application.
9. Click Search.

The following figure shows the Select and Add Roles window with the search results. The role retrieved by the
search results is named Cost Center 110-120 SVS Role.

10. Select Cost Center 110-120 SVS Role and click OK.

The following figure shows the Role tab on the Create Policy page with the role that was populated by the
search results.

11. Select the Rule tab.
12. Accept the default setting of Multiple Values in the Row Set field.

Note:  The Row Set field determines the range of value set values affected by the policy.

◦ If Multiple Values is selected, a condition must be specified.

◦ If All Values is selected, then the policy grants access to all values in the value set and no
condition is needed.

◦ If Single Value is selected, then the internal Value ID for the segment value must be specified
and no condition is needed.

13. Click Search on the Condition field.
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14. Select Cost Centers 110 to 120 for the Condition field and click OK.

The following figure shows the Rule tab on the Create Policy page. The selected row set is Multiple Values and
the condition is Cost Centers 110 to 120.

15. Click Save and Close.
16. Click OK to confirm.
17. Repeat steps 2 through 13 to create the rest of the policies, using the values in the following table.

Field Policy 2 Policy 3 Policy 4

General Information tab, Name
 

Policy for 310
 

Policy for 400
 

Policy for all cost centers
 

General Information tab, Start
Date
 
 

9/1/16
 

9/1/16
 

9/1/16
 

Role tab, Role Name
 

Cost Center 310 SVS Role
 

Cost Center 400 SVS Role
 

Cost Center All SVS Role
 

Rule tab, Row Set
 

Multiple Values
 

Multiple Values
 

All Values
 

Rule tab, Condition
 

Cost Center 310
 

Parent Cost Center 400
 

Not Applicable
 

18. Click Done.

Deploying the Accounting Flexfield
You must deploy the accounting flexfield for the segment value security changes to take effect.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Financial Reporting Structures

◦ Task: Manage Chart of Accounts Structures

2. In the Module field, select General Ledger and click Search.

36



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 2
Oracle Cloud Security

3. Select the row for the Accounting Flexfield and click Deploy Flexfield.

The following figure shows the Manage Chart of Accounts Structure page after searching for General Ledger
modules. The search results display a row with a key flexfield named Accounting Flexfield.

4. Click OK.

Publishing the Account Hierarchies
1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Financial Reporting Structures

◦ Task: Publish Account Hierarchies

2. In the Hierarchy field, select All Corporate Cost Centers.
3. In the Hierarchy Version field, select V5.
4. Click Search.
5. In the Search Results section, expand the hierarchy row.
6. Select the row for the hierarchy version V5.
7. Click Publish.
8. Click OK.

Assigning Segment Value Security Roles to Users
1. In the Tools work area, open the Security Console.
2. Enter Cost Center 110-120 SVS Role in the Search field and click Search.
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3. In the Search Results section, select the down arrow icon and select Edit Role.

The following figure shows the Roles page and the available menu options, including Edit Role, for the role
named Cost Center 110-120 SVS Role.

4. Click Next four times to navigate to the Edit Role: Users page.
5. Click Add User.
6. Enter Casey in the Search field and click Search.
7. Click Add User to Role to add Casey Brown to the role.
8. Click OK to confirm.

The following figure shows the Edit Role page for the Cost Center 110-120 SVS Role with the user Casey Brown
selected.

9. Repeat steps 2 through 8 to add the other roles to different users as needed.
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Related Topics
• Update Existing Setup Data

Data Security Differences in GL Features Based on Balance Cubes  
In certain cases, differences in data security can appear depending on whether the Oracle General Ledger feature being
used is directly or indirectly based on the balances cube.

For example, this can occur when a user is assigned multiple data access sets for the same balances cube with different
security specifications for ledger or primary balancing segment value access, or when segment value security rule
assignments are involved.

General Ledger features based directly on the balances cube are:

• Inquire on Detail Balances

• Account Monitor

• Account Inspector

• Financial Reporting

• Smart View

• Allocations

All other General Ledger features are indirectly based on the balances cube.

When using features indirectly related to the balances cube, you select a specific data access set and you work only with
that one data access set at a time. The defined ledger and primary balancing segment value access for the selected data
access set are enforced.

When using features directly related to the balances cube, the cumulative effects of your combined data access sets for
that balances cube are enforced. From your combined data access sets for that cube, balances cube security separately
constructs the access filter for the ledger dimension and primary balancing segment values dimension independently
of the other dimensions. This means the specific combination of ledger and primary balancing segment values access
as defined in each distinct data access set aren't enforced as such. Instead, you have access simultaneously to all the
ledgers and all the primary balancing segment values granted to you through your combined data access sets.

Note:  Balances cube security grants access to all values of the balancing segment value set for a data access set
defined as either of the following:

• Full ledger

• All Values: Specific Balancing Segment Values Access Type

With segment value security rules assigned to you through your various roles, the security rules are in effect
simultaneously whether working directly or indirectly with the balances cube.

Segment value security rules are specified for a particular value set. Therefore, as you're working on anything that
references the secured value set, all segment value security rules for that value set that's assigned to you through any
of your roles are in effect at the same time, regardless of the specific role the rule was assigned to. In other words,
segment value security rules are cumulative, or the union of all the segment value security rules you have assigned
to you through your roles. If you have one role assigned to your user that only grants access to cost center 200, and
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another role that grants access to cost centers 300 through 500, then you have access to cost centers 200 and 300
through 500.

When using features indirectly based on the balances cube, such as journal entry pages, the primary balancing segment
values you can access are based on the intersection of:

• Primary balancing segment values granted to you through your current selected data access set.

• All of your assigned segment value security rules pertaining to the primary balancing segment value set across
all of your assigned segment value security roles.

So, if a balancing segment value is only granted in either of the selected data access set or a segment value security
role, that balancing segment value isn't available to you.

In contrast, for features directly based on the balances cube, your access is based on the cumulative union of:

• Primary balancing segment values granted to you through all your assigned data access sets related to the
balances cube that you're working with.

• Any segment value security rule grants to that primary balancing segment value set across all of your segment
value security role assignments.

Example
This setup is used to more clearly and comprehensively illustrate the difference in how security works for features
directly and indirectly related to the balances cube with respect to data access sets and segment value security, though
this might not generally reflect a real-life example.

In this example, your job role is assigned two different data access sets for the Vision Corporation ledger. The Vision
Corporation 01 data access set is assigned primary balancing segment value 01, and the Vision Corporation 02 data
access set is assigned primary balancing segment value 02. You are also assigned segment value security roles SVS 01
and SVS 03.

The following table lists the job role, data access set, and primary balancing segment value assignments for this
example.

Job Role Data Access Set Primary Balancing Segment Value

General Accounting Manager
 

Vision Corporation 01
 

01
 

General Accounting Manager
 

Vision Corporation 02
 

02
 

The following table lists the primary balancing segment values that are assigned to you through the segment value
security roles.

Segment Value Security Role Primary Balancing Segment Value

SVS 01
 

01
 

SVS 03
 

03
 

Select Vision Corporation 01 Data Access Set
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For features indirectly based on the balances cube, you can access primary balancing segment value 01. This segment
value represents the intersection of the Vision Corporation 01 data access set and the SVS 01 and SVS 03 segment value
security roles.

Neither your selected data access set, nor your segment value security roles provide access to Company 02, and your
selected data access set Vision Corporation 01 and your cumulative segment value security roles SVS01 and SVS03 only
intersect on primary balancing segment value 01, and not on 03.

For features directly based on the balances cube, you can access primary balancing segments 01, 02, and 03. These
segment values represent the union of your assigned data access sets and segment value security roles. With the
balances cube, all data access sets assigned to you that are related to the balances cube you're working with apply
simultaneously, regardless of the data access set you selected to work with in the application.

Select Vision Corporation 02 Data Access Set

For features indirectly based on the balances cube, you can't access any primary balancing segment value because
none of the values from the Vision Corporation 02 data access set and SVS 01 and SVS 03 segment value security roles
intersect.

For features directly based on the balances cube, you can access primary balancing segments 01, 02, and 03. These
values represent the union of your assigned data access sets and segment value security roles.

How You Segregate Import Journals Access from FBDI Import for
Journals Access  
You can restrict the combined use of the Import Journals process and the Load Interface File for Import process for file-
based data import (FBDI) journals to certain users.

Users who aren't authorized to import journals using FBDI can be assigned privileges that allow them to submit journal
import only for processes such as Create Accounting for subledger transactions and Oracle General Ledger journal
creation through the Application Development Framework desktop integration (ADFdi) spreadsheet.

Separate privileges give you the flexibility to assign different users different levels of access to the Import Journals
process to optimize security control and prevent interruptions in FBDI journal import procedures that are reserved for
automated and mass volume imports.

Here are the privileges that allow access to journal import processes other than FBDI import for journals.

• Run Import Journals Program without FBDI Access
(GL_RUN_IMPORT_JOURNALS_PROGRAM_WITHOUT_FBDI_ACCESS): Allows submission of the journal import
program using the Oracle Fusion Enterprise Scheduler Services. However, this privilege does not include the
ability to use the Import Journals process when submitting the Load Interface File for Import program to
support creating journal records using File Based Data Import.

• Post Subledger Journal Entry to General Ledger No Journal Import Access for FBDI
(XLA_POST_SUBLEDGER_JOURNAL_ENTRY_TO_GL_NO_JOURNAL_IMPORT_ACCESS_FOR_FBDI): Allows
submission of the program to transfer to and post journal entries in General Ledger. However, this privilege
does not include the ability to use the Import Journals process when submitting the Load Interface File for
Import program to support creating journal records using File Based Data Import.

These privileges aren't assigned to any predefined role. You must assign them to
a custom role to use them as substitutes for the Run Import Journals Program
(GL_RUN_IMPORT_JOURNALS_PROGRAM_PRIV) and Post Subledger Journal Entry to General Ledger
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(XLA_POST_SUBLEDGER_JOURNAL_ENTRY_TO_GENERAL_LEDGER_PRIV) privileges, which allow access to FBDI
import for journals.

If you're creating a role based on the predefined General Accountant job role, here's a summary of the steps you would
follow to prevent a user from using FBDI journal import, while still allowing that user to submit journal import through
other processes.

1. Use the Security Console to make a deep copy of the predefined General Accountant job role by copying its
top role and inherited roles. The inherited roles include the Journal Management and Subledger Accounting
Manager duty roles.

2. After the role has been copied, search for the Journal Management custom duty rule that was generated.
Perform the following actions in the Function Security Policies step:

a. Add the Run Import Journals Program without FBDI Access privilege.
b. Delete the Run Import Journals Program privilege.

3. Search for the Subledger Accounting Manager custom duty role that was generated. Perform the following
actions in the Function Security Policies step:

a. Add the Post Subledger Journal Entry to General Ledger No Journal Import Access for FBDI
privilege.

b. Delete the Post Subledger Journal Entry to General Ledger privilege.
If you're creating your own custom role or starting with an existing custom role, perform these steps in the Security
Console to prevent a user from using FBDI journal import, while still allowing that user to submit journal import through
other processes.

1. Add the Run Import Journals Program without FBDI Access and Post Subledger Journal Entry to General
Ledger No Journal Import Access for FBDI privileges.

2. Delete the Run Import Journals Program and Post Subledger Journal Entry to General Ledger privileges
wherever they exist in the role hierarchy.

Note:  Users who already submit the Load Interface File for Import for other import processes such as Import Bank
Statements from a Spreadsheet and Import AutoInvoice won't be impacted by the removal of the Run Import
Journals Program and Post Subledger Journal Entry to General Ledger privileges.

If a user who's only assigned the Run Import Journals Program without FBDI Access or the Post Subledger Journal
Entry to General Ledger No Journal Import Access for FBDI privilege submits the Load Interface File for Import
process for the Import Journals process, the job will end in error. The log file will display an insufficient permissions
message.

Related Topics
• Create ERP Roles in the Security Console

• Guidelines for Copying ERP Roles

FAQs for General Ledger  

What happens when changes are made to an account hierarchy that's referenced in
segment value security rules?  
The tree is set from an active to a draft state. The rules referencing the account hierarchy become ineffective.
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After making changes to your hierarchy, you can submit the Process Account Hierarchies process to automatically run
the required steps for processing account hierarchies updates in one submission, including:

• Tree audit

• Tree activation

• Row flattening

• Column flattening

• Maintain value set

• Maintain account hierarchy

• Publish hierarchy

With a successful audit process, the hierarchy is set back to an active status. The rules referencing the account hierarchy
go back to being effective using the updated hierarchy.

Run the row and column flattening processes for the updated hierarchy as the flexfield component in the application as
well as other hierarchy processes rely on the flattened hierarchy data to come up with the list of values available to the
user to properly secure the correct account values.

Run the Maintain Value Sets and Maintain Chart of Account Hierarchies processes, particularly for hierarchy changes
to the primary balancing segment value set if such values are referenced in your primary balancing segment value
based data access sets. These processes update the data that is required to regulate ledger and data access security by
storing:

• Primary balancing segment values assigned to a ledger.

• Specific child balancing segment values assigned to a data access set through parent value assignments.

When does security take effect on chart of accounts value sets for balances cubes?  
To enforce segment value security according to defined security policies, you must enable security on the value set
before you publish the affected account hierarchies to the balances cube.

Likewise, to stop enforcing segment value security for a previously secured value set, you must disable security on the
value set and then republish the account hierarchies.

Once segment value security is enforced, you don't have to republish account hierarchies if you define new security
policies or modify existing policies for the secured value set, even if the security definition has hierarchical conditions
that use parent values.

Note:  If you change an account hierarchy that's already published, you must republish to reflect the updated
hierarchy in the balances cube. Use the Publish Account Hierarchy task to republish the tree version. Republishing
the account hierarchy also ensures proper enforcement of security policies that are based on parent values included in
the changed hierarchy.

How can I secure the data in GL balances cubes?  
Use data access set and segment value security to secure dimension values such as ledger and chart of account values.

For chart of accounts dimension values, security restricts the display of data associated with the secured values, but
not the selection of the values themselves. For example, when submitting a report, you can select company value 100
in your report definition when selecting the Point of View, even if you weren't granted access to that company value.
However, you can't see the data associated with company 100 in your report.
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What's the difference between the segment value security rule spreadsheets?  
You can create, review, edit, and delete segment value security rules with the Manage Segment Value Security
Rules spreadsheet. You can only create segment value security rules with the Create Segment Value Security Rules
spreadsheet.

Use the Manage Segment Value Security Rules spreadsheet on secured value sets for which you’re creating segment
value security rules for the very first time. Don't use the spreadsheet to edit or create more rules for already secured
value sets whose initial rules were created using the application pages or Create Segment Value Security Rules
spreadsheet. Once you use the Manage Segment Value Security Rules spreadsheet, you must continue to use it to
create, edit, and delete the rules for that value set.

To open the desktop-integrated Manage Segment Value Security Rules spreadsheet, use the Manage Charts of
Accounts Configurations task and select a chart of accounts.

Click Manage Data Security for the secured value set in the Value Set section on the Edit Chart of Accounts
Configuration page. The spreadsheet has the following columns:

• Policy Name

• Policy Description

• Segment Value Security Role Name

• Operator

• From Value

• To Value

• Tree Code

• Tree Version

• Policy Start Date

• Policy End Date

• Mark for Deletion

Since you can only create segment value security rules with the Create Segment Value Security Rules spreadsheet,
you must use the application pages to maintain them. To open the desktop-integrated spreadsheet, use the Create
Segment Value Security Rules in Spreadsheet task. An Instructions sheet tells you how to enter values for rules that
provide access to multiple values or ranges of values. The spreadsheet has the following columns:

• Role Name

• Value Set

• Tree Code

• Values

For the differences noted, it's recommended you use the Manage Segment Value Security Rules spreadsheet to define
your segment value security rules when this option is available for your given scenario.
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Payables  

Payables Security  
Oracle Fusion Payables improves security by limiting access to invoices and payments by business unit. You can
access invoices and payments for viewing or processing only for the business units to which you have permission. The
permission must be explicitly granted to each user.

Assign users to the appropriate security context, such as a business unit, for job roles from the Manage Data Access for
Users page.

Oracle Payables is integrated to the document repository for processing scanned invoices. To enhance security, edit
access to the document repository is granted to the following predefined roles:

• Accounts Payable Manager

• Accounts Payable Specialist

• Accounts Payable Supervisor

• Accounts Payable Invoice Supervisor

Keeping up with the security requirements, the following predefined roles have view-only access to the document
repository:

• Financial Application Administrator

• Cost Accountant

• Project Accountant

Note:  For further information, refer to the chapter Role Configuration Using the Security Console in the Securing ERP
guide.

Subledger Accounting  

Security for Subledger Accounting  
Oracle Fusion Subledger Accounting features require both function and data security privileges.

Overview
Security for Subledger Accounting includes:

• Setup task security
◦ Security to configure accounting rules to define accounting treatments for transactions.

• Transaction task security

45



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 2
Oracle Cloud Security

◦ Security to create subledger journal entries (manual subledger journal entries or those generated by the
Create Accounting process or Online Accounting).

◦ Security to review and generate reports of subledger journal entries and lines.

Security to Perform Setup Tasks
Use the Define Subledger Accounting Rules task in the Setup and Maintenance work area to configure subledger
accounting rules.

To configure subledger accounting rules, the setup user must be provisioned with a role that includes the Subledger
Accounting Administration duty role.

• In the security reference implementation, the Financial Application Administrator job role hierarchy includes
the Subledger Accounting Administration duty role. This role provides the access to configure your accounting
rules.

• For more information about available setup job roles, duty roles and privileges, see the Oracle Financial Security
Reference Manual.

Security to Perform Transactional Tasks
To create and view subledger journal entries, you must have the necessary access to perform the tasks in the relevant
subledger work areas. Predefined subledger job roles include the entitlement to create and view subledger journal
entries for subledger transactions you are authorized to access.

Security for Accounting Transformations in Accounting Hub  
Accounting transformations require both function and data security privileges.

Oracle Accounting Hub security for accounting transformations includes:

• Setup task security

◦ Security to register source systems into Accounting Hub.

◦ Security to configure accounting rules to define accounting treatments for transactions.

• Transactional task security

◦ Security to create subledger journal entries (manual subledger journal entries or those generated by the
Create Accounting process).

◦ Security to review and generate reports of subledger journal entry headers and lines.

Security to Perform Setup Tasks
Use the Define Accounting Transformation Configuration task in the Setup and Maintenance work area to integrate your
external source system with the Accounting Hub.

To register your external source system and configure accounting rules, the setup user must be provisioned with a role
that includes the following duty roles:

• Application Implementation Consultant
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• Accounting Hub Integration

• In the security reference implementation, the Financial Application Administrator job role hierarchy includes
the Accounting Hub Administration Duty role. This role provides the access to integrate your external source
systems with accounting transformations.

Security to Perform Transactional Tasks
To import transaction data for accounting and posting in general ledger, the user must be provisioned with a job role
that is associated with the Accounting Hub Integration duty role.

• The Import Subledger Accounting Transactions privilege is assigned to the Accounting Hub Integration duty
role. This role enables the user to submit the Import Subledger Accounting Transactions process. This process
also creates accounting entries and posts them in the general ledger.

To create and view subledger journal entries as an independent task, you must have the access necessary to perform
the tasks. These tasks can be opened from the Oracle General Ledger, Journals work area. You must have access to the
work area, as well as all of the ledgers (primary, secondary and reporting currency) in which the journal entry is posted.

The following are defined in the security reference implementation:

• The General Accounting Manager job role hierarchy includes duty roles that provide the entitlement to manage
general accounting functions. This entitlement provides access to the general ledger, Journals work area.

The following duty role must be assigned directly to the General Accounting Manager job role to provide access to
create and view subledger journal entries:

• Accounting Hub Integration Duty

Alternatively, you can assign the Subledger Accounting Duty and Subledger Accounting Reporting Duty roles to any of
the following general ledger job roles:

• Chief Financial Officer

• Controller

• Financial Analyst

• General Accountant

For more information about available setup job roles, duty roles, and privileges, see the Oracle Financials Cloud Security
Reference guide on the Oracle Help Center.

Related Topics
• Data Security
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Cash Management  

Considerations When You Create Accounts  
Banks, branches and accounts fit together on the premise of the Bank Account model. The Bank Account model enables
you to define and keep track of all bank accounts in one place.

The Bank Account Model can explicitly grant account access to multiple business units, functions, and users. Consider
the following when you set up bank accounts:

• Assign a unique general ledger cash account to each account, and use it to record all cash transactions for the
account. This facilitates book to bank reconciliation.

• Grant bank account security. Bank account security consists of bank account use security, bank account access
security, and user and role security.

Legal Entity-Based Data Access for Bank Account Setup
By default, users with the necessary function security privileges have access to create and manage all internal bank
accounts.

Optionally, restrict access to bank account information based on the user's legal entity data access. This allows cash
managers to add, review, or modify only the bank accounts associated with the legal entities that the user has access to.
For example, only users who have been assigned a cash manager role for Vision Operations legal entity, will be able to
create, review, or modify internal bank accounts associated to this legal entity.

Decentralized organizations will benefit with improved security by ensuring that users only manage the bank account
setup for the organizations they are authorized for.
Business benefits include:

• Improve security and increase control of bank account setup by limiting user access to bank account
information.

• Helps decentralized organizations that require users only to manage the bank account information for the
organizations they are authorized for.

To enable the feature Legal Entity-Based Data Access for Bank Account Setup, you must:

1. Use the Opt in UI to enable the feature.
2. Assign users to the appropriate legal entity security context:

a. In the Setup and Maintenance work area, Select the Offering as Financials, Functional Area as Users and
Security, and Task as Manage Data Access for Users.

b. On the Manage Data Access for Users page, create data access for users by entering the user name, Cash
Manager as role, legal entity as security context, and legal entity name as security context value, to create
the data access for the user.

c. Save the changes.

Once the feature is enabled, legal entity-based data access security is applied when an internal bank account is created
or managed using either the UI or REST API.
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Account Use
Account Use refers to accounts created for:

• Oracle Fusion Payables

• Oracle Fusion Receivables

• Oracle Fusion Payroll

Select the appropriate use or uses when creating an account in one or more of these applications.

Account Access
Payables and Receivables account access is secured by business unit. Before the bank account is ready for use by
Payables or Receivables, you must:

1. Select the appropriate use for the application.
2. Grant access to one or more business units.

Note:  You can only assign access to the business units that use the same ledger as the bank accounts owning the
legal entity,

User and Role Security
You can further secure the bank account so that it can only be used by certain users and roles. The default value for
secure bank account by users and roles is No. For Payables and Receivables, you must have the proper business unit
assigned to access a bank account even if the secure bank account by users and roles is No. If the secure bank account
by users and roles is set to Yes, you must be named or carry a role assigned to the bank account to use it.

• You must assign the security duty role Cash Management Administration to the Cash Manager job role to
provide access for setting up banks, branches, and accounts. You must have the assigned Manage Bank
Account Security privilege to modify the User and Role Security.

• If you want to restrict the access to the Security tab, you must create a customized role and remove the
privilege Manage Bank Account Security. For example, you would copy the Cash Management Administration
duty role, rename it, and remove the privilege.

GL Cash Account Segments
Consider selecting the option to enable multiple cash account combinations for reconciliation if you want to reconcile
journal lines of multiple cash account combinations matching the same natural account and other specified segment
values.

For example, if you set up 01-000-1110-0000-000 as your cash account, and select Account and Sub-Account as GL
Cash Account Segments, you're able to manually or automatically reconcile journal lines entered on different account
code combinations matching the same natural account '1110' and sub-account '0000'.

Related Topics
• Assign Data Access to Users
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Assets  

Assets Data Security Components  
In Oracle Fusion Assets, you can secure access to assets to perform transactions and view their information by asset
book.

Every asset book created in Assets is automatically secured. You can perform transactions or view asset data only in the
books to which you have permission. The permission must be explicitly granted to each user based on his or her duty
requirements.

Data Privileges
Each activity is individually secured by a unique data privilege. In other words, when you provide access to a book, you
actually provide permission to perform a particular activity in that book. For example, you can allow user X to perform
only tasks related to asset additions in book AB CORP and restrict the same user from performing asset retirements in
this book.

The data accesses for different asset activities are secured for the book with the following data privileges:

• Add Fixed Asset Data

• Change Fixed Asset Data

• Retire Fixed Asset Data

• Track Fixed Asset Data

• Submit Fixed Assets Reports

Asset Book Security Context
After you have completed your Assets setup, you can assign job roles to users using the Security Console and then
grant explicit data access for asset books using the Manage Data Access for Users task from the Setup and Maintenance
work area.

Default Asset Books
Since the data access is secured by book, you must provide or select the book to perform transactions and view asset
details. If you have access to only one book, you can set up this book as the default book. The default book value must
be set using the Default Book profile option. You set the value at the site, product, or user level. Usually, the default book
is automatically entered in the Book field when you perform transactions and run reports. You can override the default
value and enter another value from the list of values.

Related Topics
• Assets Profile Options
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Payments  

Options for System Security  
Implement application security options on the Manage System Security Options page. You can set the application
security to align with your company's security policy.

You can set security options for encryption and tokenization of credit cards and bank accounts, as well as for masking
the payment instrument. Both funds capture and disbursement processes use security options.

Note:  You must enable encryption or tokenization of credit cards in Payments before you can import credit cards into
Expenses.

Ask yourself these security questions to improve the security of your sensitive data:

• Which security practices do I want to employ?

• Do I want to tokenize my credit card data?

• Do I want to encrypt my bank account data?

• Do I want to encrypt my credit card data?

• How frequently do I want to rotate the master encryption key and the subkeys?

• Do I want to mask credit card and bank account numbers? How do I accomplish that?

To set up application security options, go to Financials > Payments > Manage System Security Options in the Setup
and Maintenance work area.

Best Security Practices
These actions are considered best security practices for payment processing:

• Comply with the Payment Card Industry Data Security Standard (PCI DSS). PCI DSS is the security standard
required for processing most types of credit cards.

◦ Comply with all requirements for accepting credit card payments.

◦ Minimize the risk of exposing sensitive customer data.

• Create the master encryption key.

◦ Rotate the master encryption key periodically.

Implementation Process of Master Encryption Key and Encryption
Before you can enable encryption for credit card or bank account data, you must automatically create a master
encryption key. Oracle Platform Security Services stores your master encryption key. The application uses your master
encryption key to encrypt your sensitive data.

Automatic creation of the master encryption key ensures that it's created and stored in the proper location and with all
necessary permissions.
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Credit Card Tokenization
If you tokenize your credit card data, you're complying with PCI DSS requirements. PCI DSS requires companies to use
payment applications that are PCI DSS compliant.

Tokenization is the process of replacing sensitive data, such as credit card data, with a unique number, or token, that
isn't considered sensitive. The process uses a third-party payment system that stores the sensitive information and
generates tokens to replace sensitive data in the applications and database fields. Unlike encryption, tokens can't be
mathematically reversed to derive the actual credit card number.

Click Edit Tokenization Payment System on the Manage System Security Options page to set up your tokenization
payment system. Then, click Tokenize in the Credit Card Data section to activate tokenization for credit card data.

Credit Card Data Encryption
You can encrypt your credit card data to assist with your compliance of cardholder data protection requirements with
these initiatives:

• Payment Card Industry Data Security Standard

• Visa's Cardholder Information Security Program

Credit card numbers entered in Oracle Receivables and Oracle Collections are automatically encrypted. Encryption is
based on the credit card encryption setting you specify on the Manage System Security Options page.

Note:  If you import card numbers into Payments, you should run the Encrypt Credit Card Data program immediately
afterward.

Bank Account Data Encryption
You can encrypt your supplier and customer bank account numbers.

Bank account encryption doesn't affect internal bank account numbers. Internal bank accounts are set up in Cash
Management. They are used as disbursement bank accounts in Payables and as remit-to bank accounts in Receivables.

Supplier, customer, and employee bank account numbers entered in Oracle applications are automatically encrypted.
Encryption is based on the bank account encryption setting you specify on the Manage System Security Options page.

Note:  If you import bank account numbers into Payments, you should run the Encrypt Bank Account Data program
immediately afterward.

Master Encryption Key and Subkey Rotation
For payment instrument encryption, Payments uses a chain key approach. The chain key approach is used for data
security where A encrypts B and B encrypts C. In Payments, the master encryption key encrypts the subkeys and the
subkeys encrypt the payment instrument data. This approach enables easier rotation of the master encryption key.

The master encryption key is stored on Oracle Platform Security Services. Oracle Platform Security Services stores
data in an encrypted format. The master encryption key can be rotated, or generated, which also encrypts subkeys, but
doesn't result in encrypting the bank account numbers again.

If your installation has an existing master encryption key, click Rotate to automatically generate a new one.
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Note:  To secure your payment instrument data, you should rotate the master encryption key annually or according to
your company's security policy.

You can also select the frequency with which new subkeys are automatically generated, based on usage or on the
maximum number of days. To specify a subkey rotation policy, click Edit Subkey Rotation Policy.

Note:  To secure your payment instrument data, you're advised to schedule regular rotation of the subkeys.

The security architecture for credit card data and bank account data encryption is composed of these components:

• Oracle Platform Security Services

• Payments master encryption key

• Payments subkeys

• Sensitive data encryption and storage

This figure illustrates the security architecture of the Oracle Platform Security Services repository, the master encryption
key, and the subkeys.

Credit Card and Bank Account Number Masking
Payments serves as a payment data repository for customer and supplier information. It stores all of the customer and
supplier payment information and their payment instruments, such as credit cards and bank accounts. It provides data
security by letting you mask bank account numbers.

On the Manage System Security Options page, you can mask credit card numbers and external bank account numbers.
You just have to select the number of digits to mask and display. For example, a bank account number of XX558012
displays the last six digits and masks all the rest. These settings specify masking for payment instrument numbers in
the user interfaces of multiple applications.
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Note:  For credit cards, you can unmask only up to the first or last four digits of the credit card number. On the other
hand, you can unmask up to the first or last six digits of a bank account number.

Related Topics
• Enable Encryption of Sensitive Payment Information

• PCI DSS Credit Card Processing Requirements

Enable Encryption of Sensitive Payment Information  
Financial transactions contain sensitive information, which must be protected by a secure, encrypted mode. To protect
your credit card and external bank account information, you can enable encryption.

Encryption encodes sensitive data, so it can't be read or copied. To enable encryption, you must create a master
encryption key. Oracle Platform Security Services is a repository that stores your master encryption key. The application
uses your master encryption key to encrypt your sensitive data.

Note:  Before you can import credit cards into Expenses, you must enable encryption or tokenization of credit cards in
Payments. If you're using credit card data anywhere other than Expenses, you must enable tokenization in Payments.

To secure your credit card or bank account data, complete these steps:

1. In the Setup and Maintenance work area, go to Financials > Payments > Manage System Security Options.
2. On the Manage System Security Options page, click Apply Quick Defaults.
3. Select all the check boxes:

◦ Automatically create wallet file and master encryption key

◦ Encrypt credit card data

◦ Encrypt bank account data

4. Click Save and Close.

Business Intelligence  

Overview of Financial Reporting Security  
Security for financial reporting uses Role Based Access Control, which has the following components:

• Users with roles.

• Roles that grant access to functions and data.

• Functions and data access that is determined by the combination of role.

Note:  Users can have any number of roles.
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Data security, which controls what action can be taken against which data, can also be applied to financial reporting.
Data security is managed using:

• Data Access Sets:

◦ Are defined to grant access to a ledger, ledger set, or specific primary balancing segment values
associated with a ledger.

◦ Permit viewing of journals, balances, and reports.

• Segment Value Security Rules:

◦ Are set up on value sets to control access to parent or detail segment value for chart of accounts
segments.

◦ Restrict data entry, online inquiry, and reporting.

Note:  For more information about security, see the Securing Oracle ERP Cloud guide.

Related Topics
• Overview of Data Access Set Security

• Examples of Data Access Set Security

• Segment Value Security

• Example of Segment Value Security

Oracle Fusion Transactional Business Intelligence Security  
Oracle Fusion Transactional Business Intelligence is a real-time, self-service reporting solution.

All application users with appropriate roles can use Transactional Business Intelligence to create analyses that support
decision making. In addition, business users can perform current-state analysis of their business applications using
a variety of tools. These include Oracle Transactional Business Intelligence as the standard query and reporting tool,
Oracle Analytics Answers, and Oracle Business Intelligence Dashboard tools. This topic summarizes how access is
secured to Transactional Business Intelligence subject areas, Business Intelligence Catalog folders, and Business
Intelligence reports.

Subject Areas
Subject areas are functionally secured using duty roles. The names of duty roles that grant access to subject areas
include the words Transaction Analysis Duty (for example, Payables Invoice Transaction Analysis Duty).

The following table identifies the subject areas that predefined Financials job roles can access.

Financials Job Role Subject Areas

Accounts Payable Manager
 

All Payables
 

Accounts Payable Specialist
 

All Payables
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Financials Job Role Subject Areas

Accounts Payable Supervisor
 

Payables Invoices - Installments Real Time, Payables Payments - Disbursements Real Time, Payables
Payments - Payment History Real Time
 

Accounts Receivable Manager
 

All Receivables
 

Accounts Receivable Specialist
 

All Receivables
 

Asset Accountant
 

Fixed Assets - Asset Depreciation Real Time, Fixed Assets - Asset Retirements and Reinstatements Real
Time, Fixed Assets - Asset Source Lines Real Time, Fixed Assets - Asset Transactions Real Time, Fixed
Assets - Asset Transfer Real Time
 

Asset Accounting Manager
 

All Fixed Assets
 

Budget Manager
 

Budgetary Control - Transactions Real Time
 

Cash Manager
 

All Cash Management
 

Expense Manager
 

All Expenses
 

Financial Analyst
 

All Financials
 

Financial Application Administrator
 

All Financials
 

Financial Integration Specialist
 

All Financials
 

General Accountant
 

General Ledger - Journals Real Time, General Ledger - Period Status Real Time
 

General Accounting Manager
 

All General Ledger, All Payables, All Receivables
 

Intercompany Accountant
 

Financials Common Module - Intercompany Transactions Real Time
 

Tax Accountant
 

Payables Invoices - Withholding Real Time, Receivables - Customer Account Site Tax Profile Real Time
 

Tax Administrator
 

Payables Invoices - Withholding Real Time, Receivables - Customer Account Site Tax Profile Real Time
 

Tax Manager
 

Payables Invoices - Withholding Real Time, Receivables - Customer Account Site Tax Profile Real Time,
Receivables - Customer Tax Profile Real Time
 

Tax Specialist
 

Payables Invoices - Withholding Real Time, Receivables - Customer Account Site Tax Profile Real Time,
Receivables - Customer Tax Profile Real Time
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In addition, Oracle Fusion Cloud Financials includes predefined self-service reporting duties that provide access to
Transactional Business Intelligence subject areas and drilldown pages. They can be used as building blocks to construct
reporting roles to provide self service reporting access.

This table identifies the subject areas that predefined Financials self-service reporting duty roles can access.

Financials Self-Service Reporting Duties Subject Areas

Budgetary Control Self Service Reporting
Duty

All Budgetary Control

Cash Management Self Service Reporting
Duty

All Cash Management

Expense Self Service Reporting Duty All Expenses

Fixed Asset Self Service Reporting Duty All Fixed Assets

General Ledger Self Service Reporting
Duty

All General Ledger, Financials Common Module - Intercompany Transactions Real Time

Payables Self Service Reporting Duty All Payables

Receivables Self Service Reporting Duty All Receivables

Revenue Management Self Service
Reporting Duty

All Revenue Management

Analyses fail if the user can't access all subject areas in a report.

Business Intelligence Catalog Folders
Business Intelligence Catalog folders are functionally secured using the same duty roles that secure access to the
subject areas.

The following table identifies the folders that predefined Financials job roles can access.

Financials Job Role Business Intelligence Catalog Folders

Accounts Payable Manager
 

Transactional Business Intelligence Payables
 

Accounts Payable Specialist
 

Transactional Business Intelligence Payables
 

Accounts Payable Supervisor
 

Transactional Business Intelligence Payables
 

Accounts Receivable Manager
 

Transactional Business Intelligence Receivables
 

Accounts Receivable Specialist
 

Transactional Business Intelligence Receivables
 

Asset Accountant
 

Transactional Business Intelligence Fixed Assets
 

Asset Accounting Manager Transactional Business Intelligence Fixed Assets
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Financials Job Role Business Intelligence Catalog Folders

  

Budget Manager
 

Transactional Business Intelligence Budgetary Control
 

Cash Manager
 

Transactional Business Intelligence Cash Management
 

Expense Manager
 

Transactional Business Intelligence Expenses
 

Financial Analyst
 

Transactional Business Intelligence Financials
 

General Accountant
 

Transactional Business Intelligence General Ledger
 

General Accounting Manager
 

Transactional Business Intelligence General Ledger
 

Intercompany Accountant
 

Transactional Business Intelligence Intercompany Accounting
 

Tax Accountant
 

Transactional Business Intelligence Transaction Tax
 

Tax Administrator
 

Transactional Business Intelligence Transaction Tax
 

Tax Manager
 

Transactional Business Intelligence Transaction Tax
 

Tax Specialist
 

Transactional Business Intelligence Transaction Tax
 

Business Intelligence Reports
Analyses are secured based on the folders in which they're stored. If you haven't secured Business Intelligence reports
using the report privileges, then they're secured at the folder level by default. You can set permissions against folders
and reports for Application Roles, or Users.

You can set permissions to:

• Read, Execute, Write, or Delete

• Change Permissions

• Set Ownership

• Run Publisher Report

• Schedule Publisher Report

• View Publisher Output
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How Reporting Data Is Secured  
The data that's returned in Oracle Transactional Business Intelligence reports is secured in a similar way to the data
that's returned in application pages.

Data access is granted by roles that are linked to security profiles. This topic describes the part played by Transaction
Analysis Duty Roles in securing access to data in Transactional Business Intelligence reports. It also describes how to
enable this access in custom job roles.

Transaction Analysis Duty Roles
Each of the Transaction Analysis Duty roles providing access to subject areas and Business Intelligence Catalog folders
is granted one or more data security policies. These policies enable access to the data.

Custom Job Roles
If you create a custom job role with access to Transactional Business Intelligence reports, then you must give the role
the correct duty roles. Your custom role must have both the OBI and Financials versions of the Transaction Analysis
Duty roles. These duty roles ensure that your custom job role has the function and data security for running the reports.

For example, if your role must access the Fixed Asset Transaction Analysis subject areas, then it must inherit the duty
roles described in the following table:

Duty Role Version

Fixed Asset Transaction Analysis Duty
 

OBI
 

Fixed Asset Transaction Analysis
 

Financials
 

The Fixed Asset Transaction Analysis Duty role is granted relevant data security policies and inherits Business
Intelligence Consumer Role.

Business Intelligence Roles  
Oracle Business Intelligence roles apply to both Oracle Business Intelligence Publisher and Oracle Fusion Transactional
Business Intelligence.

They grant access to Business Intelligence functionality, such as the ability to run or author reports. These roles are in
addition to the roles that grant access to reports, subject areas, Business Intelligence catalog folders, and Financials
data. This topic describes the Business Intelligence roles.

This table lists the Business Intelligence roles.
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Business Intelligence Role Description

Business Intelligence Consumer Role
 

Allows reporting from Business Intelligence Applications, Business Intelligence Publisher, Real Time
Decisions, Enterprise Performance Management and Business Intelligence Office. This role allow you
to run reports from the web catalog but it will not allow a report to be authored from a subject area.
 

Business Intelligence Authoring
 

Allows authoring within Business Intelligence Applications, Business Intelligence Publisher, Real Time
Decisions, Enterprise Performance Management and Business Intelligence Office.
 

Business Intelligence Applications Analysis
 

Performs Business Intelligence Applications Analysis generic duty.
 

Fixed Asset Business Intelligence
Management
 

Manages access to Fixed Assets OBIA Dashboard.
 

Business Intelligence Applications
Administrator
 

Provides access to the BI Applications Configuration Manager and to the BI Data Warehouse
Administration Console.
 

Delivered Roles for Financials Subject Areas  
Access to subject areas in the Oracle Business Intelligence Catalog is secured by OTBI Transactional Analysis Duty roles.

The following table lists subject areas and the corresponding job role and OTBI Transactional Analysis duty role that are
required for creating user-defined reports using the subject areas. The OTBI Transactional Analysis duty role is inherited
by the job role. Use this table to verify that your users have the job roles necessary to create reports using subject areas.

Note:  The Business Intelligence Consumer role allows users to view reports, but not create new ones. All self-service
reporting duties inherit this Business Intelligence Consumer role. All other job roles inherit the Business Intelligence
Author role, enabling users with those job roles to create new reports. The following table lists subject areas for
Financials and the default security roles needed for each one.

Subject Areas Job Role Self Service Reporting Duty OTBI Transactional Analysis Duty
Role

• Budgetary Control -
Transactions Real Time

Budget Manager
 

Budgetary Control Self Service
Reporting Duty

Budgetary Control Analysis Duty
 

• Cash Management - Bank
Statement Balances Real
Time

• Cash Management - Bank
Statement Line Charges Real
Time

• Cash Management - Bank
Statements Real Time

• Cash Management - External
Cash Transactions Real Time

Cash Manager
 

Cash Management Self Service
Reporting Duty

• Cash Management
Transaction Analysis Duty
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Subject Areas Job Role Self Service Reporting Duty OTBI Transactional Analysis Duty
Role

• Expenses - Employee
Expense Overview Real Time

• Expenses - Expense
Transactions Real Time

Expense Manager
 

Expense Self Service Reporting
Duty

 
• Expenses Summary

Transaction Analysis Duty

• Expense Transactions
Transaction Analysis Duty

• Financials Common Module
- Intercompany Transactions
Real Time

• Intercompany Accountant

• General Accountant

General Ledger Self Service
Reporting Duty

Inter Company Transaction
Analysis Duty
 

• Fixed Assets - Asset
Assignments Real Time

• Fixed Assets - Asset Balances
Real Time

• Fixed Assets - Asset
Depreciation Real Time

• Fixed Assets - Asset Financial
Information Real Time

• Fixed Assets - Asset
Retirements and
Reinstatements Real Time

• Fixed Assets - Asset Source
Lines Real Time

• Fixed Assets - Asset
Transactions Real Time

• Fixed Assets - Asset Transfer
Real Time

Asset Accountant
 

Fixed Asset Self Service Reporting
Duty

• Fixed Asset Transaction
Analysis Duty

• Fixed Asset Details
Transaction Analysis Duty

• Fixed Depreciation
Transaction Analysis Duty

• Fixed Asset Details
Transaction Analysis Duty

• General Ledger - Balances
Real Time

• General Ledger - Journals
Real Time

• General Ledger - Period
Status Real Time

• General Ledger -
Transactional Balances Real
Time

General Accountant
 

General Ledger Self Service
Reporting Duty

• General Ledger Transaction
Analysis Duty

• Payables to Ledger
Reconciliation Transaction
Analysis Duty

• Receivables to Ledger
Reconciliation Transaction
Analysis Duty

• Payables Invoices -
Installments Real Time

• Payables Invoices -
Prepayment Applications Real
Time

• Payables Invoices -
Transactions Real Time

• Payables Invoices - Trial
Balance Real Time

• Payables Invoices -
Withholding Real Time

• Accounts Payable Manager

• Accounts Payable Specialist

• General Accountant

Payables Self Service Reporting
Duty

• Payables to Ledger
Reconciliation Transaction
Analysis Duty

• Payables Invoice Transaction
Analysis Duty

• Payables Payment
Transaction Analysis Duty
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Subject Areas Job Role Self Service Reporting Duty OTBI Transactional Analysis Duty
Role

• Payables Payments -
Disbursements Real Time

• Payables Payments - Payment
History Real Time

• Receivables - Adjustments
Real Time

• Receivables - Bills Receivable
Real Time

• Receivables - Credit Memo
Applications Real Time

• Receivables - Credit Memo
Requests Real Time

• Receivables - Customer
Account Site Tax Profile Real
Time

• Receivables - Customer Real
Time

• Receivables - Customer Tax
Profile Real Time

• Receivables - Miscellaneous
Receipts Real Time

• Receivables - Payment
Schedules Real Time

• Receivables - Receipt
Conversion Rate Adjustments
Real Time

• Receivables - Receipts Details
Real Time

• Receivables - Revenue
Adjustments Real Time

• Receivables - Standard
Receipts Application Details
Real Time

• Receivables - Transactions
Real Time

• Accounts Receivable Manager

• Accounts Receivable
Specialist

• General Accountant

Receivables Self Service Reporting
Duty

• Receivables to Ledger
Reconciliation Transaction
Analysis Duty

• Receivables Customer
Transaction Analysis Duty

• Receivables Transaction
Analysis Duty

• Receivables Receipts
Transaction Analysis Duty

• Subledger Accounting -
Journals Real Time

• Subledger Accounting
- Payables Summary
Reconciliation Real Time

• Subledger Accounting
- Receivables Summary
Reconciliation Real Time

• Subledger Accounting -
Supporting References Real
Time

• Cash Manager

• Accounts Payable Manager

• Accounts Receivable Manager

• Asset Accountant

• Cash Management Self
Service Reporting Duty

• Fixed Asset Self Service
Reporting Duty

• Payables Self Service
Reporting Duty

• Receivables Self Service
Reporting Duty

Subledger Accounting Transaction
Analysis Duty
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Reporting Roles and Permissions  
Viewing reporting roles and permissions can help you to understand how Oracle Transactional Business Intelligence
security works.

This topic explains how to view:

• The reporting roles that a job role inherits

• The permissions for sample Oracle Transactional Business Intelligence reports in the Business Intelligence
Catalog

Viewing Inherited Reporting Roles on the Security Console
Sign in with the IT Security Manager job role and follow these steps:

1. Select Navigator > Tools > Security Console.
2. On the Security Console, search for and select a job role. For example, search for and select the Accounts

Payable Manager job role.

Depending on the enterprise setting, either a graphical or a tabular representation of the role appears. Switch to
the tabular view if it doesn't appear by default.

3. Accounts Payable Manager inherits many duty roles, such as Payables Balance Analysis and Payables Invoice
Processing. These roles (without the word Duty in their names) are Financials roles. Their role codes start with
the characters ORA_. Find these roles in the table.

4. Notice also the many Transaction Analysis Duty roles (with the word Duty in their names) that appear at the
console. For example, Accounts Payable Manager inherits the Transactional Analysis Duty. These roles are OBI
roles. Their role codes start with the characters FBI_. Find these roles in the table.

5. Notice that the Payables Invoice Transaction Analysis Duty role inherits BI Consumer Role. Most of the OBI duty
roles inherit BI Consumer Role.

Tip:  You can export the role hierarchy to a spreadsheet for offline review.

Viewing Permissions in the Business Intelligence Catalog
To view these permissions, you must have a role that inherits BI Administrator Role. None of the predefined Financials
job roles inherits BI Administrator Role.

1. Select Navigator > Tools > Reports and Analytics to open the Reports and Analytics work area.
2. In the Contents pane, click the Browse Catalog icon. The Business Intelligence Catalog page opens.
3. In the Folders pane, expand Shared Folders.

Expand the Financials folder and then the Bill Management folder.
4. Click the Customers Export Report folder.

A list of reports appears on the BI Catalog page.
5. Click Costing Reports > More > Permissions.

The Permissions dialog box opens. Scroll if necessary to see the complete list of permissions, which includes
the role BI Administrator Role.
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6. Click the Oracle Applications tab to return to the home page.

Configure Security for Oracle Transactional Business Intelligence  
Oracle Transactional Business Intelligence secures reporting objects and data through a set of delivered Transaction
Analysis Duty roles.

You can't configure the Transaction Analysis Duty roles provided with Oracle Financials Cloud, or the associated security
privileges. However, you can configure reporting security according to your security requirements as described in this
topic.

Oracle Transactional Business Intelligence secures reporting objects and data through the following types of roles:

• Reporting objects and data are secured through the predefined OTBI Transactional Analysis Duty roles. The
Transaction Analysis Duty roles control which subject areas and analyses a user can access and what data a
user can see.

• Business Intelligence roles, for example, BI Consumer Role, or BI Author Role. These roles grant access to
Business Intelligence functionality, such as the ability to run or author reports. Users need one or more of these
roles in addition to the roles that grant access to reports and subject areas to create and run reports and view
analytics.

You can't copy or modify the Business Intelligence roles or the Transaction Analysis Duty roles provided with Oracle
Financials, or the associated security privileges. In addition, any role with a role code prefix of OBIA, for example,
Business Intelligence Applications Analysis Duty (OBIA_ANALYSIS_GENERIC_DUTY), can also not be copied. However,
you can configure reporting security according to your security requirements as described in this topic.

Modifying Transaction Analysis Duty Role Assignments
To configure the subject areas that users have access to create a custom job role and provide the role with the Oracle
Transactional Business Intelligence duty roles that provide the required access.

For example, you can create a role that provides access to both general ledger and fixed assets subject areas by
assigning both the General Ledger Transaction Analysis Duty and the Fixed Asset Transaction Analysis Duty to the role.

Modifying Business Intelligence Role Assignments
The Business Intelligence roles enable users to perform tasks within Business Intelligence tools such as Oracle Analytics
Publisher. The default Business Intelligence roles used in Oracle Financials Cloud are BI Consumer and BI Author.

The delivered Transaction Analysis Duty roles inherit the BI Consumer Role, which provides view-only access to
analyses and reports. You assign the BI Author Role at the job role level, giving you flexibility in granting the BI Author
privilege to only those job roles that you want to have access to create and edit analyses and reports.

All predefined Financials Cloud job roles that inherit a Transaction Analysis Duty role are also assigned the BI Author
Role by default. You can optionally create copies of the predefined job roles and add or remove the BI Author Role from
the roles as required.

Business Intelligence Publisher Secured List Views  
Oracle Analytics Publisher is a set of tools for creating formatted reports based on data models.
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You can access Analytics Publisher from Business Intelligence Composer or the Business Intelligence Catalog by clicking
NewReport . This topic describes how you can use secured list views to secure access to data in Business Intelligence
reports.

Some reporting tools combine the data model, layout, and translation in one report file. With that approach, business-
intelligence administrators must maintain multiple copies of the same report to support minor changes. By contrast,
Analytics Publisher separates the data model, layout, and translation. Therefore, reports can be:

• Generated and consumed in many output formats, such as PDF and spreadsheet

• Scheduled for delivery to e-mail, printers, and so on

• Printed in multiple languages by adding translation files

• Scheduled for delivery to multiple recipients

Analytics Publisher Data Security and Secured List Views
When you create a Analytics Publisher data model with physical SQL, you have two options.

You can:

1. Select data directly from a database table, in which case the data you return isn't subject to data-security
restrictions. Because you can create data models on unsecured data, you're recommended to minimize the
number of users who can create data models.

2. Join to a secured list view in your select statements. The data returned is determined by the security profiles
that are assigned to the roles of the user who's running the report.
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3  Implement Oracle Financials Cloud

Overview of Implementing Financials  
To start your Financials implementation, use the Application Implementation Consultant role
(ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) to opt into the offerings that meet your business
requirements. Refer to the Oracle Applications Cloud Using Functional Setup Manager guide to manage the opt-in and
setup of your offerings.

Financials Offering
By using the Financials offering, you can configure how you manage financial flows, including assets, ledgers,
cash cycle, invoices and payments, accounts receivable, collections, and the setup of subledger accounting and tax
configuration.

The following table specifies the primary functional areas of this offering. For the full list of functional areas and
features in this offering, use the Associated Features report that you review when you plan the implementation of your
offering.

Functional Area Description

Bill Management
 

Manage system options and user registrations.
 

Budgetary Control and Encumbrance
Accounting
 

Manage control budgets and encumbrance accounting, along with data access for users. Public sector
customers typically use this functional area.
 

Cash Management and Banking
 

Manage banks, bank branches, and bank accounts. Additionally, define reconciliation matching rules,
 bank statement transaction creation rules, parse rules, transaction codes, and transaction type
mapping. Furthermore, configure your cash positioning and cash forecasting options.
 

Collections
 

Manage aging methods and collectors, as well as collections preferences, scoring data points, and
strategy tasks.
 

Customer Billing
 

Manage Receivables transactions and customer billing: AutoInvoice, payment terms, transaction types,
 transaction sources, memo lines, balance forward billing, and recurring billing.
 

Customer Payments
 

Manage Receivables customer payments and receipts: receipt classes and methods, AutoCash rules,
 Application rules, AutoMatch, Lockbox.
 

Expenses
 

Manage expense report templates, approval rules, and conversion rates and policies. If applicable, opt
into using corporate cards for expenses, processing of expense receipt imaging, or integration with
travel.
 

Financial Reporting Center
 

Manage the financial tools to report and analyze accounting data: Financial Reporting Center, Smart
View, Financial Reporting Studio, and Workspace.
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Functional Area Description

Fixed Assets
 

Manage asset locations, calendars, books and categories, along with depreciation methods.
 

General Ledger
 

Manage ledgers, accounting configurations, journal sources and categories, and other related
accounting setup. If applicable, opt into configuring journal approval email notifications.
 

Intercompany
 

Manage Intercompany transaction processing within Financials, intercompany balancing and
reconciliation.
 

Joint Venture Management
 

Manage the distribution of joint venture revenue and costs among joint venture partners while
preserving essential data for tracking and auditing.
 

Payables
 

Manage supplier invoice and payment options, payment terms, distribution sets, invoice tolerances,
 and procurement agents.
 

Payments
 

Manage payment systems, payment methods, formats, and payment process profiles. If applicable, opt
into deriving a bank account number from IBAN.
 

Receivables
 

Manage the required setups to enable Receivables for transactions and receipts: Receivables system
options; Receivables activities; AutoAccounting rules; remit-to addresses; and statement cycles.
 

Revenue Management
 

Manage system options for revenue management, selling price profiles, hierarchies, resources, and
Trading Community source systems.
 

Revenue Recognition
 

Manage revenue recognition for Receivables: revenue policies and revenue contingencies.
 

Suppliers
 

Configure options for suppliers and supplier data.
 

Transaction Tax
 

Manage tax configuration, including tax regimes, taxes, and tax rates.
 

U.S. Federal Financials
 

Manage the financial management system options specifically defined for U.S. Federal agencies.

Note:  Enable U.S. Federal Financials only if you are a U.S. federal agency. When you enable U.S.
Federal Financials, you incorporate processes, data elements, reporting, and accounting methods
specific to federal agencies.

 

Related Topics
• Plan Your Implementation
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Overview of the Financials Configuration for Rapid
Implementation  
Simplify your setup and focus only on the critical steps by using the Define Financials Configuration for Rapid
Implementation task list.

The rapid implementation task list includes tasks that are:

• Critical for initial setup

• Required by most users

To create an implementation project that includes the Define Financials Configuration for Rapid Implementation
task list, use the Manage Implementation Projects page in the Setup and Maintenance work area. The application
implementation manager can edit the task list and assign and track each task.

Note:  You can change the standard setup configuration in the rapid implementation task list. Simply add the
standard Financials offering task lists and tasks to your rapid implementation project to update your setup.

Task Lists
The Define Financials Configuration for Rapid Implementation task list include the following task lists for specific
functional areas within your Oracle Financials Cloud implementation:

Task List Description

Define Common Financials Configuration
for Rapid Implementation
 

Common configuration for Oracle Financials Cloud rapid implementation, which includes enterprise
structures and banks setup.
 

Define Transaction Taxes for Rapid
Implementation
 

Tax setup to address local and international tax requirements.
 

Define Financials Security Configuration
for Rapid Implementation
 

User and data roles setup for Oracle Financials Cloud rapid implementation.
 

Define Ledger Configuration for Rapid
Implementation
 

General Ledger rapid implementation that includes general ledger and intercompany.
 

Define Financial Reporting Center
Configuration for Rapid Implementation
 

Financial Reporting Center rapid implementation that includes setup for financial reporting and
integration with planning and financial management applications.
 

Define Invoicing and Payments
Configuration for Rapid Implementation
 

Invoicing and payments configuration for Payables rapid implementation.
 

Define Expenses Configuration for Rapid
Implementation

Corporate expense policies and rules, expense types, and expense report approval rules for Expenses
rapid implementation.
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Task List Description

  

Define Fixed Assets Configuration for
Rapid Implementation
 

Configuration for Assets rapid implementation.
 

Define Receivables Configuration for Rapid
Implementation
 

Configuration for Receivables rapid implementation.
 

Note:  Remember to perform the Open First Period task since it's required and a part of the Define Financials
Configuration for Rapid Implementation task list.

Configuring Rapid Implementation Tasks Lists
Depending on the applications you're implementing, you can simplify your task lists even more. For example, if you're
only implementing Receivables, you can remove the following task lists from your implementation project:

• Define Invoicing and Payments Configuration for Rapid Implementation

• Define Expenses Configuration for Rapid Implementation

• Define Fixed Assets Configuration for Rapid Implementation

Related Topics
• Example of an Oracle Financials Cloud Rapid Implementation Project

Example of an Oracle Financials Cloud Rapid
Implementation Project  
This example shows how to create an implementation project for the Oracle Financials rapid implementation task list.

Here are the key decisions for this example:

Decision to Consider In This Example

What applications are included in this
implementation?
 

You're implementing:
 

• General Ledger

• Financial Reporting Center

• Payables

• Receivables

• Expenses

• Assets
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Decision to Consider In This Example

• Cash Management

• Tax

Are the setup requirements unique to this
organization?
 

No
 

Can the rapid implementation task
lists and tasks be used for this
implementation?
 

Yes
 

Create the Implementation Project
1. Click Navigator > Setup and Maintenance.
2. On the Setup page, open the panel tab and click Manage Implementation Projects.
3. On the Implementation Projects page, click the Create icon in the Search Results table.
4. On the Create Implementation Project: Enter Basic Information page, enter Implementation Project-

FIN_Rapid_Implementation in the Name field.
5. Click in the Description field to automatically update the name in the description.
6. Click the Save and Open Project button.
7. On the Implementation Project: Implementation Project-FIN_Rapid_Implementation page, click Add in the Task

Lists and Tasks table.
8. On the Select and Add: Task Lists and Task dialog box, select Task list in the Search field.
9. Enter %Rapid Implementation% in the Name field. Use wildcard characters if you don't know the exact name

of the task list or task.
10. Click Search.
11. Select the Define Financials Configuration for Rapid Implementation row.
12. Click Done.
13. On the Implementation Project: Implementation Project-FIN_Rapid_Implementation page, expand the task list

to see the task lists and tasks for your implementation project.
14. Click Done.

Common Financials Configuration  

Overview of Geographies  
Setting up your geography structure and master geographies correctly in the Trading Community Model is critical to the
proper use and management of Oracle Enterprise Resource Planning (ERP) Cloud applications.

The geography structure and master geography data is shared across multiple product families and applications.
Address validation ensures complete and valid master address data across all location entities across product
applications. In addition, complete and valid master data is critical for accurate transaction tax calculation.

You can either define your geography structure and corresponding master geographies manually or import these
geography entities. You can use the:

1. Manage Geographies page
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2. Import Management process
For more information about managing your geographies, see the Geographies section in the Define Enterprise
Structures chapter in the Oracle ERP Cloud Implementing Common Features for Financials and Project Management
guide on Oracle Help Center (https://docs.oracle.com).

Manage Geographies
Use the Manage Geographies page to manually define your geography structure, hierarchy, mapping, and validation.
Manually define your geographies when you have a simple geography requirement with a limited number of
geographies within an individual country.

Import Management
Use the Import Management process to read the data included in your XML or text file and import the data into the
application.

To access Import Management functionality, go to Navigator > Tools > Import Management.

For more information, see the Import Your Geography Data topic.

Related Topics
• How do I manage Geography Structures, Hierarchies, and Validation?

Implement Enterprise Structures  
The Define Common Financials Configuration for Rapid Implementation task list provides a framework for developing
and managing your chart of accounts, ledgers, legal entities, and business units to meet your accounting and reporting
requirements.

Setting Up Enterprise Structures
The tasks in this list relate to the setup of enterprise structures. These tasks are the basic setup steps. They may be
interspersed with other tasks that aren't required to implement Oracle Financials Cloud. In the Setup and Maintenance
work area, create an implementation project that includes the Define Financials Configuration for Rapid Implementation
task list. That task list includes the Define Common Financials Configuration for Rapid Implementation task list. Each
task is performed by the Application Implementation Consultant.

Note:  These tasks are also included in the Define Enterprise Structures Configuration for Rapid Implementation task
list, which you can add to your implementation project in the Setup and Maintenance work area.

All documentation references are from the Oracle Financials Cloud Implementing Enterprise Structures and General
Ledger guide.

1. Manage geographies.

◦ Perform the task Manage Geographies to enable the list of values for address fields in user interfaces.

◦ See: Geographies chapter: Define Geographies: Overview

72

https://www.oracle.com/pls/topic/lookup?ctx=fa23d&id=s20033985


Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 3
Implement Oracle Financials Cloud

2. Create chart of accounts, ledger, legal entities, and business units in a spreadsheet.

◦ Perform the task Create Chart of Accounts, Ledger, Legal Entities, and Business Units in
Spreadsheet to create a spreadsheet for entering the primary ledger and all accompanying enterprise
structures. Spreadsheet entry includes the chart of accounts with segment values and account
hierarchies, associated business units, and associated legal entities. In addition, the spreadsheet includes
the rules for generating sequential identifiers for transactions recorded in the application and certain
setup objects along with their accounting specifications for various modules of Oracle Financials Cloud.

◦ See: Financial Structures chapter

- Enterprise Structures Rapid Implementation: Overview
- Create Chart of Accounts, Ledger, Legal Entities, and Business Units in Spreadsheets: Explained
- Create Chart of Accounts, Ledger, Legal Entities, and Business Units in Spreadsheets: How They're

Processed
3. Upload the chart of accounts.

◦ Perform the task Upload Chart of Accounts to load the chart of accounts structure, including segments
and value sets, from the spreadsheet.

◦ See: Financial Structures chapter: Create Chart of Accounts, Ledger, Legal Entities, and Business Units in
Spreadsheets: How They're Processed

4. Upload the ledger, legal entities, and business units.

◦ Perform the task Upload Ledger, Legal Entities, and Business Units to load key enterprise structures,
including the ledger, legal entities, and business units that are dependent on the chart of accounts.

◦ See: Financial Structures chapter: Create Chart of Accounts, Ledger, Legal Entities, and Business Units in
Spreadsheets: How They're Processed.

5. Create cross-validation rules.

◦ Perform the task Create Cross Validation Rules in Spreadsheet for the chart of accounts to determine
the account combinations that users can create dynamically as they enter transactions or journal entries.

◦ See: Financial Structures chapter

- Cross-Validation Rules in General Ledger: Overview
- Cross-Validation Rules: Explained
- Cross-Validation Rules: Points to Consider
- Cross-Validation Rules Spreadsheet: Explained
- Creating Cross-Validation Rules in a Spreadsheet: Worked Example

After performing the enterprise structures tasks, run the Enterprise Structures Setup Report and diagnostic tests for the
enterprise structures setup data.

• See: Enterprise Structures Introduction chapter

◦ Enterprise Structures Setup Report: Explained

◦ Running Diagnostic Tests for Enterprise Structures Setup Data: Explained
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How You Implement Cash Management  
The Oracle Fusion Cash Management product provides a framework for developing and managing your banks, bank
branches, and bank accounts.

Setting Up Cash Management
The tasks in this list relate to the setup and uploading of banks, bank branches, and bank accounts. These are the basic
tasks that appear in the Setup and Maintenance work area.

For setting up cash management, each task is performed by the Application Implementation Consultant. All
documentation references are from the Oracle Financials Cloud Implementing Payables Invoice to Pay guide, Cash
Management and Banking Configuration chapter.

1. Create banks, branches, and accounts in a spreadsheet.

◦ Perform the task Create Banks, Branches, and Accounts in Spreadsheet to create your bank, branch,
and account information.

2. Upload banks, branches, and accounts.

◦ Perform the task Upload Banks, Branches, and Accounts to import your bank, branch, and account
information into Cash Management.

◦ See:

- Cash Management Rapid Implementation: Overview

Related Topics

Implement Tax  
Oracle Fusion Tax provides a single-point solution for managing your transaction and withholding tax requirements.

Oracle Fusion Tax:

• Uniformly delivers tax services to all core Oracle Fusion application business flows through one application
interface.

• Provides features for uploading third-party tax partner content.

• Is configurable and scalable for adding and maintaining country-specific tax content.

Setting Up Oracle Fusion Tax
The Define Taxes for Rapid Implementation task list provides the required and most frequently used setup tasks for
implementation scenarios. Using spreadsheets, you can upload your tax setups to create tax regimes, taxes, tax rates,
and tax rules.

You can use the standard Define Tax Configuration task list for:

• The ongoing maintenance of your tax setup.

74



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 3
Implement Oracle Financials Cloud

• Limited tax configurations that can't be set up or updated using the rapid implementation approach.

To set up Oracle Fusion Tax, the Application Implementation Consultant or Tax Manager must perform the following
tasks:

1. Manage tax regimes.

◦ Perform the Manage Tax Regimes task to create and maintain tax regimes for the taxes in each country
and geographic region where a separate tax or collection of taxes apply.

You can use the Tax Configuration Workbook to upload all common tax regime setups as well as your
organization specific setups, such as tax regime subscriptions.

You can also use the individual Tax Regimes and Tax Regime Subscriptions spreadsheets to exclusively
create tax regimes and tax regime subscriptions.

◦ See the following topics::

- Tax Configuration Workbook: Explained
- Creating Tax Setup Using the Tax Configuration Workbook: Worked Example
- Creating Tax Setup Using Tax Partner Content in the Tax Configuration Workbook: Worked Example
- Tax Implementation Workbook: Explained
- Creating Tax Setup Using the Tax Implementation Workbook: Worked Example
- Creating a Tax Regime Using the Manage Tax Regimes Spreadsheet: Worked Example

2. Run the jurisdiction and rates upload program.

◦ For SaaS (Oracle Cloud) implementations, run the Import Tax Configuration Content job.

◦ Refer to the Tax Configuration Content Upload Program: How It Is Processed topic.

3. Manage taxes.

◦ Perform the Manage Taxes task to create and maintain details for the taxes of tax regimes.

You can use the Tax Configuration Workbook to upload all common tax setups.

You can also use the individual Taxes spreadsheet to create taxes for a tax regime or a collection of
tax regimes. Additionally, you can use the individual Tax Accounts spreadsheet to create tax account
assignments.

◦ See the following topics:

- Tax Configuration Workbook: Explained
- Creating Tax Setup Using the Tax Configuration Workbook: Worked Example
- Creating Tax Setup Using Tax Partner Content in the Tax Configuration Workbook: Worked Example
- Creating Tax Setup Using the Tax Implementation Workbook: Worked Example

4. Manage tax rates and tax recovery rates.

◦ Perform the Manage Tax Rates and Tax Recovery Rates task to create and maintain details for tax rates
and tax recovery rates.

You can use the Tax Configuration Workbook to upload all common tax rate and tax recovery rate setups.

You can also use the individual Tax Rates, Tax Rate Accounts, Tax Recovery Rates, and Tax Recovery Rate
Accounts spreadsheets to create:

- Tax statuses
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- Tax jurisdictions
- Tax rates
- Tax recovery rates
- Tax accounts

◦ See the following topics:

- Tax Configuration Workbook: Explained
- Creating Tax Setup Using the Tax Configuration Workbook: Worked Example
- Creating Tax Setup Using Tax Partner Content in the Tax Configuration Workbook: Worked Example

5. Manage tax rules.

◦ Perform the Manage Tax Rules task to create and maintain tax rules that define the conditions under
which the exceptions to the default taxability apply.

You can use the Tax Implementation Workbook to upload organization-specific tax rule setups.

You can also use the individual Tax Rules spreadsheet to create tax rules details.

◦ See the following topics:

- Tax Implementation Workbook: Explained
- Creating Tax Setup Using the Tax Implementation Workbook: Worked Example

6. Manage tax registrations.

◦ Perform the Manage Tax Registrations task to create and maintain tax registration information
related to a party's transaction tax obligation with a tax authority for a tax jurisdiction where it conducts
business.

You can use the Tax Implementation Workbook to upload your organization-specific tax registrations.

◦ Refer to the Tax Registrations: Explained topic.

7. Manage tax exemptions.

◦ Perform the Manage Tax Exemptions task to create and maintain tax exemptions to reduce or increase
the tax rate applied to a transaction.

◦ Refer to the Tax Exemptions: Explained topic.

8. Manage simulator transactions.

◦ Perform the Manage Simulator Transactions task to verify tax configuration for taxes that are enabled
for simulation or for both simulation and transactions by processing real-time transactions without
affecting active data.

◦ Refer to the Tax Simulator: Explained topic.

Related Topics
• Implementing Tax

76

https://www.oracle.com/pls/topic/lookup?ctx=fa23d&id=s20047524


Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 3
Implement Oracle Financials Cloud

Implement U.S. Federal Financials  
Get started with Oracle U.S. Federal Financials to enable your agency to meet Federal financial management system
requirements. To complete setting up U.S. Federal Financials, you must complete the core setup steps along with the
necessary prerequisite setups for the integrated applications.

Setting Up U.S. Federal Financials
The tasks in this list include the setup steps for U.S. Federal Financials. These tasks are performed by the Financial
Applications Administrator.

1. Prerequisites

◦ Manage users

- Perform the task Manage Users to create users and assign access privileges.

◦ Manage chart of accounts structures

- Perform the task Manage Chart of Accounts Structures to define accounting flexfields and
Federal-specific segment labels.

◦ Manage invoice options

- Perform the task Manage Invoice Options to control how invoices are processed for your business
unit.

◦ Manage accounting calendars

- Perform the task Manage Accounting Calendars to create Federal-specific accounting calendar
2. Core Federal Financials Setup

◦ Manage federal options

- Perform the task Manage Federal Options to define the business unit attributes for each business
unit of your agency.

◦ Manage federal account symbols

- Perform the task Manage Federal Account Symbols to define Federal account symbols for your
agency.

◦ Manage agency location codes

- Perform the task Manage Agency Location Codes to define Treasury-assigned codes that identify
the accounting and reporting offices of your agency.

◦ Manage treasury account symbols

- Perform the task Manage Treasury Account Symbols to define identification codes for individual
appropriations, receipts, and other fund accounts of your agency.

◦ Manage fund attributes

- Perform the task Manage Fund Attributes to define fund attributes used by your Federal agency
for Treasury reporting and legal compliance.
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3. Subledger Accounting Setup

◦ Define expense accrual distributions

- Perform the task Manage Mapping Sets for Procurement offering to define the expense accrual
distributions for the Purchasing accounts for your agency.

◦ Define General Ledger accounts

- Perform the task Manage Mapping Sets for Accounting Hub offering to define the General Ledger
accounts used by Subledger Accounting for your agency.

4. Prompt Payment Setup

◦ Define transaction calendar

- Perform the task Manage Transaction Calendars to define a transaction calendar for Prompt
Payment processes.

◦ Define lookups

- Perform the task Manage General Ledger Lookup Values to define lookup codes for Prompt
Payment processes.

◦ Define current value of funds rate

- Perform the task Manage Interest Rates to define the rate of interest applicable on your overdue
invoices.

◦ Define payment terms

- Perform the task Manage Payment Terms to define invoice payment terms that comply with the
Prompt Payment Act.

5. Payment Processing Setup

◦ Define pay group lookups

- Perform the task Manage Payables Lookups to define a pay group that maps to the payment
format of a payment type.

◦ Define payment type mappings

- Perform the task Manage Payment Type Mapping to map a payment type to a pay group.

◦ Define internal bank branches

- Perform the task Manage Bank Branches to define the bank branches for internal bank accounts.

◦ Define internal bank accounts

- Perform the task Manage Bank Accounts to define bank accounts that recognize the Secure
Payment System or Payment Automation Manager format.

◦ Define payment process request templates

- Perform the task Manage Payment Process Request Templates to define the payment process
request templates.

Related Topics
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Ledger Configuration  

Implement General Ledger  
The Define Ledger Configuration for Rapid Implementation and Define Financial Reporting Center Configuration for
Rapid Implementation task lists provide a framework for developing and managing general ledger features including
ledger sets, journal approval rules, and the Financial Reporting Center.

Setting Up General Ledger
The tasks in the following list relate to the setup of General Ledger. These tasks are the basic setup steps. They may be
interspersed with other tasks that aren't required to implement Oracle Financials Cloud. In the Setup and Maintenance
work area, create an implementation project that includes the Define Financials Configuration for Rapid Implementation
task list. That task list includes both the Define Ledger Configuration for Rapid Implementation and Define Financial
Reporting Center Configuration for Rapid Implementation task lists.

For setting up general ledger, each task is performed by the Application Implementation Consultant.

Define Ledger Configuration for Rapid Implementation
All documentation references are from the Oracle Financials Cloud Implementing Enterprise Structures and General
Ledger guide, unless otherwise noted.

This image shows the general categories of ledger configuration: intercompany balancing, journal processing, period
close processing, ledger sets, data access sets, and intercompany balancing.
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1. Manage ledger sets.

◦ Perform the task Manage Ledger Sets to create, review, and update collections of ledgers intended for
batch processing or financial reports.

◦ See: Ledgers chapter

- Ledgers and Subledgers
- Primary Ledgers, Secondary Ledgers, and Reporting Currencies
- Ledgers, Legal Entities, Balancing Segments, and Business Units

2. Manage data access sets.

◦ Perform the task Manage Data Access Sets to create, review, and update collections of ledgers intended
for data security.

◦ See: Financial Structures chapter

- Overview of General Ledger Security
- Overview of Data Access Set Security
- Examples of Data Access Set Security
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3. Create segment value security rules.

◦ Perform the task Create Segment Value Security Rules in Spreadsheet to define segment value
security for value sets.

◦ See: Financial Structures chapter

- Overview of General Ledger Security
- Segment Value Security
- Example of Segment Value Security

4. Manage intercompany balancing rules.

◦ Perform the task Manage Intercompany Balancing Rules to define rules to assign intercompany
receivables and intercompany payables accounts for transactions unbalanced by legal entity or
management entity.

◦ See: Intercompany Setup chapter

- Intercompany Balancing Rules
- Intercompany System Options
- Example of Intercompany Organization Configuration
- Customer and Supplier Assignment

5. Manage journal approval rules.

◦ Perform the task Manage Journal Approval Rules to review and update rules to route journal entries
through an approval process.

◦ See: General Ledger Options chapter

- Considerations for Defining Journal Approving Rules
- Create Journal Approval Rules

6. Manage settings for automatic journal posting.

◦ Perform the task Manage AutoPost Criteria Sets to define, review and update settings for automatic
journal posting.

◦ See: General Ledger Options chapter

- Create an AutoPost Criteria Set
- Examples of Manually Running the AutoPost Process

7. Manage settings for automatic journal reversal.

◦ Perform the task Manage Journal Reversal Criteria Sets to define, review, and update settings for
automatic journal reversal.

◦ See: General Ledger Options chapter, Journal Reversals

8. Manage accounting and reporting sequences.

◦ Perform the task Manage Accounting and Reporting Sequences to define, review, and update
sequencing definitions for journal posting and period close.

◦ See: General Ledger Options chapter

- Overview of Accounting and Reporting Sequences
- How to Define Journal Sequences Manually: Explained
- What happens when I enable sequencing in the rapid implementation spreadsheet?
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9. Manage allocations and periodic entries.

◦ Perform the task Manage Allocations and Periodic Entries to create, review, and update allocation
and periodic definitions and journal entries. Generate journal entries from the allocation and periodic
definitions.

◦ See: Allocations and Periodic Entries chapter

- Overview of Allocations and Periodic Entries
- Overview of Calculation Manager
- Overview of Oracle Essbase Balances Cubes
- Create an Allocation Rule and Generate Allocations
- Overview of Recurring Journals

10. Manage revaluation definitions.

◦ Perform the task Manage Revaluations to review and update existing calculations of unrealized gains
and losses on foreign currency transactions, and to define new calculations.

◦ See: Period Close chapter

- Revaluation Process
- Overview of Revaluation Unrealized Gains or Losses
- How Income Statement Accounts Are Revalued
- Overview of Revaluation Tracking By Multiple Segments

11. Manage historical rates.

◦ Perform the task Manage Historical Rates to review and update existing currency historical conversion
information, and to create conversion information.

◦ See: Financial Structures chapter

- Enter Daily Rates Using the Daily Rates Spreadsheet
- Update Currency Rates

12. Open the first period.

◦ Perform the task Open First Period to open the first accounting period so you can begin recording
transactions.

◦ See: Ledgers chapter: Overview of Opening First Period

◦ See: Period Close chapter: Overview of Close Monitor

Define Financial Reporting Center Configuration for Rapid Implementation
All documentation references are from the Oracle Financials Cloud Implementing Enterprise Structures and General
Ledger guide, Financial Reporting chapter, unless otherwise noted.

1. Define Financial Reporting Center configuration:

◦ Perform the tasks in the Define Financial Reporting Center Configuration task list to define and manage
technical configuration options for the Financial Reporting Center.

◦ See:

- Overview of Financial Reporting Center
- Set Up Financial Reporting Center and Smart View
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2. Define Essbase database connections.

◦ Perform the task Define Essbase Database Connections in Workspace to define database connections
to connect to Essbase in Workspace.

◦ See: Set Up Financial Reporting Center and Smart View

3. Configure the Smart View client.

◦ Perform the task Configure Smart View Client for Users to install the Smart View client on users'
computers to perform balance inquiry.

◦ See: Set Up Financial Reporting Center and Smart view

4. Create financial statements.

◦ Perform the task Create Financial Statements to create, review, and update report definitions for
management and statutory financial statements.

◦ See: Create a Financial Report

5. Define budget scenarios.

◦ Perform the task Define Budget Scenarios to define scenarios to track budgets for different periods or
forecasts.

◦ See: Budgets chapter

- Overview of Budget Uploads
- How General Ledger Budget Balance Import Data Is Processed
- Import Budget Data from a Flat File
- Import Budget Data from a Spreadsheet

Related Topics

Intercompany Balancing Rules  
You use Intercompany balancing rules to generate the accounts required to balance journals that are out of balance by
legal entity or primary balancing segment values.

Specify the intercompany receivables and intercompany payables accounts that you want to use as the template for
building the intercompany receivables and intercompany payables accounts. The intercompany balancing feature then
uses these rules to generate the accounts of the balancing lines it creates.

Journals lines are first summarized by the legal entity and are balanced by the legal entity. Since a legal entity can have
many primary balancing segment values, it's possible that a journal could have multiple lines for a legal entity with
different primary balancing segment values. In that case, when intercompany balancing is done, the lowest primary
balancing segment value within each legal entity in the journal is used. After this, balancing occurs across balancing
segment values within each legal entity.

These same rules are also used to generate the intercompany receivables account and intercompany payables account
of transactions entered in the Intercompany module.

The intercompany balancing rules are also used to generate the intercompany receivables account for the provider side
of an intercompany transaction. And balancing rules are also used to generate the intercompany payables account for
the receiver side of an intercompany transaction.
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CAUTION:  After you create an Intercompany balancing rule, you can't modify them. But you can end date an existing
rule and create a new rule.

Defining Intercompany Balancing Rules
You can define intercompany balancing rules at these levels:

1. Primary balancing segment
2. Legal entity
3. Ledger
4. Chart of accounts

The rules are evaluated in the order shown. For example, you can define a Primary Balancing Segment rule and a Legal
Entity level rule. If both rules can be used to balance a particular journal, the Primary Balancing Segment rule is used, as
it has a higher precedence.

You have flexibility in defining your intercompany balancing rules. You can have a simple setup in which you define
one rule for your chart of accounts. This rule is used for all intercompany balancing for all ledgers that use this chart
of accounts. Alternatively, you can have a more granular set of rules. For example, define a different rule for each
legal entity and one chart of accounts rule to cover any gaps. You can gain even more granularity by defining rules for
specific journal and category combinations or intercompany transaction types.

Using Chart of Accounts Rules for Intercompany
Use chart of accounts rules for intercompany balancing. You have flexibility in defining your intercompany balancing
rules with the setup of a single chart of accounts rule to use for all ledgers that use this chart of accounts. When you
create a chart of accounts rule, you specify the chart of accounts, intercompany receivables, and intercompany payables
accounts you want to use, as well as the source and category. It is recommended that the intercompany receivables
account be an asset type account, and the intercompany payables account be a liability type account.

You can define rules that are applied to a specific source and category, such as Payables and Invoices. Or a specific
intercompany transaction type, such as Intercompany Sales. Alternatively, you can choose to create rules for all sources
and categories by selecting the source of Other and the category of Other.

Intercompany Balancing then evaluates the journal source and journal category combination in determining which rule
to use for balancing. This is the order of precedence.

• Specific journal source and journal category

• Specific journal source and journal category of Other

• Journal source of Other and specific journal category

• Journal source of Other and journal category of Other

Additional Intercompany Balancing and Clearing Company Options
Additional Intercompany Balancing and Clearing options are used to balance the second balancing segment or the third
balancing segment or both, when a transaction is unbalanced by one of these segments but is already balanced by the
primary balancing segment. This option is defined for a ledger but you can create rules for various Source and Category
combinations.
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Additional Intercompany Balancing and Clearing options include these settings:

• Intercompany Receivables and Intercompany Payables accounts: You can use as the accounts as the template
to build balancing accounts for balancing segment 2 and balancing segment 3 when the journal is already
balanced by primary balancing segment.

• Summarization options: You can choose to summarize lines within a legal entity before balancing lines are
generated by choosing the Summary Net option. Alternatively choose the Detail options so lines aren't
summarized before balancing within a legal entity. Note that summarization always applies to balancing lines
generated in a cross legal entity scenario.

• Clearing company options: Oracle recommends to always set clearing company options to handle many-to-
many journals. This avoids balancing failing during General Ledger Posting or Subledger Accounting Create
Accounting process.

Clearing Company Options
You can choose to set clearing company options to balance a many-to-many journal. Set these options to manage your
clearing company balancing.

• Clearing Company Condition: Choose when to use a clearing company.

◦ Use clearing company only for intracompany journals.

◦ Use clearing company for all many-to-many journals.

◦ Error out if many-to-many journal. The default value for this option.

• Clearing Company Source: Choose how the clearing company value is derived for your balancing lines, from
these options:

◦ Default clearing balancing segment value.

◦ Manually entered clearing balancing segment value. Note that if you select Manually entered clearing
balancing segment value, then you must manually enter a value in the create journals screen. This option
doesn't work for subledger accounting entries as they don't have a field on the user interface to enter this
value.

• Clearing Company Value: If you selected Default clearing balancing segment value for Source, you must select
a primary balancing segment value in this field. This value is used to balance your intracompany or many-to-
many journals.

Example of Intercompany Balancing Rules  
This topic provides examples of intercompany balancing rules and the intercompany balancing lines generated. These
rules are used to generate the accounts needed to balance journals that are out of balance by legal entity or primary
balancing segment values.

Intercompany Balancing Rules Precedence
In this example the legal Entity InFusion Textiles intercompany manufacturing activities are tracked separately from its
non-manufacturing activities. To achieve this, legal entity level rules are defined specifically between the legal entity
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InFusion Textiles and the two manufacturing legal entities, InFusion Products (East) and InFusion Products (West). A
chart of accounts rule is created to cover all other intercompany activities.

Setup

• InFusion USA Chart of Accounts as shown in this table.

Segment Name Company (CO) Cost Center (CC) Division (DIV) Account (ACCT) Intercompany (IC)

Segment Qualifier
 

Primary Balancing
Segment
 

Second Balancing
Segment
 

Third Balancing
Segment
 

Account
 

Intercompany
Segment
 

• Ledger, Legal Entity, Primary Balancing Segment Value Assignments as shown in this table.

Ledger Legal Entity Primary Balancing Segment Value

InFusion USA
 

InFusion Farms
 

3100, 3200, 3300, 3400, 3500
 

InFusion USA
 

InFusion Textiles
 

4000
 

InFusion USA
 

InFusion Products (East)
 

5000
 

InFusion USA
 

InFusion Products (West)
 

6000
 

InFusion USA
 

1000, 9000
 

• Chart of Accounts Rule as shown in this table.

Rule Number Chart of Accounts AR Account AP Account Source Category Transaction Type

1
 

InFusion USA
Chart of Accounts
 

1000 - 000 - 0000
- 13050 - 0000
 

1000 - 000 - 0000
- 21050 - 0000
 

Other
 

Other
 

None
 

• Legal Entity Level Rule as shown in this table.

Rule No. From Legal
Entity

To Legal Entity AR Account AP Account Source Category Transaction
Type

2
 

InFusion Textiles
 

InFusion
Products (West)
 

1000 - 000 -
0000 - 13020 -
0000
 

1000 - 000 -
0000 - 21020 -
0000
 

Other
 

Other
 

None
 

3
 

InFusion Textiles
 

InFusion
Products (East)
 

1000 - 000 -
0000 - 13030 -
0000

1000 - 000 -
0000 - 21030 -
0000

Other
 

Other
 

None
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Rule No. From Legal
Entity

To Legal Entity AR Account AP Account Source Category Transaction
Type

  

• Journal Balancing

◦ Journal before Balancing as shown in this table.

Line Line Type Legal Entity CO CC DIV ACCT IC Debit Credit

1
 

Expense
 

InFusion
Farms
 

3100
 

100
 

1200
 

52330
 

0000
 

150
 

2
 

Expense
 

InFusion
Products
(East)
 

5000
 

100
 

1200
 

52340
 

0000
 

200
 

3
 

Expense
 

InFusion
Products
(West)
 

6000
 

200
 

1300
 

52345
 

0000
 

300
 

4
 

Liability
 

InFusion
Textiles
 

4000
 

500
 

1300
 

40118
 

0000
 

650
 

• Journal Balancing

◦ Journal after Balancing as shown in this table.

Uses Rule Line Line Type Legal
Entity

CO CC DIV ACCT IC Debit Credit

1
 

Expense
 

InFusion
Farms
 

3100
 

100
 

1200
 

52330
 

0000
 

150
 

2
 

Expense
 

InFusion
Products
(East)
 

5000
 

100
 

1200
 

52340
 

0000
 

200
 

3
 

Expense
 

InFusion
Products
(West)
 

6000
 

200
 

1300
 

52345
 

0000
 

300
 

4
 

Liability
 

InFusion
Textiles
 

4000
 

500
 

1300
 

40118
 

0000
 

650
 

1
 

5
 

IC AR
 

InFusion
Textiles
 

4000
 

500
 

1300
 

13050
 

3100
 

150
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Uses Rule Line Line Type Legal
Entity

CO CC DIV ACCT IC Debit Credit

1
 

6
 

IC AP
 

InFusion
Farms
 

3100
 

100
 

1200
 

21050
 

4000
 

150
 

3
 

7
 

IC AR
 

InFusion
Textiles
 

4000
 

500
 

1300
 

13030
 

5000
 

200
 

1
 

8
 

IC AP
 

InFusion
Products(East)
 

5000
 

100
 

1200
 

21050
 

4000
 

200
 

2
 

9
 

IC AR
 

InFusion
Textiles
 

4000
 

500
 

1300
 

13020
 

6000
 

300
 

1
 

10
 

IC AP
 

InFusion
Products
(West)
 

6000
 

200
 

1300
 

21050
 

4000
 

300
 

Related Topics
• Intercompany Balancing Rules

Invoicing and Payments Configuration  

How You Implement Payables and Payments  
The Invoicing and Payments Configuration for Rapid Implementation task list provides the framework for managing
essential setups for Oracle Payables and Oracle Payments.

The framework includes setups for Oracle Procurement that are required for Payables. It also provides the setup steps
for common options, distribution sets, and invoice tolerances for Payables, and the setup steps of disbursement system
options, payment methods, and payment process profiles for Payments.

Setting Up Payables and Payments
The tasks in the following list relate to the setup of Payables and Payments.

For setting up Payables and Payments, each task is performed by the Application Implementation Consultant.
References to help topics in the following tasks are from the following publications:

• Oracle Financials Cloud Implementing Payables Invoice to Pay

◦ General Payables Options chapter, Manage Common Options for Payables and Procurement section

◦ Payables Configuration chapter

◦ Disbursements chapter

• Oracle Procurement Cloud Implementing Procurement
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◦ Purchasing Configuration chapter, Define Procurement Agents section

• Oracle Procurement Cloud Using Procurement

◦ Supplier Profiles chapter, Create Supplier section

◦ Supplier Profiles chapter, Import Suppliers section

1. Configure Procurement business function, procurement agents, and suppliers.

◦ Perform the task Configure Procurement Business Function, Procurement Agents, and Suppliers,
which includes configuring:

- The procurement business function for the procurement business unit to specify procurement
document control, document defaults, document numbering, and related settings.

- Procurement agent access to information, such as purchasing documents and suppliers.
- Suppliers, sites, and other supplier-related information.

◦ See: Define Procurement Agents section
- Procurement Agents

◦ See: Supplier Profiles chapter
- Oracle Supplier Model
- Import Suppliers section
- See: Create Supplier section

◦ Supplier Sites and Supplier Site Assignments: Explained

2. Manage common options for Payables and Procurement.

◦ Perform the task Manage Common Options for Payables and Procurement to set the controls and
default values that are used by both Payables and Procurement, such as the default liability account and
whether to accrue expense items at time of receipt or at period end.

◦ See: Manage Common Options for Payables and Procurement section
- Guidelines for Common Options for Payables and Procurement
- Default Distributions
- Considerations for Offset Segments
- Considerations for Accruing Expense Items

Note:  You can skip this step if you have used the Rapid Implementation spreadsheet for General Ledger to
create the ledger, legal entities, and business units.

3. Manage distribution sets.

◦ Perform the task Manage Distribution Sets to define a distribution set, which is a list of accounts with
or without percentages. When you create an invoice that's not associated with a purchase order, you can
enter the distribution set name to automatically create the invoice distributions with a predefined set of
accounts. If the distribution set has percentages, the invoice line amount is automatically distributed to
the accounts, otherwise you must enter the amounts manually.

◦ See: Payables Configuration chapter
- Distribution Sets

4. Manage invoice tolerances.
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◦ Perform the task Manage Invoice Tolerances to define acceptable variances between invoice, purchase
order, and receipt information. You can define both percentage-based and amount-based tolerances.
Invoices that exceed the specified tolerances are placed on hold during the invoice validation process.

◦ See: Payables Configuration chapter

- Invoice Tolerances
5. Manage disbursement system options.

Note:  Payments provides predefined setups for Steps 5 to 7. You don't need to modify the predefined
setups unless you want to change disbursement system options, or configure different payment methods or
payment process profiles.

◦ Perform the task Manage Disbursement System Options to manage payment processing options at the
enterprise and business unit level.

6. Manage payment methods.

◦ Perform the task Manage Payment Methods to define or manage payment methods and to attach or
update validations that are assigned to them. See:

- Payment Methods
- Payment Method Defaulting
- Example of Setting Up User-Defined Validations for Payment Methods or for Payment Files

7. Manage payment process profiles.

◦ Perform the task Manage Payment Process Profiles to define or manage payment process profiles,
which are entities that determine the payment processing type, grouping of installments, grouping of
payments, and the definition of usage rules based on payment methods, disbursement bank accounts,
business units, and currencies. See:

- Payment Process Profiles

Related Topics

Expenses Configuration  

Implement Expenses  
The Define Expenses Configuration for Rapid Implementation task list provides a framework for developing and
managing your system options, expense report templates, approval rules, and conversion rates and policies.

The tasks in the Define Expenses Configuration for Rapid Implementation task list enable expense entry, approval, and
reimbursement processing in Expenses.
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Setting Up Expenses
To set up Expenses, each task is performed by the Application Implementation Consultant. References to help topics in
the following tasks are from the Oracle Financials Cloud Implementing Expenses: Expense Policies and Rules chapter.

1. Manage expenses system options.

◦ Perform the task Manage Expenses System Options to define setup options for managing expense
entry and processing for all business units.

◦ Confirm that the default settings are aligned with your business practices.

2. Manage expense report templates.

◦ Perform the task Manage Expense Report Templates to define expense types applicable to your
company and group them into expense templates. Expense templates are defined by business units. The
expense templates available in expense report entry is determined by the business unit of the employees.

◦ Specify receipt requirements when you define expense types.

◦ See:

- Expense Templates: Points to Consider
- Can expense types be used across expense templates?
- Configuring Expense Policies: Points to Consider.

3. Manage expense approval rules.

◦ Perform the task Manage Expense Approval Rules to define expense report approval rules based on
your company's approval policies.

◦ Modify the predefined rules as needed.

◦ See:

- Configuring Approval Rules: Explained
- Defining Approval Rules: Explained

Note:  To enable audit of expense reports, you must define audit rules in addition to approval rules.

4. Manage conversion rates and policies.

◦ Perform the task Manage Conversion Rates and Policies to select the conversion rate type for each
business unit.

◦ See: Configuring Expense Policies: Points to Consider

Related Topics

Fixed Assets Configuration  

Implement Assets  
Get started with Oracle Assets and enable your reporting and accounting capabilities using the Define Fixed Assets
Configuration for Rapid Implementation task list.
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This task list provides a framework to develop and manage your Assets flexfields, system controls, fiscal years,
locations, calendars, prorate conventions, asset books, and asset categories.

Set Up Assets
The tasks in the following list relate to the setup of Oracle Assets. These are the basic steps for setup. These tasks
appear in the setup task list in the Setup and Maintenance work area. However, in your task list the tasks may be
interspersed with other tasks that you don't need to perform before you can use Oracle Fusion Cloud Financials.

For setting up Assets, each task is performed by the Application Implementation Manager.

Define Fixed Assets Configuration for Rapid Implementation

All documentation references are from the Oracle Financials Cloud Implementing Assets guide, unless otherwise noted.

1. Create Fixed Assets Configuration in Spreadsheet.

◦ Perform the task Create Fixed Assets Configuration in Spreadsheet to define your initial Fixed Assets
configuration or rapidly implement Oracle Asset categories, system controls, depreciation calendars,
prorate conventions, and books.

◦ See: Oracle Applications Cloud Configuring and Extending Applications guide.

2. Update Fixed Assets Configuration in Spreadsheet.

◦ Perform the task Update Fixed Assets Configuration in Spreadsheet to update or add to your Oracle
Asset categories, locations, and books.

3. Upload Fixed Assets Configuration in Spreadsheet.

◦ Perform the task Upload Fixed Assets Configuration in Spreadsheet to load the key flexfield
structure, system controls, calendar, prorate convention, asset book, location combination, and category
assignment to the book created or updated in the spreadsheet.
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Related Topics
• System Controls

• Depreciation Methods

Receivables Configuration  

Implementation Procedures for Receivables and Payments  
The Receivables task list provides a framework for developing and managing your accounts receivable environment.
This includes the necessary setups in Oracle Receivables and the related setups in Oracle Payments.

Define the Receivables and Payments Configuration
The tasks in the following list relate to the setup of Receivables and of Payments for Receivables. These are the basic
steps for setup.

For setting up Receivables and Payments for Receivables, each task is performed by the Application Implementation
Consultant. All documentation references are from these chapters in Oracle Financials Cloud Implementing Receivables
Credit to Cash:

• Define Common Accounts Receivable Configuration

• Manage Receivables System Options

• Define Customer Billing Configuration

• Define Customer Payments

• Configure Payment System Connectivity

• Define Funds Capture

• Define Customer

1. Manage Receivables system options.
◦ Perform the task Manage Receivables System Options to manage the basic settings of your

Receivables environment.
◦ See: Manage Receivables System Options chapter:

- Updating System Option Records: Critical Choices
- Using Header Level Rounding: Example
- Tax Invoice Printing Options
- Tuning Segments: Explained
- Log File Message Levels: Explained
- Transaction and Statement Delivery E-Mail Subject Line: Examples
- Transaction and Statement Delivery Using E-Mail: How It Works

2. Manage Receivables activities.
◦ Perform the task Manage Receivables Activities to set up default accounting information for all

activities in accounts receivable other than transaction processing and receipt processing.
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◦ See: Define Common Accounts Receivable Configuration: Define Receivables Activities section:

- Receivables Activity Types
- GL Account Source
- Tax Rate Code Source

3. Manage AutoAccounting rules.

◦ Perform the task Manage AutoAccounting Rules to set up default accounting information for
Receivables transaction processing.

◦ See: Define Customer Billing Configuration: Define AutoAccounting section:

- AutoAccounting Account Types and Segment Values
- AutoAccounting Structure: Points to Consider
- Using AutoAccounting to Derive Accounting Flexfield Segments: Example

4. Manage remit-to addresses.

◦ Perform the task Manage Remit-to Addresses to assign remit-to addresses to Receivables transactions.

◦ See: Define Customer Billing Configuration: FAQs for Remit-to Addresses section:

- How can I use remit-to addresses?
- How does AutoInvoice validate remit-to addresses?
- How can I define a default remit-to address?
- Why did the country appear?
- Why do I verify the address?

5. Manage memo lines.

◦ Perform the task Manage Standard Memo Lines to define memo lines for line items that aren't
inventory items.

◦ See: Define Customer Billing Configuration: Define Memo Lines section: Revenue Accounts and Memo
Lines: Explained.

6. Manage system security options.

◦ Perform the task Manage System Security Options to enable the credit card and bank account
encryption and masking.

◦ See: Define Payments Security chapter: System Security Options: Critical Choices.

7. Manage funds capture payment methods.

◦ Perform the task Manage Funds Capture Payment Methods to define funds capture payment methods
to enable customers to remit payments. Payments supports bank account transfers for automated funds
capture processing.

8. Manage funds capture process profiles.

◦ Perform the task Manage Funds Capture Process Profiles to define profiles for funds capture
processing with rules for authorization and settlement handling.

◦ See: Define Funds Capture chapter: Funds Capture Process Profile: Explained.

9. Manage internal payees.

◦ Perform the task Manage Internal Payees to set up one or more business units that use a payment
processor or gateway to receive funds from customers.
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10. Manage payment systems.

◦ Perform the task Manage Payment Systems to define external organizations, such as banks or payment
processors, that process funds capture and disbursement transactions.

◦ See: Configure Payment System Connectivity chapter:

- Validations: Critical Choices
- Formats: Explained
- Transmission Protocol: Explained
- Transmission Configuration: Explained
- Configuring Your Communication Channel to a Payment System: Explained
- Payment System: Explained
- Payment System Account: Explained
- Importing a Security Credential File: Procedures

11. Manage receipt classes and methods.

◦ Perform the task Manage Receipt Classes and Methods to set up the steps required for receipts and to
set up default accounting information for receipt processing.

◦ See: Define Customer Payments: Define Receipt Classes and Methods section:

- Remittance Methods and Clearance Methods
- Automatic Receipt Processing: Points to Consider
- Fund Transfer Error Handling: Explained
- Remittance Bank Accounts: Explained

12. Manage lockbox.

◦ Perform the task Manage Lockbox to set up a lockbox to create receipts automatically from data
supplied by your remittance bank.

◦ See: Define Customer Payments: Define Lockbox section:

- Lockbox Interface Table AR_PAYMENTS_INTERFACE_ALL
- Match Receipts By Method: Explained

13. Manage transmission formats for lockbox.

◦ Perform the task Manage Transmission Formats for Lockbox to set up lockbox transmission formats.
The transmission formats ensure that data is correctly transferred from your remittance bank.

◦ See: Define Customer Payments: Define Transmission Formats for Lockbox section:

- Validating the Lockbox File Transmission: How It Works
- Lockbox Transmission Formats
- Lockbox Transmission Format Record Types
- Lockbox Transmission Format Field Types

14. Manage statement cycles.

◦ Perform the task Manage Statement Cycles to set up statements and statement cycles that determine
when to send statements to your customers.

◦ See: Define Common Accounts Receivable Configuration: Define Statements section:

- Setting Up for Statements: Procedure
- Statement Cycles: Example

15. Create customer.
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◦ Perform the task Create Customer to create customer records for all organizations and persons with
whom you do business.

◦ See: Define Customer chapter: Define Customer Account section and Manage Customers section:

- Customer Account Relationships: Explained
- Customer Account Uses: Points to Consider
- Customer Addresses: Points to Consider
- Related Contact Sites: Explained
- Customer and Party: Explained
- Party Relationships: Explained
- Customer Upload: How Data is Processed
- Preparing Customer Data for Upload: Points to Consider
- Validating Unique Values in the Customer Spreadsheet Upload: Examples
- Customer Listing Report

16. Manage approval limits.

◦ Perform the task Manage Approval Limits to set approval limits for each of your users for specific
transactions and amount ranges per currency.

◦ See: Define Common Accounts Receivable Configuration: Define Approval Limits section: Approval Limits
Document Types.

Related Topics
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4  Financial Reporting

Overview of Financial Reporting Configuration  
Configure these financial tools to report and analyze your accounting data: Financial Reporting Center, Smart View,
Financial Reporting Studio, and Workspace.

Overview of Financial Reporting Center  
The Financial Reporting Center is intended to be the primary user interface for financials end users to access all seven
report types.

Financial Reporting Center
The Financial Reporting Center includes these report types: Financial Reporting Web Studio Reports, Account Groups
and Sunburst, Smart View Reports, Oracle Transactional Business Intelligence Analyses, Oracle Transactional Business
Intelligence Dashboards, Oracle Analytics Publisher Reports, and Business Intelligence Mobile Apps. Other reporting
tools are also available to run the same seven report types.

This figure illustrates the report types that are available in the Financial Reporting Center.
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Reports can be accessed through various methods. However, the Financial Reporting Center provides access to every
type of report, is intended to be the primary user interface for financials end users, and is tablet and smartphone
friendly. In addition to accessing reports, you can add favorites, define tags, and view report details, such as type and
last updated date.

Financial Reports are read from the Shared > Custom > Financials and My Folders directories. All other report types
can be saved anywhere in the BI Catalog however, any user-defined content should be in the Shared > Custom folder.
Subfolders can be created within the Shared > Custom folder.

Seven types of reports can be run from the Financial Reporting Center and from the other reporting tools.

• Financial Reports: These reports are built off of the Oracle Financial Reporting Web Studio using data in the
Oracle General Ledger balances cube. For example, company income statements and balance sheets. These
reports are mainly run by users in General Ledger.

• Account Groups and Sunburst: Account groups are used to monitor key accounts in General Ledger. When
a user creates an account group, it becomes visible in the Financial Reporting Center with the Sunburst
visualization tool. The Sunburst visualization tool lets you interact with your account balances across various
business dimensions to view balances from different perspectives. Account groups are used only in General
Ledger.

• Smart View Reports: Smart View is a multidimensional pivot analysis tool combined with full Excel functionality.
Smart View enables you to interactively analyze your balances and define reports using a familiar spreadsheet
environment. These queries are mainly for users in General Ledger. To share Smart View queries, users can
email them to other users, or they can upload the queries to the Financial Reporting Center where users can

98



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 4
Financial Reporting

download them to a local drive for use. The Financial Reporting Center is only a place for users to upload and
download Smart View queries.

Note:  To upload a Smart View report to the Financial Reporting Center: select the Open Workspace for
Financial Reports task, navigate to the BI Catalog, and select Upload from the Tasks section. Be sure to
upload the Excel file to one of the folder locations mentioned previously.

• Oracle Transactional Business Intelligence Analyses: These analyses and reports are built off of transactional
tables using subject areas. These reports can be run by users in General Ledger, Payables, Receivables, Cash
Management, Intercompany, and so on.

• Oracle Transactional Business Intelligence Dashboards: Dashboards put all the information, functions,
and actions that a business user must have to do their job in one place. Dashboards are built off of Oracle
Transactional Business Intelligence objects like analyses and reports. These reports can be run by users in
General Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.

• Oracle Analytics Publisher Reports: Most of these reports are predefined and must first be submitted and
resubmitted to see the latest data by the Oracle Enterprise Scheduler through the Scheduled Processes
navigation. These reports can be run by users in General Ledger, Payables, Receivables, Cash Management,
Intercompany, and so on.

• BI Mobile Apps: Oracle Business Intelligence Mobile App Designer is an application that enables you to create
multitouch information-driven applications with rich interaction, rich visualization, and rich media, for mobile
devices such as iPhone, iPad, Android phone, tablet, and more. These reports can be run by users in General
Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.

Other Reporting Tools
Six other tools are available for reporting in Financials.

The following table lists the other reporting tools and the types of reports they support.

Other Reporting Tools Report Type

General Accounting Dashboard and
Account Inspector
 

Account Groups
 

Reports and Analytics
 

Oracle Transactional Business Intelligence Objects
 

BI Catalog
 

All Report Types, Except Oracle Analytics Publisher Reports
 

Enterprise Performance Management
Workspace
 

Reports, Books, Snapshot Reports, Snapshot Books, Financial Reporting Batches, and Batch Scheduler
 

Enterprise Scheduler System
 

Oracle Analytics Publisher Reports
 

Even though the Financial Reporting Center is designed to be the main user interface for a financial end user's reporting
needs, some users may choose to use any of the six other tools for reporting in financials, such as:

• General Accounting Dashboard, which provides access to Account Groups: Uses the Account Monitor to
efficiently monitor and track key account balances in real time.
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• Account Inspector: Perform ad hoc queries from account groups and financial reports through drill down to
underlying journals and subledger transactions.

• Reports and Analytics: This reporting tool has a panel that reflects the folder structure of the BI Catalog. Users
can access and run any Oracle Transactional Business Intelligence analysis, report or dashboard. Users can't
run predefined Financial Reports or Oracle Analytics Publisher reports from this interface. This interface can be
used by all financials users.

• BI Catalog: A component of the Enterprise Performance Management Workspace where you can run all report
types, except for predefined Oracle Analytics Publisher reports.

• Enterprise Performance Management Workspace: Create reports, books, snapshot reports, snapshot books,
Financial Reporting batches, and batch scheduler, and schedule batches to automatically run and burst to
email.

• Enterprise Scheduler System: Only Oracle Analytics Publisher reports can be submitted from this interface.
Users access this interface by navigating to Tools > Scheduled Processes. Most financial users have access to
this interface to run standard reports for General Ledger, Payables, Receivables, and so on.

Related Topics
• Set Up Financial Reporting Center and Smart View

Create a Folder from the Financial Reporting Center  
The Financial Reporting Center is a tool for accessing, designing, and presenting financial reports and analytic data.

Configure Financial Reporting Center
You have access to reports through the folder structure in the Financial Reporting Center and Workspace that's installed
with Oracle Fusion Financials. Your Oracle Fusion Business Intelligence (BI) administrator defines the folder structure in
Workspace your company's security requirements for folders and reports, as well as report distribution requirements for
financial reporting batches.

Security can be set on folders and reports from Workspace. The BI Catalog stores both the Financial Reports and the BI
Publisher Reports. Your BI administrator grants access to the folders and reports that you need.

Create and Secure a Folder Structure
To create a folder or subfolder:

1. From the Financial Reporting Center, open the Tasks pane and click the Open Workspace for Financial
Reports task.

2. From the Navigate menu, select Applications, then BI Catalog.
3. On the Oracle BI Catalog page, go to the location in the Folders panel where you want to create the folder.
4. In the Oracle BI Catalog toolbar, click New and select Folder.
5. On the New Folder window, enter the folder name.
6. Click OK.

To assign permissions to a folder:

1. From the Financial Reporting Center, open the Tasks pane and click the Open Workspace for Financial
Reports task.

100

https://www.oracle.com/pls/topic/lookup?ctx=fa23d&id=s20033440


Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 4
Financial Reporting

2. From the Navigate menu, select Applications, then BI Catalog.
3. Search for the folder to which you want to assign permissions.
4. Go to the Tasks panel and click Permissions.
5. On the Permissions window, click the Add user or roles  icon.
6. On the Add Application Roles and Users window, query the roles and select the ones you want to add.
7. Click the Move button.
8. Set the permission to the intended level, for example, Full Control.
9. Click OK.

Configure Smart View Client for Users  
Smart View is a multidimensional pivot analysis tool combined with full Excel functionality. Smart View enables you to
interactively analyze your balances and define report using a familiar spreadsheet environment.

Install Smart View, an add-in to Excel, to each client computer. To download the installation files:

1. Navigate to the Financial Reporting Center and select the Open Workspace for Financial Reports task.
2. In the Enterprise Performance Management System Workspace, select Tools > Install > Smart View.

Note:  Since Smart View is an add-in to Microsoft Office products, you can install Smart View only on a Windows
operating system.

Once Smart View is installed, you must configure the connection using the Smart View Shared Connections URL. To
derive the Shared Connections URL follow these steps:

1. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.
2. Edit the workspace URL by removing index.jsp and adding SmartViewProviders at the end.

Note:  This URL is an example for a Cloud-based environment. If the workspace URL is https://
efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/index.jsp, the Shared
Connections URL is https://efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/
SmartViewProviders.

3. Copy the URL.
4. Open Excel.
5. Navigate to the Smart View menu > Options

This image shows the Smart View ribbon on the Excel spreadsheet. The task lists include Panel, Connections,
and Options.

6. Click the Options button and select the Advanced option.
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The following figure shows the Options window with the Advanced option selected. The shared connections
URL appears in the General section.

7. Paste the URL in the Shared Connections URL field.
8. Click OK.

For more information about configuring the Smart View client for users, see the Oracle Smart View for Office User's
Guide.

To connect to Oracle Fusion General Ledger Balances cubes in Smart View:

1. Start Smart View.
2. Click the Smart View tab and select the Panel icon. The Smart View pane opens.
3. Click the Shared Connections  button on the task pane.
4. Sign in with your user name and password.

The following image shows the Sign In window for connecting to the database.
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5. Click the Select Server list icon to proceed.
The following figure shows the Shared Connections section on the Smart View panel. The Select Server to
proceed field is selected and two values appear in the drop-down list: Oracle Essbase, Oracle Hyperion Financial
Reporting.

Note:  If the Essbase Server isn't there, then it has to be added. Use the following steps:

a. Click the Add Essbase Server link.
b. Specify the Essbase Server login and password.
c. Expand the Essbase server and locate its cube.

6. Select Oracle Essbase from the list of shared connections.
7. Click the Expand to expand the list of cubes.
8. Expand your cube that has the name of your chart of accounts.

The following figure shows the Shared Connections section on the Smart View panel. The Oracle Essbase
server is expanded, showing several cubes.

9. Click db. A list of functions appears.
10. Click the analysis link.

Note:  You must perform these steps only once for a new server and database.

To set how the name and alias of the Essbase database appears:

1. On the Smart View ribbon, click the Options button.
2. Select Member Options from the list and select the Member Name Display list.
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3. You can select from among the following options:
• Distinct Member Name: Only shows the full Essbase distinct path.

• Member Name and Alias: Shows both the member name and the alias.

• Member Name Only: Shows only the member name.

Note:  The Smart Slice feature isn't supported in General Ledger. For all other documentation, refer to the Oracle
Smart View for Office User's Guide.

Define Database Connections in Workspace for Financial
Reports  
You must create database connections so you can access the cubes from Workspace and Financial Reporting Web
Studio.

Note:  Ledger setup has to be completed before the database connection can be created. Oracle Fusion General
Ledger balances cubes are created as part of ledger setup. Each combination of chart of accounts and accounting
calendar has a separate cube. Each cube needs a database connection.

Steps to define a database connection are:

1. From the Financial Reporting Center work area, open the Tasks panel and select the Open Workspace for
Financial Reports task.

2. From within the workspace, select the Navigate  menu > Applications > BI Catalog.
3. From the Tools menu, select Database Connection Manager.
4. On the Database Connection Manager window, click New.
5. Enter a user-friendly name for the database connection name.
6. Enter Essbase as the Type, your server, user name, and password.
7. Select Application (cube) and Database from the list of values.
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8. Expand the Application name to see the related database, for example, db.

The following figure shows the Database Connection Properties window with the completed fields from steps 5
through 8.

9. Click OK twice to save your selections.
10. Click Close to save the connection.

For more information about configuring Essbase database connections in Workspace see: Oracle Essbase Database
Administrator's Guide.

Note:  The database connection is available in both Workspace and Financial Reporting Web Studio. Optionally, the
database connection can be set up in Financial Reporting Web Studio while entering the grids on a report.

Create a Financial Report  

Define a Basic Financial Report Using the Reporting Web Studio  
This is the first of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
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You can use Financial Reporting Web Studio to design traditional financial report formats such as balance sheets, profit
and loss statements, and cash flow reports. You can also design nontraditional reports for financial or analytic data that
include text and graphics.

In this example, you're designing a basic financial report.

1. From the Financial Reporting Center work area, select the Tasks panel tab and click Open Workspace for
Financial Reports.

2. On the Tools menu, select Launch Financial Reporting Web Studio.
3. On the File menu, select New, Report.
4. On the toolbar, click the Grid icon. Grids are tables that contain data from external database connections.
5. In the design canvas, draw a box to create the grid. The Database Connection Properties dialog box opens.

Tip:  When creating a grid, best practice is to leave space in the design canvas for other objects, such as a
company logo and report title.

6. Select the Data Sources list and select the data source for the chart of accounts that the report is based on. A
unique cube exists for each combination of chart of accounts and accounting calendar.

Tip:  Best practice is to always turn on suppression in financial reports at the Database Connection Server
level. You can verify the setting by highlighting the grid, and then selecting Data Query Optimization
Settings on the Task menu. For most reports, best practice is to turn on suppression for the entire grid. Then
turn suppression off for columns and rows that must always display. For more information about suppression
settings, refer to the Defining Basic Conditional Suppression section in the Financial Reporting Web Studio
User's guide.

7. Click OK. The Dimension Layout dialog box opens.

Arrange the Dimensions
Use the Dimension Layout dialog box to arrange the dimensions on your report. For this report, the accounting periods
display on the columns and the revenue and expense account information displays on the rows. The company appears
on each page and can be selected at runtime.

1. Drag the Accounting Period dimension to the Columns axis.
2. Drag the Account dimension to the Rows axis.
3. Drag the Company dimension to the Page axis.
4. Click OK to close the Dimension Layout dialog box.

Define the Rows
Use the Select Members dialog box to define the revenue and expense account rows.

1. Select the revenue parent account.

a. Double-click the Account cell. The Select Members dialog box opens with a default member selected.
b. Remove the default Account selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
c. In the Search field, enter the value for the account that represents total revenue and click the Search

icon.
d. Select the account from the search results and click OK. The account moves to the Selected area.
e. Click OK. The Select Members dialog box closes.

2. Now insert a text row to add space between the revenue and expense accounts.
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a. Select the last row in the grid by clicking the row header.
b. On the Insert menu, select Row, then Text.

3. Insert a row for the expense accounts.
a. Right-click the last row header.
b. On the Insert Row menu, select Data. Notice the default value for the new row is the revenue parent

account.
4. Select the expense parent accounts.

a. Double-click the account value in the new expense account row. The Select Members dialog box opens
with the revenue parent account selected.

b. Remove the revenue parent account selection from the Selected area by clicking to select it and then
clicking the Remove from Selected icon.

c. In the Available area, expand the Account member, and continue expanding until you find the expense
parent accounts for the report.

d. Select the accounts and click the Add to Selected icon to move them to the Selected area.
e. Select the Place selections into separate rows option so each account appears in its own row on the

report.
f. Click OK. The Select Members dialog box closes.

Save and Preview the Report
Save the report and leave it open for the next topic, which is adding a formula to a financial report.

1. Click the Save icon.
2. Select the folder with your name and enter the report name and description.
3. Click Save.
4. Optionally preview the report in HTML or PDF format using the File menu or toolbar.

Add Formulas to a Financial Reporting Report  
This is the second of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a formula to summarize the expense account balances on your financial report.

Before you start, do the steps described in the Define a Basic Financial Report Using the Reporting Web Studio topic,
then follow these steps.

1. Right-click the last row header, select Insert Row and select Formula.
2. Click in the empty cell in the new row.
3. In the Heading Row Properties pane, select the Custom Heading option, enter Total Expenses and click the

Update icon. The new heading appears in the report.
4. Select the row header for the formula row. The SUM function appears in the design canvas.
5. In the Formula bar, click the Sum(0) button and enter the formula and cell references in the formula text box.

Because the expense rows appear one after the other, you can use the first row number and the last row
number with a colon in between. For example, Sum([3:5]). If the rows weren't contiguous, you could put
brackets around each row number and separate them with commas. For example, Sum([3], [5], [6]).
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6. Validate the formula syntax by clicking the check mark icon in the toolbar. Validation checks the validity of the
formula, not if the data is available.

7. Save the report and leave it open for the next topic, which is defining a range function. Optionally preview the
report.

Define Range Functions for a Financial Reporting Report  
This is the third of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a range function to report across multiple accounting periods. You configure the range to
present balances for the last 12 months from the period selected at runtime.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report

Now follow these steps.

1. Double-click the Accounting Period cell. The Select Members dialog box opens.
2. Remove the default accounting period from the Selected area by clicking it to select it and then clicking the

Remove from Selected icon.
3. Click the Functions tab.
4. Select Range from the list.
5. Click the Add to Selected icon. The Range dialog box opens.
6. Define the starting member for the range.

a. On the Start Member row, click the Lookup Selection icon in the Value column.
b. Click the Functions tab.
c. Select the Relative Member function to define the periods that display on the report relative to the

period specified at runtime.
d. Click OK. The Relative Member dialog box opens.
e. On the Member row, click the Lookup Selection icon in the Value column.
f. Select Current Point of View for Accounting Period so you can enter the starting period for the report.

g. Click OK.
h. On the Offset row, enter -11 in the Value field.

The offset determines the first period of the range. The starting period in the range function is always
the oldest period. Because this is a rolling 12 period report, enter -11 to include the 11 periods prior to the
period you enter at runtime. The member selection for the End Member parameter determines period 12.

i. Click OK.
7. Define the ending member for the range.

a. On the End Member row, click the Lookup Selection icon in the Value column.
b. Select Current Point of View for Accounting Period.
c. Click OK.
d. Click OK to close the Range dialog box.
e. Click OK to close the Select Members dialog box.
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8. Save the report and leave it open for the next topic, which is defining a grid point of view. Optionally preview
the report.

Set User and Grid Points of View for a Financial Reporting Report  
This is the fourth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you set a user point of view and a grid point of view for a financial report.

All financial reporting reports have a user point of view and a grid point of view. Best practice is to use a combination of
both.

If you want users to select certain dimension members at runtime, then those dimensions should be set in the
user point of view. Selections for user point of view members are global for a user and data source. This means the
application saves and applies them to any other report that has the same dimensions set to the user point of view. By
default, all dimensions are set to the user point of view and must be selected at runtime. If you want your report to
always use certain dimension selections, then select the specific members in the grid point of view.

Note:  Members of a grid point of view only display in HTML.

In this example you set the Ledger, Scenario, Balance Amount and Currency dimensions to use the grid point of view.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report

Now follow these steps.

1. Select the cell in the grid that represents the intersection of the rows and columns. The Grid Properties pane
opens.

2. In the Grid Properties pane, click the Grid Point of View check box.
3. In the design canvas, click the Ledger: User Point of View for Ledger button. The Select Members dialog box

opens.
4. Expand the Ledger member and continue to expand until you find the ledger to include on the report. Select

the ledger.
5. Click Apply Selection.
6. Select Scenario from the Dimension list to select the type of balance to use on the report.
7. Expand the Scenario member and select Actual.
8. Click Apply Selection.
9. Select Balance Amount  from the Dimension list.

10. Expand the Balance Amount member and select Period Activity.
11. Click Apply Selection.
12. Select Currency from the Dimension list.
13. Search for USD.
14. Click OK to accept the search result.
15. Click Apply Selection.
16. Click OK to close the Select Members dialog box.
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17. Save the report and leave it open for the next topic, which is setting page and grid properties. Optionally,
preview the report.

Work with Grid Point of View Setup and Page Axis for a Financial
Reporting Report  
This is the fifth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you change the grid point of view setup and set the page member selection to a prompt on your
financial report.

Before you start, do the tasks described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report

Now follow these steps.

1. Click the first cell in the grid to select all of the rows and columns.
2. Right-click and select Grid Point of View Setup from the list. The Setup Grid Point of View dialog box opens.

a. To prevent the Balance Amount dimension from being changed at runtime, select the Lock Member
Selection option.

b. Click OK. The Setup Grid Point of View window closes.
3. In the Grid Properties pane:

a. Click the Drill Through option to allow drilling from the report to the General Ledger transaction data.
b. Click the Suppression section to view the suppression settings.
c. Enter 0 in the Zero Values field to set the text option for rows with zero values. If necessary, you could

also suppress the display of rows with zero values, rows with missing data, and rows with errors.
4. Set a runtime prompt for the Company dimension so you have the flexibility of selecting any company or

combination of companies at runtime. In this example, you want to restrict the valid list of companies that can
be selected at runtime.

a. On the grid, click the Pages label. The Company dimension appears in the design canvas.
b. Click the Company button. The Select Members dialog box opens.
c. Remove the default Company selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
d. Select Prompt for Company.
e. Click the Add to Selected icon to move the selection to the Selected area.
f. Click OK. The Define Prompts dialog box opens.

g. Click the Lookup icon in the Choices List field. The Select Members dialog box opens.
h. Remove the default Company selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
i. Expand the Company member, and continue expanding until you find and select the default companies

you want to display in the prompt.
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j. Click the Add to Selected icon to move the companies to the Selected area.
k. Click OK. The Select Members window closes.
l. On the Define Prompts dialog box, click in the Member Name field and select Alias. The actual company

label displays in the prompt list of values instead of a numeric company value, making the prompt more
user-friendly.

m. Click OK. The Define Prompts window closes.
5. Click the Pages label on the grid. The Page Properties pane opens.

a. In the Page Properties pane, select the Alias: Default option so each page of the report shows the name
of the company instead of the number.

6. Select the four data rows in the grid so all of the rows have the same settings.

a. In the Heading Row Properties pane, select the Alias: Default option in the Heading Row Properties pane
to display the revenue and expense account names instead of the accounts.

b. In the Heading Row Properties pane, select the Allow Expansion option so you can expand the parent
account values to view the detail child values.

7. Save the report and leave it open for the next topic, which is formatting your financial report and adding a
graph. Optionally, preview the report.

Add Formats and Graphs to a Financial Reporting Report  
This is the sixth and final topic in a series of topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you add formats and graphs to a financial report.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report
5. Work with Grid Point of View Setup and Page Axis for a Financial Reporting Report

Now follow these steps.

1. In the report object browser, select the name of the report, which is the first object.
2. Add a logo.

a. In the report layout, drag the header line to make space for the logo and title.
b. In the Header section, click the Add Report Object icon and select Image.
c. In the Image Properties pane, click Browse and select your company logo.

3. Add a title.

a. Select the name of the report in the report object browser.
b. In the Header section, click the Add Report Object and select Text. As an alternative, you can click the

Text icon in the toolbar and draw the text box. The text box opens.
c. Enter the report title.
d. Select the title text and use the format toolbar to adjust the font size, center the text, and change the font

style to bold.
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4. Change the page orientation.

a. Select the name of the report in the report object browser.
b. On the File, menu, select Page Setup.
c. In the Page Setup dialog box, select the Landscape option.
d. Click OK.

5. Add a chart.

a. In the Body section, click the Add Report Object icon and select Chart.
b. In the Chart Properties pane, select the Line chart type.
c. To show only the expense account rows, deselect row 1, and select rows 3, 4, and 5 in the Data Range

section.
d. Click the Format Chart button. The Format Chart dialog box opens.
e. In the Appearance tab, enter the title for the chart. For example, Expenses by Period.
f. Click the Legend tab and enter a title for the legend. For example, Type of Expenses.

g. Click the Axes tab and enter a title for the Metadata axis. For example, Period. Enter a title for the
Primary Axis. For example, Dollars.

h. Click the Refresh Chart button to preview the chart on the Format Chart dialog box.
i. Click OK. The Format Chart dialog box closes.

6. Save the report and optionally, preview it.
For more information about Financial Reporting Web Studio, select the Using EPM with Oracle Financials Cloud link
from the All Books for Oracle Financials Cloud page of the Oracle Help Center at https://docs.oracle.com.
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5  Implement AI Apps for Financials

AI Apps Implementation Workflow  
Follow these high-level steps to get started with AI Apps for Financials. Refer to the sections in this chapter to get more
detailed implementation instructions where you need them.

Before you start
Before implementing AI Apps for Financials, make sure that the Cloud ERP environment for your organization meets
this criteria:

• Must not be on a government pod

• Should be live in production with at least 3 months of consumable data to benefit from high quality
recommendations and prediction results

Step 1: Create users and assign roles
Create the users and roles in Oracle Cloud Financials to enable communication and data exchange for AI Apps and
schedule and run the data extracts in Oracle BI Publisher. Create the user to access the administrator tasks in AI Apps
for ERP.

Step 2: Set up AI Apps
On the Connections page in Oracle AI Apps for ERP, make the connections for your integrations with your Oracle
Financials service. If you use the early payment discounts feature, choose your preferred conversion currency and the
APR range for discount offers on the Settings page.

Step 3: Opt in for AI Apps for Financials features
In the Setup and Maintenance work area of Oracle Financials, enable the applicable features.

Step 4: Configure the campaign email template
In the Setup and Maintenance work area of Oracle Financials, manage the profile options and configure the value for the
email sender name and address. Personalize the email template to represent your company's identity. If you won't be
using email campaigns, you can skip this step.

To understand AI Apps features and setting them up, watch these videos:

• Intelligent Account Combination Defaulting Setup Instructions

• Dynamic Discounting Introduction

• Dynamic Discounting Campaign Management

• Dynamic Discounting Intelligent Payment Discounts
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Set Up AI Apps  

Connect AI Apps to Financials Cloud  
If you aren't using early payment discounts, you can skip this step. To use standing offers for early payment discounts to
suppliers based on AI and the settings that you specify, you must connect using the appropriate credentials.

1. Sign in to AI Apps for ERP as a user with the Application Implementation Consultant role.

To access the AI Apps for ERP application:

a. If you're not already on the Home page, click the company logo in the page header.
b. Use the arrow in the tab carousel to scroll, and click the Tools tab.
c. In the Quick Actions section, click AI Apps Administration.

This will open the AI Apps Administration UI in a separate browser tab.
d. Select AI Apps for ERP.

This will open the AI Apps for ERP UI in a separate browser tab. You can bookmark this page to directly
access the applications in the future or share this with users who will manage early payment discounts.

2. Click Connections.
3. In the Oracle Financials Cloud section, click Edit.
4. Enter these values:

Field Value

User Name
 

The user name you created for the integration user. For example AIA_INTEGRATION.
 

Password
 

The password associated with that user name.
 

Note:
If you change the password later, you must also update it here. The passwords must match.
 

URL
 

The URL to your Oracle Financials Cloud instance. For example, https://<fusion-
instance>.oraclecloud.com.
 

5. Click Save.

Related Topics
• Create the AI Integration User and Role

Connect AI Apps to Business Intelligence  
To ingest data for AI model training and supplier categorization with Oracle BI Publisher, you must connect using the
appropriate credentials.

1. Sign in to AI Apps for ERP as a user with the Application Implementation Consultant role.
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To access the AI Apps for ERP application:

a. If you're not already on the Home page, click the company logo in the page header.
b. Use the arrow in the tab carousel to scroll, and click the Tools tab.
c. In the Quick Actions section, click AI Apps Administration.

This will open the AI Apps Administration UI in a separate browser tab.
d. Select AI Apps for ERP.

This will open the AI Apps for ERP UI in a separate browser tab. You can bookmark this page to directly
access the applications in the future or share this with users who will manage early payment discounts.

2. Click Connections.
3. In the Oracle Business Intelligence section, click Edit.
4. Enter these values:

Field Value

User Name
 

The user name you created for the Business Intelligence user. For example AIAPPS_BIP.
 

Password
 

The password associated with that user name.
 

Note:
If you change the password later, you must also update it here. The passwords must match.
 

URL
 

The URL to your Oracle Financials Cloud instance. For example, https://<fusion-
instance>.oraclecloud.com.
 

5. Click Save.
After the Oracle Business Intelligence section is completed and saved, the data ingestion and model training will begin.
You can expect to have a working model for AI Apps features after 8 to 12 hours, depending on the volume of data.
Some large data sets may require more time. Check the Oracle Data Science section on the Connections page to view
the status of the training. For details, see Train Models for AI Apps Features and Download Evaluation Reports.

Related Topics
• Create the Business Intelligence User and Role

Train Models for AI Apps Features and Download Evaluation Reports  
AI Apps uses machine learning models with algorithms that are trained and optimized on your data. Without creating
large volumes of test data, you can understand the potential performance of an AI Apps feature using the model
evaluation report.

For a model evaluation report, you need to connect AI Apps to Business Intelligence and train the model. After it’s
trained, you can download the evaluation report. Here’s how you can do that:

1. Sign in to AI Apps for ERP as a user with the Application Implementation Consultant role.
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To access the AI Apps for ERP application:

a. If you're not already on the Home page, click the company logo in the page header.
b. Use the arrow in the tab carousel to scroll, and click the Tools tab.
c. In the Quick Actions section, click AI Apps Administration.

This will open the AI Apps Administration UI in a separate browser tab.
d. Select AI Apps for ERP.

This will open the AI Apps for ERP UI in a separate browser tab. You can bookmark this page to directly
access the applications in the future.

2. Click Connections.
3. Verify that AI Apps is connected to Business Intelligence. If it's not, connect now. For details, see Connect AI

Apps to Business Intelligence.
4. If you're setting up a nonproduction environment to train an AI model, enter the latest P2T refresh date to

replace your existing training data with the data that's been in production up to the refresh date.
a. In the P2T refresh section, click Edit.
b. In the P2T Refresh window, Latest P2T Refresh Date field, select the latest date that the connected

tenant was refreshed from production.
c. Click Update Training Data.

The AI model will now be trained on the latest data copied from production. This ensures that there’s enough
and relevant data to train the model and generate the evaluation report.

In the Oracle Data Science section, you can view the status of the model training for the feature.
5. After the model training is complete, click Download Report for the feature.

Use the report to understand the potential performance of the feature on your data. In the evaluation report for the
Intelligent Account Combination Defaulting feature, you can find the promotion code to opt in to the feature.

Set the Conversion Currency  
If you aren't using early payment discounts, you can skip this step. The application uses the reporting currency to
display monetary values in a single currency.

Values in a different currency than the reporting currency are converted using the conversion rate type you select for
display purposes only. No accounting values are changed or saved based on these settings, but they're required for
viewing purposes.

1. Ensure that you have already connected AI Apps to Oracle Business Intelligence and that data ingestion is
complete.

2. Sign in to AI Apps for ERP as a user with the Payables Administrator role.
3. Click Settings.
4. Select the reporting currency to use by default for display purposes.
5. Select your preferred conversion rate type.
6. Click Save.

Set the APR Range for Recommendations  
If you aren't using early payment discounts, you can skip this step. The adaptive intelligence model uses the APR range
you specify on the Settings page to control the rates for early payment discount offers.
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The range you specify also controls the APR range that helps users analyze supplier discount opportunities. The range
that you set should reflect the business goals of your buying organization.

For example, these business goals can include your expected return rate on working capital as a floor and can also
provide control over a ceiling rate to constrain the recommendations. The range should reflect your organization's
minimum expected return and maximum discount allowed to establish your business goals through AI models for APR
recommendations.

By default, the range is set as 0% to 40%. It should be a priority to establish a range that is appropriate for your
organization. As a guideline, a typical industry benchmark for APR ranges would be 8% as a minimum value and 50% as
a maximum value, delivering discount ranges from .2% to 12.5% based on days paid early.

1. Ensure that you have completed the steps to set conversion currency.
2. Sign in to AI Apps for ERP as a user with the Payables Administrator role.
3. Click Settings.
4. Enter the desired minimum and maximum values for the APR range.
5. Click Save.

Create Users and Assign Roles  

Create AI Apps Admin Users  

Admin users who can access AI Apps for ERP for initial setup and ongoing management of connections and supervisory
controls, must have the Application Implementation Consultant role. Your IT security manager can assign this role from
the security console in your Oracle Financials Cloud environment.

Create the Business Intelligence User and Role  
The AIAPPS_BIP_ROLE role is required in Oracle Business Intelligence (BI) to extract values from Oracle Financials Cloud
and train the AI Apps machine-learning models.

Note:   It's best practice to create a dedicated user, however, you may prefer to create and add this role to an existing
user. To avoid any disruption of the services, ensure that this user is excluded from password reset policies.

1. Connect to the Oracle Financials Cloud as a user with the IT Security Manager role.
2. In the Navigator menu, under Tools, click Security Console. You may need to click More to expose the Tools

options.
3. Create the AIAPPS_BIP_ROLE:

a. On the Roles page, click Create Role.
b. Enter these values:

Field Value

Role Name
 

AIAPPS_BIP_ROLE
 

117



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 5
Implement AI Apps for Financials

Field Value

Role Code
 

AIAPPS_BIP_ROLE
 

Role Category
 

BI - Abstract Roles
 

c. Click Next three times.
d. On the Role Hierarchy stop, click Add Role.
e. In the Add Role Membership window, search for and select BIAuthor, then click Add Role Membership.
f. Search for and select BIPDataModelDeveloper, then click Add Role Membership.

g. Click Cancel to close the window.
h. Click Next two times.
i. Click Save and Close, and then click OK.

4. Create a user account named AIAPPS_BIP with the AIAPPS_BIP_ROLE role:

a. Click Users.
b. On the User Accounts page, click Add User Account.
c. In the User Information section, enter values for all of the required fields.
d. Rename the User Name value to AIAPPS_BIP.
e. Click Add Role.
f. In the Add Role Membership window, search for and select AIAPPS_BIP_ROLE, then click Add Role

Membership.
g. Click Done to close the window.
h. Click Save and Close.

5. Schedule a process to import the user and role security data as follows:

a. From the Navigator menu, in the Tools section, select Scheduled Processes.

You may need to click More to expose the Tools options.
b. Click Schedule New Process and select the values shown here:

Field Value

Type
 

Job
 

Name
 

Import User and Role Application Security Data
 

c. Click OK.
d. In the Process Details window, click Submit.
e. Make a note of the process ID, and then click OK.
f. Click Refresh until the status of the process ID you noted shows as succeeded.
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Create the AI Integration User and Role  
If you aren't using early payment discounts, you don't need the integration user, so you can skip this step.

The integration between Oracle Financials Cloud and AI Apps for ERP requires that a specific user and its associated
roles exist. This user and its roles provide the required privileges to connect to the Oracle Financials Cloud REST
endpoint.

1. Connect to Oracle Financials Cloud as a user with the IT Security Manager role.
2. In the Navigator menu, under Tools, click Security Console. You might need to click More to expose the Tools

options.
3. Create the AIA_FIN_DISCOUNTS role:

a. In the navigation pane, click Roles.
b. Click Create Role.
c. Enter these values:

Field Value

Role Name
 

AIA_FIN_DISCOUNTS
 

Role Code
 

AIA_FIN_DISCOUNTS
 

Role Category
 

Financials - Job Roles
 

d. Click Next.
e. On the Privileges tab, click Add Function Security Policy.
f. In the Add Role Membership window, search for and select

AP_MANAGE_BUYER_DISCOUNT_OFFERS_PRIV, then click Add Privilege to Role.
g. Click Cancel to close the window.
h. Click Next four times.
i. Click Save and Close, and then click OK.

4. Create the user account named AIA_INTEGRATION:
a. Click Users.
b. On the User Accounts page, click Add User Account.
c. In the User Information section, enter values for all the required fields.
d. Rename the User Name value to AIA_INTEGRATION.

5. Add roles to the AIA INTEGRATION user:
a. Click Add Role.
b. Search for and select AIA_FIN_DISCOUNTS, then click Add Role Membership.

This role is to access the REST API for standing offers.
c. Click Done to close the window.
d. Click Save and Close.
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6. Schedule a process to import the user and role security data as follows:

a. From the Navigator menu, in the Tools section, select Scheduled Processes.

You might need to click More to expose the Tools options.
b. Click Schedule New Process and enter these values:

Field Value

Type
 

Job
 

Name
 

Import User and Role Application Security Data
 

c. Click OK, and then click Submit.
d. Make a note of the process ID, and then click OK.
e. Click Refresh until the status of the process ID you noted shows as succeeded.

Roles for AI Apps Users  
You can manage additional users and assign them to specific roles through the IDCS console for the AI Apps service.
The roles determine which tasks users can perform in the application.

This table describes the roles that you can assign and the privileges associated with them.

Role Privileges Description

Adaptive Intelligent ERP Payables Discounts
Read Only
 

• View early payment discounts

• View campaigns

Views supplier categorizations and supplier
details, such as early payment discount
enrollments.
 

Adaptive Intelligent ERP Payables Discounts
Manager
 

• Manage early payment discounts

• Manage campaigns

Manages user tasks, such as identifying
and enrolling suppliers into early payment
programs.
 

Adaptive Intelligent ERP Payables Administrator
 

• Manage connections

• Manage early payment discounts

• Manage campaigns

• Manage settings

Manages all activities related to the
administration and setup of AI Apps for ERP,
 such as setting up connections and business
policies.
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Create AI Apps Users  
Follow these steps to access the AI Apps for ERP application and to create discounts administrators or users. If you
aren't using early payment discounts, you can skip these steps.

1. Sign in to your Oracle Financials account as an IDCS user administrator of the service assigned to the
Application Implementation Consultant role.

2. To access the AI Apps for ERP application:
a. If you're not already on the Home page, click the company logo in the page header.
b. Use the arrow in the tab carousel to scroll, and click the Tools tab.
c. In the Quick Actions section, click AI Apps Administration.

This will open the AI Apps Administration UI in a separate browser tab.
d. Select AI Apps for ERP.

This will open the AI Apps for ERP UI in a separate browser tab.

Tip:  You can bookmark this page to directly access the applications in the future or share this with
users who will manage early payment discounts.

3. To set up dynamic discounting administrators and users in the IDCS Console for AI Apps:
a. On the user menu, select User Administration.

The user menu will update to include more options.
b. Select Admin Console.
c. In the Identity Domain section, click Oracle Cloud Services.
d. On the Oracle Cloud Services page, click AI Apps.
e. Under Resources, select Application Roles.
f. On the Application Roles page, expand the row for one of the following roles, and select Manage

Assigned Users.
- Adaptive Intelligent ERP Payables Administrator
- Adaptive Intelligent ERP Payables Discounts Manager
- Adaptive Intelligent ERP Payables Discounts Read Only

g. Select Show Available Users.
h. Search for and select the applicable user, and then click Assign.
i. Click Close.

Opt In for AI Features  

Opt In for Intelligent Account Combination Defaulting  
The entry of a promotion code is required to display this feature as a selectable option within the Setup and
Maintenance area of your Oracle Cloud ERP environment. After you enter the promotion code, you can turn this feature
on or off within your environment.
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You can find the promotion code in the evaluation report that's generated after data ingestion and model training. For
details, see Train Models for AI Apps Features and Download Evaluation Reports.

1. Sign in to Oracle Financials Cloud as a user with the Application Implementation Consultant role.
2. To enter the promotion code, follow these steps:

a. On the Navigation menu, select My Enterprise > Enterprise.
b. Click Manage Promotions Codes.
c. Click Enter Promotion Code.
d. Enter your promotion code and click Save and Close.
e. Check that your code is displayed as Intelligent Account Combination Defaulting for Invoices Promotion

Code. If it isn’t, contact your Oracle representative.
3. On the Navigation menu, select My Enterprise > Setup and Maintenance.
4. On the Setup list in the page header, select Financials.
5. Click Change Feature Opt In.
6. If not already expanded, expand Financials, and then expand Supplier Invoice Processing.
7. Select the Payables row, and then click the Features edit icon.
8. Select the row for the feature named Intelligent Account Combination Defaulting for Invoices, then click the

Enable box in that row.
9. Click Save and Close, and then click Done.

10. Click Done again to return to the Financials setup page.
Predictions will be served after you opt in to.

Opt In for Early Payment Discount Offers  
In the Setup and Maintenance work area, enable the early payment offers feature.

1. Log in to Oracle Financials Cloud as a user with the Application Implementation Consultant role.
2. On the Navigation menu, select Setup and Maintenance.
3. On the Setup list in the page header, select Financials.
4. Click Change Feature Opt In.
5. If not already expanded, expand Financials, and then expand Supplier Invoice Processing.
6. Select the Payables row, and then click the Features edit icon.
7. Ensure that the feature named Early Payment Offers is enabled, then click the Features edit icon in that row.
8. In the Early Payment Offers feature dialog box, select both options (Standing Offers and Dynamic Offers).
9. Click Save and Close, and then click Done.

10. Click Done again to return to the Financials setup page.

Configure Campaigns  

Email Campaigns  
You can send early payment discount offers to suppliers by email using campaign management. You can use the
template in Business Intelligence to structure the layout, subject, and content of your emails. The template contains
information that suppliers need like offer details, currently eligible invoices, and discount calculation.

Suppliers can use these emails to take an action on the offer. The emails contain response buttons and the responses
are automatically processed and applied while processing payment requests.
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Supplier's Response Result

Accept a one-time offer Only the invoices that are ready for payment are listed in the email and selected for early payment.
Other eligible invoices might be included in future email offers.

Enroll into a standing offer All invoices are paid early on the same terms going forward.

Decline the offer Invoices aren’t carried on to payment. Eligible invoices might be included again in future email offers.

Unsubscribe No further emails from the current campaign are sent to the supplier.

If suppliers accept a one-time offer or enroll into standing offers, payments managers can select the applicable early
payment invoices when they initiate payments in Oracle Payables.

Configure Email Templates  
You need to configure an email template in Business Intelligence to create campaigns in Oracle AI Apps for ERP. You can
use this template as the layout and it contains the subject of the email.

1. From the Oracle Analytics Publisher, download the template that you’ll use to configure your email template.
a. Sign in to the Oracle Analytics Publisher with the AI_APPS_BIP role using the http://hostname.com:port/

xmlpserver URL.
b. On the header, click Catalog.
c. On the Catalog page, Folders pane, expand Shared Folders Financials Workflow Notifications Payables

and click Invoices.

You can see the reports and folders in the Invoices folder appear in the display area.
d. In the Dynamic Discount Campaign Offer Email Notification row, click More and from the menu, select

Customize.

This creates a copy of the template in the Invoices folder and the Dynamic Discount Campaign Offer
Email Notification page is displayed with the created copy.

e. On the Dynamic Discount Campaign Offer Email Notification layout, click Edit.

The template is downloaded to your machine.
2. Edit the template according to your campaign requirements.

You can replace the placeholder with your company name, revise the notification text, and change the look and
feel of the template.
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3. Upload the edited email template to the Publisher.

a. Go back to the Dynamic Discount Campaign Offer Email Notification page and click Delete on the
existing template.

b. On the confirmation dialog, click OK.
c. Click Add New Layout.
d. In Upload or Generate Layout section, click Upload.
e. On the Upload Template File window:

i. In the Layout Name field, enter Dynamic Discount Campaign Offer Email Notification.
ii. In the Template File field, click Choose File and select the template you edited.

iii. In the Type field, select RTF Template.
iv. In the Locale field, select English.
v. Click Upload.

You can see the edited template uploaded on the page.
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Configure Email Sender Name and Address  
After creating a template, configure the campaign email sender’s name and address.

1. Set the ORA_FND_BPM_FROM_EMAIL_ADDRESS_ENABLED profile option.

a. From the Fusion home page, go to the Setup and Maintenance work area.
b. Click the Tasks icon and in the menu, click Search.

c. Search for the Manage Administrator Profile Values task and open it.
d. On the Manage Administrator Profile Values page, Profile Option Code field, enter

ORA_FND_BPM_FROM_EMAIL_ADDRESS_ENABLED.
e. Click Search.
f. In the RA_FND_BPM_FROM_EMAIL_ADDRESS_ENABLED: Profile Values region, Profile Value field,

select Yes.
g. Click Save and close.
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2. Enter the email sender’s name and address.

a. Go back to the Setup and Maintenance work area.
b. Click the Tasks icon and in the menu, click Search.
c. Search for the Manage Task Configurations for Financials task and open it.
d. On the BPM worklist page, search for the DynamicDiscountCampaignOffer task.
e. Click the task to open it and click the Edit task icon.
f. In the task, click the Notifications tab.

g. Click More to view the additional fields.
h. In the Email: From and Reply To address field, enter the sender’s email address in quotes.
i. In the Email “From:” Display Name field, enter the sender’s display name in quotes.

j. Verify that the Make notification actionable check box is selected.
k. Click the Save icon to save your changes and click the Commit task icon to commit your changes.

Configure Recipients  
You can configure supplier contacts as supplier portal users so that they can receive offers and respond to them by
email.
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Here’s how you can create a user role, add it to your supplier roles, and then create the contact:

1. Create the supplier portal user role for early payment administration.
a. Sign in to Oracle Financials Cloud using the IT security manager role.
b. Go to Navigator > Tools > Security Console.
c. In the navigation pane, click Roles.
d. Click Create Role.
e. Enter a role name and code. Select the role category as Financials - Job Roles.
f. Click Next.

g. On the Privileges tab, click Add Function Security Policy.
h. In the Add Function Security Policy dialog box, search for Manage Early Payment Offers in Supplier

Portal and select the matching result. Then, click Add Privilege to Role.
i. Close the dialog box.
j. Click Next to skip to the Summary page.

Note:  For creating this role, you don’t need to enter any values after adding the function security
policy. You can directly skip to the Summary page.

k. Click Save and Close, and then click OK.
2. Add the role to supplier user roles.

a. Sign in to Oracle Financials Cloud using the Supplier Administrator or Supplier Manager role.
b. Go to Navigator > My Enterprise > Setup and Maintenance.
c. In the Tasks panel tab, click Search.
d. Search for Manage Supplier User Roles and select the matching task.
e. Click Actions > Select and Add.
f. Search for the role that you created earlier and click Apply.

3. Create the supplier contact.
a. Go to Navigator > Procurement > Suppliers.
b. Search for the supplier name.
c. On the Supplier page, select the Contacts tab and click Edit.
d. Select an existing contact that you want to edit or create a new contact.
e. Ensure that the contact has an email address.
f. Scroll down to the User Account section.

g. Select the Create user account check box.
h. The default supplier portal roles are automatically populated. Click Select and Add to add the role you

created earlier.
i. Click Submit.

4. Schedule a process to import the user and role security data as follows:

a. Go to Navigator > Toold > Scheduled Processes.

You might need to click More to expose the Tools options.
b. Click Schedule New Process and select the values shown here:

Field Value

Type
 

Job
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Field Value

Name
 

Import User and Role Application Security Data
 

c. Click OK.
d. In the Process Details window, click Submit.
e. Make a note of the process ID, and then click OK.
f. Click Refresh until the status of the process ID you noted shows as succeeded.

The supplier receives an email confirmation for their new supplier portal access and request to reset their password.
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6  Rapid Implementation Spreadsheets

Create Chart of Accounts, Ledger, Legal Entities, and
Business Units in Spreadsheets  
Represent your enterprise structures in your chart of accounts, ledger, legal entities, and business unit configuration to
track and report on financial objectives and meet reporting requirements. These components provide the underlying
structure for organizing financial information and reporting.

The chart of accounts within the ledger facilitates:

• Aggregating data from different operations, from within an operation, and from different business flows

• Consistent definitions to your stakeholders in compliance with legislative and corporate reporting standards
and aids in management decisions

Rapid implementation is a way to configure a financial enterprise and financial reporting structures quickly using sheets
in a workbook that upload lists of:

• Companies (legal entities)

• Ledgers by country

• Business units

• Chart of accounts and segment values

• Segment value hierarchies

• Financial sequences

• Required subledger accounts

Once the sheets have been uploaded, the application creates:

• Chart of accounts structure and instance

• Segment value hierarchies

• Key accounts such as retained earnings

• Required subledger accounts

• Accounting calendar

• Primary ledger for each country represented on the legal entities sheet

• Legal entities and their locations

• Business units

• Document and journal sequencing

• Set of Financial Reporting reports

• Three account groups

CAUTION:  Once you begin using your chart of accounts, calendar, and ledger, making changes to their fundamental
attributes is neither recommended nor supported. This includes your chart of account segments, including the
segment labels as well as other characteristics of those segments, and your calendar structure or pattern.
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The following figure illustrates the flow of the enterprise structure setup.

Legal entities (companies) incur transactions that are identified by business units with business functions. Transactions
that are recorded in subledgers are transferred to the ledger. A ledger is characterized by a calendar, a currency, and a
chart of accounts. A chart of accounts consists of segments, some of which are assigned segment labels, such as cost
center, natural account, and primary balancing segment. Legal entities can be assigned primary balancing segment
values.

Additional information for some of the common setup objects depicted in the figure follows:

• Legal Entity: Identifies a recognized party with rights and responsibilities given by legislation, which has the
right to own property and the responsibility to account for itself.

• Business Units: Performs one or many business functions that can be rolled up in a management hierarchy. A
business unit can process transactions on behalf of many legal entities. Usually a business unit has a manager,
strategic objectives, a level of autonomy, and responsibility for its profit and loss. When created through the
spreadsheet, all available business functions are automatically enabled for the business unit.
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• Ledger: Maintains records and is a required component in your configuration. The rapid implementation
process:

◦ Creates primary ledgers by combining the chart of accounts, calendar, and currency as well as other
required options defined in the rapid implementation workbook.

◦ Assigns the standard accrual subledger accounting method to the primary ledger. The subledger
accounting method is used to group subledger journal entry rule sets together to define a consistent
accounting treatment.

◦ Creates a General Ledger balances cube for each ledger with a unique chart of accounts and calendar
combination. Each segment is created as a dimension in the balances cube along with the standard cube
dimensions.

• Subledger: Captures detailed transactional information, such as supplier invoices, customer payments, and
asset acquisitions. Uses subledger accounting to transfer transactional balances to the ledger where they're
posted.

• Chart of Accounts: Configures accounts that consist of components called segments. Accounts are used to
record balances and organize financial information and reporting.

• Segment: Identifies one of the components of a chart of accounts, which when combined with other segments,
creates an account combination for recording transactions and journal entries. A segment is associated with a
value set, which provides the set of values for that segment, along with the formatting and validation for those
values.

• Segment Label: Identifies certain segments in a chart of accounts and assigns special functionality to those
segments.

◦ Balancing Segment: Ensures that all journals balance for each balancing segment value or combination
of multiple balancing segment values for financial processes and reports. The three balancing segment
labels are: Primary Balancing Segment, Second Balancing Segment, and Third Balancing Segment.

◦ Natural Account: Determines the account type (asset, liability, expense, revenue, or equity) and specific
categorization of the financial activity. Facilitates General Ledger processes, such as closing of the
income statement accounts to retained earnings at the beginning of a new fiscal year.

◦ Cost Center: Facilitates grouping of natural accounts by functional cost types, accommodating tracking
of specific business expenses across natural accounts.

With the rapid implementation workbook you can also:

• Create more than one hierarchy for any of your chart of accounts segments during initial setup. You can also
create additional hierarchies and hierarchy versions, as well as update existing hierarchy versions, after the
initial setup is done by uploading the rapid implementation spreadsheet data.

• Create sequences for each legal entity or ledger based on the predefined country defaults. Document
sequences are created for: Payables invoices, Payments, Receivables invoices, Receivables credit memos,
Receivables adjustment activities. Reporting and accounting journal sequences are created for subledger
journals and General Ledger journals.

Related Topics
• How Charts of Accounts, Ledgers, Legal Entities, and Business Units Are Created Using Spreadsheets
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How Charts of Accounts, Ledgers, Legal Entities, and
Business Units Are Created Using Spreadsheets  
The rapid implementation process for setting up an enterprise structure includes several steps.

1. Downloading the Rapid Implementation for General Ledger workbook.
2. Entering data into the sheets.
3. Verifying the entered data and resolving any errors.
4. Uploading the chart of accounts file.
5. After successful upload of the chart of accounts file, uploading the general ledger, legal entity, and business

unit file with the rest of the configuration.
The rapid implementation enterprise structure configuration is meant to be used as a one-time initialization. To
the extent that you want to make certain allowed modifications to the configuration, you generally have to make
those changes directly in the applications. After initial upload of the ledger, legal entity, and business unit file, the
fundamental accounting configuration framework is only created once and is permanently set. This framework includes
the ledger and its assigned chart of accounts, calendar and currency assignment, and the associated definitions of
those components.

Workbook Overview
You can download the workbook in one of two ways:

1. In the Setup and Maintenance work area, go to the Manage Chart of Accounts Configurations task in the
Financial Reporting Structures functional area and click the Download Setup Template button.

2. In the Setup and Maintenance work area, create an implementation project that includes the Define Financials
Configuration for Rapid Implementation task list. Download the workbook using the Create Chart of
Accounts, Ledger, Legal Entities, and Business Units in Spreadsheet task.

The workbook includes the following sheets:

• Instructions

• Chart of Accounts, Calendar, and Ledger

• Business Units

• Companies and Legal Entities

• Natural Accounts

• Financial Sequences

New sheets for entering segment values and hierarchies for additional segments of your chart of accounts can be
created automatically. After you enter the segments on the Chart of Accounts, Calendar, and Ledger sheet, click Add
Segment Sheets or Generate Additional Hierarchy.

Note:  The rapid implementation process creates a standard ledger. You can convert a standard ledger to an average
daily balance ledger before the first period is opened by selecting the Enable average balances check box on the
Specify Ledger Options page.
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Instructions
Review the Instructions sheet for important information about how to use the workbook and submit the accounting
configuration. The sheet includes:

• Data preparation requirements

• Setup object concepts

• Best practices and recommendations

• Instructions on how to create additional hierarchies or hierarchy versions

• A completed workbook with sample data, which you can use to familiarize yourself with how to enter data,
preview the sample report, and generate required upload files

Chart of Accounts, Calendar, and Ledger
Enter the data to create your chart of accounts, calendar, and ledger.

CAUTION:  Once you begin using your chart of accounts, calendar, and ledger, making changes to their fundamental
attributes is neither recommended nor supported. This includes your chart of account segments, including the
segment labels as well as other characteristics of those segments, and your calendar structure or pattern.

The following figure shows an example of the Chart of Accounts, Calendar and Ledger sheet with sample values.

An explanation of each field on the sheet follows.

• Name: Enter the name of your primary ledger.
A primary ledger is created for each unique country that's entered in the Companies and Legal Entities sheet.
A country code is appended to the name that you specify. For example, one legal entity is based in the United
States and another in Canada. If you enter the ledger name of InFusion Ledger, two primary ledgers are
automatically created, InFusion Ledger US and InFusion Ledger CA.
All of the primary ledgers that are created use the same chart of accounts, account hierarchies, and accounting
calendar. Legal entities and their primary balancing segment values are assigned to the primary ledger of their
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respective countries. If the addresses provided for the legal entities on the Companies and Legal Entities sheet
are all in the same country, then only one primary ledger is created.

• Currency: If you're not entering legal entities and only a single ledger should be created by the rapid
implementation configuration, enter the ledger currency in which you want to maintain accounting for in that
ledger. If you're entering legal entities, leave this field blank. The currency is automatically supplied based on
the country.

• Period Frequency: Select from among the list of available frequencies for the ledger calendar.

CAUTION:  For the accounting calendar created using the Rapid Implementation Enterprise Structure
solution, the choices of patterns are limited to the period frequency and adjusting period options that are
available for selection in the spreadsheet. It isn't possible to make alterations to the pattern or specified
fiscal year start date once the calendar has already been created. The accounting periods of the calendar are
automatically named using a preset format. If you want to change these period names, you have a limited
window of time to make those changes. Use the Manage Accounting Calendars page in the application to
make the changes before the accounting calendar is being used actively, such as when one of its accounting
periods has been set to a status of Open.

• Adjusting Periods: Select the number of periods used to segregate closing, auditing, or other adjustments in
General Ledger. The entries are tracked in the adjusting period and not in your monthly activity.

• Fiscal Year Start Date: Enter the start date of the accounting calendar. The date can't be changed after the
submission of the configuration.

CAUTION:  If you plan to run translations, enter a fiscal year start date for the entire accounting year that's
before the first period for which you intend to run translations. You can't run translation in the first defined
period of an accounting calendar. For example, if your fiscal year starts on January 1, and you want to start
translations for the period of Mar-17, then you should select a fiscal year start date of January 1, 2016. Also
when determining the fiscal year start date, you might want to consider whether you plan to load history.

• Segment: Enter the names for your segments. The value sets are created from the segments.

• Segment Label: Select segment labels to assign special functionality to segments.

Segment labels specifying the segment's purpose, such as balancing, cost center and natural account, can only
be assigned once to a chart of accounts segment. The Primary Balancing Segment and Natural Account
Segment labels must be assigned, while the other segment labels are optional. Segments that are assigned
these two particular labels cannot be assigned any other label. However, segments that are assigned the other
remaining labels can also be assigned additional labels, provided they're not Primary Balancing Segment or
Natural Account Segment.

The Intercompany Segment label assignment is optional. If assigned, an Intercompany sheet is automatically
added to the workbook when you select the Add Segment Sheets button. Use the sheet to enter your
intercompany values and hierarchies. When you upload the chart of accounts file, the application creates
a new value set for the Intercompany segment with the values that you entered. If you want to assign the
Intercompany segment the same values as the Primary Balancing segment, copy all the parent and child values
from the Companies and Legal Entities sheet to the Intercompany sheet.

If you enable segment value security on the primary balancing value set, the security enforcement won't
conflict with the Intercompany segment because the value sets for the two segments will be different. The same
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holds true if you enable segment value security on the intercompany value set. Security enforcement won't
conflict with the Primary Balancing segment.

If you plan to use related value sets and create a relationship between the segments that involves your primary
balancing segment or intercompany segments, there won't be a conflict of values because the value sets are
different.

Note:  If you want to assign the Intercompany segment the same value set as the Primary Balancing segment,
you can change the value set assignment from the Manage Chart of Accounts Configurations page after you
upload the chart of accounts configuration and before you upload the financial structures for the chart of
accounts. If you decide to go with the same value set for both segments, you won't be able to change the
value set association later on, once the ledger is assigned to the chart of accounts.

Note:  For the posting process to apply intercompany balancing, you must select the Enable intercompany
accounting option on the Specify Ledger Options page.

• Short Prompt: Enter a short name for the segment, which is used on applications pages.

• Display Width: Enter the segment size. Select the size carefully and leave room for growth. For example, if you
have 89 cost centers, enter 3 for the display length to allow for more than 100 cost centers in the future.

• Add Segment Sheets: Select this button to create sheets for additional segments. Sheets are provided only for
the Company and Natural Accounts segments.

From the new segment sheet, you can click the Generate Additional Hierarchy button to create more than
one hierarchy for any chart of account segment. A worksheet is then automatically created and populated with
the data already entered for that segment. Change this data as required for the new hierarchy. You can create
additional hierarchies during initial setup, or after the initial setup is done.

CAUTION:  You can't change the chart of accounts, accounting calendar, or currency for your ledgers after the setup
is created.

Business Units
Enter the name of your business units and related default legal entities.

The following figure shows an example of the Business Units sheet with sample values for the Name and Default Legal
Entity Name fields.

Business units are created with the names that you enter. You can enter more than one business unit per ledger. Based
on the default legal entity specified for the business unit in the Business Units sheet, the business unit is assigned the
primary ledger to which its default legal entity is assigned.
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Companies and Legal Entities
Enter parent and child values for your Company segment, which is the segment that's assigned the Primary Balancing
Segment label on the Chart of Accounts, Calendar, and Ledger sheet. You can create up to nine levels of parent values
to roll up your companies to meet corporate and local reporting requirements.

Enter your legal entities for the child values with the address, registration number, and reporting unit registration
number. The registration number identifies legal entities registered for your company and recognized by law for
which you want to record and perform transactions. The reporting unit registration number identifies the lowest level
component of a legal structure that requires registrations.

The following figure shows part of the Companies and Legal Entities sheet with sample values. The sheet includes
columns for different levels of parent values, the child value, and company description. The Legal Entity columns
include name, identifier, country, address information, and registration numbers.

To create additional hierarchies for the company segment for reporting or other purposes, click the Generate
Additional Hierarchy button. A worksheet is automatically created and populated with the data already entered for that
segment. Change this data as required for the new hierarchy. You can create additional hierarchies during initial setup,
or after the initial setup is done.

When a new hierarchy sheet is created, the name for that sheet is derived by adding a counter to the sheet name. For
example, when you click Generate Additional Hierarchy on the Companies and Legal Entities sheet, the new sheet
is named Companies and Legal Entities 1. When you click Generate Additional Hierarchy again, another sheet is
generated with the name Companies and Legal Entities 2.

Note:  Adding legal entity information isn't supported on a new hierarchy sheet for the Company segment.

Natural Accounts
Enter account hierarchies, account values, and specify account types.
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The following figure shows part of the Natural Accounts sheet with sample parent and child values, descriptions, and
account type.

• Parent: Enter parent account values to define hierarchies. Hierarchies are used for chart of accounts mappings,
revaluations, data access sets, cross-validation rules, and segment value security rules. The balances cube and
account hierarchies are also used for financial reporting, Smart View queries, and allocations.

• Child: Enter child account values to define the postable accounts.

• Description: Enter descriptions for the segment values.

• Account Type: You must assign an account type to each account value. Account types are used in year-end
close processes and to correctly categorize account balances for reporting. Select from among general account
types and expanded account types. The general account types are: Asset, Liability, Owner's Equity, Revenue,
Expense. Expanded account types provide specialized functionality and are used to:

◦ Identify the intended usage of your natural account values to facilitate automation and enable
completion of other required setup objects. For example, assign the Asset - Intercompany Receivable
and Liability - Intercompany Payable expanded account types. The Rapid Implementation process then
automatically creates a chart of accounts level intercompany balancing rule, which is a required setup for
the application to perform intercompany balancing.

◦ Automatically generate fully defined initial Financial Reporting reports and Account Groups based on
your enterprise structure.

Examples of expanded account types include:

◦ Asset - Accounts Receivable: For Receivables receipt methods

◦ Liability - Accounts Payable: For Payables common options

◦ Owner's Equity - Retained Earnings: For General Ledger ledger options

◦ Revenue - Top Revenues Parent Account: For sample reports and account groups

◦ Expense - Top Operating Expenses Parent Account: For sample reports and account groups

You must assign the Revenue - Top Revenues Parent Account and Expense - Top Operating Expenses
Account account types to the parent accounts that are your highest level and comprehensive revenue and
operating expenses accounts. You can optionally assign the account type of Expense - Top Cost of Sales
Parent Account, if it's applicable for your scenario.

The Generate Financial Reports and Account Groups process, which is automatically submitted when the
accounting configuration is created in the application, generates a set of Financial Reporting reports and
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account groups according to the accounting configuration defined in the workbook. The top parent accounts
are used as the basis for deriving the accounts referenced in the reports and in the Account Groups.

The immediate descendants of the top parent accounts are used to define the rows on the reports. Depending
on whether both the top operating expense and top cost of sales accounts are tagged, different variations
of the income statements are generated. If the optional top cost of sales account is provided, the Financial
Reporting reports that are income statements also include a gross margin section.

CAUTION:  Assign account types carefully. If you assign an incorrect account type to a natural account
segment value, accounting entries are recorded incorrectly and financial statements are inaccurate.
Misclassified accounts are also potentially handled incorrectly at year end, with actual balances either getting
zeroed out to retained earnings, or accumulating into the next year.

• Financial Category: Select a value to identify groups of accounts for reporting with Oracle Transactional
Business Intelligence. You can add financial categories to parent values. Accounts that are tagged with
expanded account types are automatically assigned a financial category. You can override the default category
or leave it out.

Note:  The list of accepted values is defined in the FINANCIAL_CATEGORY lookup_type.

• Generate Additional Hierarchy: To create additional hierarchies for the natural account segment for reporting
or for other purposes, click the Generate Additional Hierarchy button. A worksheet is automatically created
and populated with the data already entered for that segment. Change this data as required for the new
hierarchy. You can create additional hierarchies during initial setup or after the initial setup is done.

Financial Sequences
Enable document or journal sequences to assign unique numbers to transactions to meet legal requirements.

The following figure shows the Financial Sequences sheet with sample values for the Restart and Initial Value columns.

Document sequences are created for these transactions: Payables invoices, Payments, Receivables invoices, Receivables
credit memos, Receivables adjustment activities. Reporting and accounting journal sequences are created for Subledger
journals and General Ledger journals.

For each transaction, you can provide values for the following fields:

• Restart: Set when to restart the numbering: Annually, Monthly, Never.

• Initial Value: Specify the beginning number in the sequence.
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How Worksheets Are Processed
After you complete the worksheets, proceed with validation, sample report preview, and file upload.

1. On the Chart of Accounts, Calendar, and Ledger sheet, click the Step 1: Validate button.

The validation checks the worksheets for missing or inappropriate setups. Errors are marked as actionable
items in a validation report sheet that's dynamically generated. You can review the anomalies and make
the corrections as indicated. The Field column on the validation report notes the issue. Click the text link
to navigate to the appropriate field in the sheet that must be updated. When the validation is successful, a
message appears with the option of previewing a sample of the reports that are automatically generated as
part of the enterprise configuration.

The following figure shows the message that appears after a successful validation.

If you select to preview the sample report, a new sheet is automatically created called Preview Report. The
preview incorporates elements of the setup that you provided. The rows on the report are derived based on the
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top parent revenue and expense account values that you tagged on the Natural Accounts sheet. The preview
also reflects the reporting hierarchy for your natural accounts.
The following figure shows an example of the sample Financial Reporting report.

You can use the preview to validate whether the hierarchy setup aligns to your reporting needs. If the natural
account hierarchy requires adjustments, this is your chance to make those corrections before actually creating
the account hierarchies in the application. You can modify your enterprise structure setup, validate the
spreadsheet, and preview the revised sample reports for as many times as you need. The account hierarchies
are created when you finally submit the accounting configuration in the rapid implementation spreadsheet.

2. Click Step 2: Generate Chart of Accounts File. The process generates a data file called ChartOfAccounts.xml
with the entered chart of accounts and hierarchies setup data. Save the file to a network or local drive.

3. Click Step 3: Generate Ledger, LE, and BU File. The process generates a data file called
FinancialsCommonEntities.xml with the entered ledger, legal entities, and business unit setup data. Save the
file to a network or local drive.

4. From your implementation project, go to the Upload Chart of Accounts task. The Upload Enterprise Structures
and Hierarchies process is launched.

5. Accept the default selection of the Upload Enterprise Structure option.
6. Click Browse and select the first file that you saved called ChartOfAccounts.xml.
7. Click Submit.
8. Verify that the process completed without errors or warnings.
9. From your implementation project, go to the Upload Ledger, Legal Entities, and Business Units task. The

Upload Enterprise Structures and Hierarchies process is launched.
10. Accept the default selection of the Upload Enterprise Structure option.
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11. Click Browse and select the second file that you saved called FinancialsCommonEntities.xml.
12. Click Submit.
13. Verify that the process completed without errors or warnings.

An individual set of the following Financial Reporting reports is generated for each ledger that's defined within the rapid
implementation accounting configuration. If multiple primary ledgers are created as part of your configuration, a set of
Financial Reporting reports is generated for each ledger.

• Income Statement

• Consolidated Income Statement

• Rolling Quarterly Income Statement

• Rolling Monthly Income Statement

• Trial Balances by Ledger Currency

• Trial Balances by Entered Currency

The process also generates three account groups. These include two for the infolets, Revenues and Expenses, and
one for the Close Monitor called Close Monitor Summary Income Statement. A set of these three account groups is
generated for the balances cube, to be shared among all the ledgers that are part of that balances cube.

Additional Hierarchies After Initial Setup
To create additional hierarchies and hierarchy versions, or to update existing hierarchy versions after the initial setup:

1. Click the Generate Additional Hierarchy button on the applicable segment sheet. A new worksheet is
automatically created and populated with the data already entered for that segment. Change the data as
required.

2. Click the Generate File for This Hierarchy Only button. This generates a .zip file for the particular hierarchy.
3. From your implementation project, go to the Upload Chart of Accounts task. The Upload Enterprise

Structures and Hierarchies process is launched.
4. Select the Upload Hierarchy option.
5. Select from among the following options and provide values for the required parameters:

a. Create hierarchy: Select to create another account hierarchy. Specify the value set, tree code, and start
date.

b. Create version: Select to render a new version of an existing account hierarchy. Specify a value set, tree
code, tree version, and start date.

c. Update existing version: Select to edit an existing version of an account hierarchy. Specify a value set,
tree code, and tree version.

6. Click Choose File and select the .zip file that you saved earlier.
7. Click Submit.

Related Topics
• Overview of Trees

• How Financial Reporting Reports and Account Groups Are Generated

• Manage Setup Using Implementation Projects
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Overview of Cross-Validation Rules in General Ledger  
You can use cross-validation rules to determine the valid account combinations that can be dynamically created as
users enter transactions or journal entries.

Once enabled, a cross-validation rule determines whether a selected value for a particular segment of an account
combination can be combined with specific values in other segments to form a new account combination.

For example, your organization has determined that the company Operations can't use the Marketing cost center.
You can define a cross-validation rule such that, if the company is Operations, then validate that the cost center isn't
Marketing. New account combinations have to satisfy all of the cross-validation rules enabled for the chart of accounts
before they can be created.

Entry and Maintenance
This table describes the different methods that you can use to enter and maintain cross-validation rules.

Method Navigation What You Can Do

Manage Cross-Validations page, Rules tab In the Setup and Maintenance work area, use
the Manage Cross-Validation Rules task in the
Financial Reporting Structures functional area.

Note:  As an alternative navigation, select
the Manage Cross-Validation Rules
action on the Manage Chart of Accounts
Configuration page.

• Create

• Edit

• View

• Upload to the interface table

• Download from the interface table

• Import from the interface table into the
application

• Download from the application

• Submit the Manage Account
Combination Validation Rules process

Cross-Validation Rules Import file-based data
import (FBDI)

Access the FBDI template from either of these
locations:

1. In the Oracle Help Center (https://
docs.oracle.com), open the Oracle Fusion
Cloud Financials File-Based Data Import
(FBDI) for Financials guide.

2. In the Setup and Maintenance work area,
 use the Manage Cross-Validation Rules
task in the Financial Reporting Structures
work area.

Create and edit large volumes of cross-
validation rules

Create Cross-Validation Rules desktop-
integrated spreadsheet

In the Setup and Maintenance work area,
 use the Create Cross Validation Rules in
Spreadsheet task in the General Ledger
functional area.

Create a large volume of cross-validation rules.

To edit error messages for cross-validation rules, use this task in the Setup and Maintenance work area:

• Offering: Financials

142



Oracle Fusion Cloud Financials
Getting Started with Your Financials Implementation

Chapter 6
Rapid Implementation Spreadsheets

• Functional Area: Financial Reporting Structures

• Task: Manage Messages for General Ledger

Tip:  When you export or import cross-validation rules to a new instance using an export or import project in the
Functional Setup Manager, you must add the Manage Messages for General Ledger task before the Manage
Cross-Validation Rules task. You must export or import the messages before exporting or importing the cross-
validation rules.

Existing Account Combinations
If existing account combinations violate newly enabled cross-validation rules, those account combinations continue to
be valid. Before you disable existing account combinations that violate your rules and that you no longer use, move the
balances in those accounts to the correct accounts. Then disable the account combinations to prevent further posting.
Best practice is to define and enable cross-validation rules before account combinations are created, transactions or
journal entries are imported or entered, and balances are loaded.

Related Topics
• Cross-Validation Rules

• Considerations for Cross-Validation Rules

• Create Cross-Validation Rules in a Spreadsheet

• How Cross-Validation Rule Violations Are Managed

• Update Existing Setup Data

Cross-Validation Rules Spreadsheet  
The rapid implementation solution provides a template for defining cross-validation rules in a spreadsheet.

Cross-validation rules determine whether a selected value for a particular segment of an account combination can be
combined with specific values in the other segments to form a new account combination.

In the Setup and Maintenance work area, use the following:

• Offering: Financials

• Functional Area: General Ledger

• Task: Create Cross Validation Rules in Spreadsheet

Note:  The spreadsheet can only create cross-validation rules. To update existing cross-validation rules, use the
Manage Cross-Validation Rules task in the Setup and Maintenance work area.

Spreadsheet Overview
The cross-validation rules spreadsheet includes two sheets. One sheet has instructions and the other sheet provides
the template for creating the cross-validation rules. The Instructions sheet includes:

• An overview
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• An explanation of the template

• Steps to fill in the template

• An example

The following figure shows the Create Cross-Validation Rules sheet.

The following table describes each field and column on the sheet.

Field or Column Description

Worksheet Status
 

The upload results for the worksheet. The application updates this field when you submit the
spreadsheet.
 

Chart of Accounts
 

The chart of accounts for which the cross-validation rules are defined.
 

Changed
 

The indicator that the row has been updated. The application updates this field.
 

Row Status
 

The upload results for the row. The application updates this field when you submit the spreadsheet.
 

Name
 

The name that uniquely identifies the cross-validation rules in a deployment.
 

Description
 

The purpose for the cross-validation rule.
 

Error Message
 

The explanation to users for why the attempted combination violates the cross-validation rule.
 

Condition Filter Segment
 

The segments of the chart of accounts that constitute the condition filter.
 

Condition Filter Values
 

The values of the condition filter segment that determine whether the cross-validation rule is
evaluated.
 

Validation Filter Segment
 

The segments of the chart of accounts that constitute the validation filter.
 

Validation Filter Values The values of the validation filter segment used to enforce a new account combination.
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Field or Column Description

  

Note:  Cross-validation rules created from the spreadsheet are automatically enabled and don't have a start or end
date.

Steps to Use the Template
To use the spreadsheet template:

1. Select the chart of accounts.
2. Enter a suitable name, description, and error message in the respective columns.
3. Select the condition filter segment. To add more than one segment to the condition filter, use the next row.

Repeat the rule name and select the condition filter segment.
4. Provide the segment values that constitute the condition filter in the Condition Filter Values column.

◦ To select multiple detail values, enter the detail values separated by commas. For example:
5501,5502,5503.

◦ To select a range, enter the detail values separated by hyphens. You can enter multiple ranges using the
comma as the range separator. For example: 3001-3030,3045-3200.

◦ To select all detail values that are descendants of a parent, enter the parent value. You can enter multiple
parent values using commas as the separator. For example: 1000,2000.

◦ You could enter all of the previously listed values in the same cell. For example:
1000,2000,3001-3030,3045-3200,5501,5502,5503.

◦ To specify that a detail value should not be selected, prefix the value with the less than and greater than
symbols <>. These symbols represent the Does Not Equal operator. For example, <>5501 means the rule
applies when the segment value isn't equal to 5501.

- This operator can't be used for parent values or ranges.
- This operator can't be used more than once for the same rule and segment.

5. Select the validation filter segment. To add more than one segment to the validation filter, use the next row.
Repeat the rule name and select the validation filter segment.

6. Provide the segment values that constitute the validation filter in the Validation Filter Values column in the
same way as specified for the condition filter.

7. Review the data that you entered and click Submit to publish the cross-validation rules.
8. Review the upload results in the Worksheet Status and Row Status fields.

Related Topics
• Cross-Validation Rules

• Considerations for Cross-Validation Rules

• Create Cross-Validation Rules in a Spreadsheet

• Update Existing Setup Data
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Overview of Cash Management Rapid Implementation  
Use Microsoft Excel templates to rapidly implement the following setup objects:

• Banks

• Bank Branches

• Bank Accounts

Functional Setup Manager Tasks
The following are the Functional Setup Manager tasks that are required to be performed to rapidly create the setup
objects data. To access these tasks, create an implementation project that includes the Define Financials Configuration
for Rapid Implementation task list:

• Create Banks, Branches, and Accounts in Spreadsheet: Downloads the rapid implementation excel spreadsheet
template. Enter the bank, branch, and bank account data in this spreadsheet, and generate the data file to be
loaded.

• Upload Banks, Branches, and Accounts: Launches the Upload Banks, Branches, and Accounts process with the
data file to be uploaded as the parameter. You must upload the data file generated from the previous task.

Preparing Data
Prepare your bank, branch, and account information to enter into the spreadsheet template.

• Bank information requires the country, name, and number.

• Branch information requires name, number, BIC code, and alternate name.

• Account information requires name, number, currency, legal entity, type, and IBAN.

After you finish preparing the data in the spreadsheet, click the Generate Banks, Branches, and Accounts File button.
Save the generated XML file.

Loading Data
Use the following steps to load your data.

• In the Setup and Maintenance work area, create an implementation project that includes the Define Financials
Configuration for Rapid Implementation task list. From your implementation project, go to the Upload Banks,
Branches, and Accounts task. This task launches the Upload Banks, Branches, and Accounts process.

• Select the XML file you have saved earlier and submit the process.

• Verify in the process monitor that the process completed successfully.

• Review the banks, branches, and accounts created.
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Best Practices
The following are recommended best practices:

• Determine the Legal Entity for each bank account. The Legal Entity must be associated to a primary ledger.

• Determine the use for each bank account: Payable, Receivable, or both.

• Determine the Cash and Cash Clearing account for each bank account. Enter the entire account combination
based on your chart of accounts, for example 01-000-1110-0000-000.

Related Topics
• How You Process Electronic Bank Statements

Tax Configuration Workbook  
Use the Tax Configuration Workbook to upload all common tax setups. For example, create standard state, county, and
city sales tax rates within the US using this workbook.

Tax Configuration Workbook Worksheets
The Tax Configuration Workbook is a Microsoft Excel spreadsheet template with six common tax setup worksheets:

Worksheet Predefined Data Content Setup Options

Manage Tax Regimes
 

Yes
 

Option 1: Use the tax regimes that are already
included for 28 countries. You can modify or
delete any of the predefined tax regimes where
needed.
 
Option 2: Use tax partner content for the Tax
Configuration Workbook.
 

Manage Taxes
 

Yes
 

Option 1: Use the taxes that are already
included for 28 countries. You can modify
or delete any of the predefined taxes where
needed.
 
Option 2: Use tax partner content for the Tax
Configuration Workbook.
 

Manage Tax Zones
 

No
 

Prepare the tax zones with the appropriate
corresponding geographies.
 

Manage Rates
 

No
 

Option 1: Prepare the tax rates.
 
Option 2: Use tax partner content for the Tax
Configuration Workbook.
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Worksheet Predefined Data Content Setup Options

Manage Tax Thresholds
 

No
 

Option 1: Prepare the tax thresholds or
maximum taxes.
 
Option 2: Use tax partner content for the Tax
Configuration Workbook.
 

Manage Tax Recovery Rates
 

No
 

Option 1: Prepare the tax recovery rates.
 
Option 2: Use tax partner content for the Tax
Configuration Workbook.
 

Related Topics
• Example of Creating Tax Setup Using the Tax Configuration Workbook

• Example of Creating Tax Setup Using Tax Partner Content in the Tax Configuration Workbook

Example of Creating Tax Setup Using the Tax
Configuration Workbook  
This example shows how you can create standard sales tax rates within the US using the Tax Configuration Workbook.
You can create sales tax rates at state, county, and city levels using this method.

Here's a summary of key decisions you make in this scenario:

Decision to Consider In This Example

What tax setup are you creating?
 

Tax Rates
 

Do you have exception rules for calculating
US sales tax on transactions?
 

No
 

Do you use tax partner content?
 

No
 

Creating Tax Setup
Follow these steps to create tax rates in the Tax Configuration Workbook:

1. Navigate to the Manage Tax Regimes page.
2. Click the Rapid Setup Spreadsheets button and select Download Tax Configuration Workbook.
3. Save the Tax Configuration Workbook in your local directory.
4. Review the details on the Instructions sheet of the workbook.
5. For the Manage Tax Regimes and Manage Taxes worksheets, use the predefined content for the US sales tax.

You can modify or delete the predefined content where needed.
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6. Use the instructions and the column help text to populate the required setups in the Manage Rates worksheet.
7. After completing the Tax Rates worksheet, go to Instructions sheet again.
8. Click Generate CSV File. It performs theses actions:

◦ Saves the entire Tax Configuration Workbook data in a comma separated values (CSV) file.

◦ Saves the CSV file into a single compressed file attachment.

9. Save the compressed file attachment in your local directory.
10. Click the Rapid Setup Spreadsheets button and select Upload Tax Configuration Workbook.
11. Select the compressed file that you saved earlier.
12. Click Open and then click Upload.
13. Note the process ID and click the Monitor Upload and Download Processes tab.
14. Click Refresh and ensure that the process ID completes with a Succeeded status.

◦ If the status of the upload process is Succeeded, you can view your setups using the search criteria on
the page.

◦ If the status of the upload process isn't Succeeded, your upload has failed. Check the details in the
corresponding error log, correct any file errors, and reupload the file.

Related Topics
• Example of Creating Tax Setup Using Tax Partner Content in the Tax Configuration Workbook

Guidelines for Uploading Customer Data Using a
Simplified Spreadsheet  
Use the Upload Customers from Spreadsheet process to upload customer data using the simplified Customer Import
FBDI (File-Based Data Import) template.

The single upload process performs all the operations of generating a batch, transferring the customer data in the
spreadsheet template to the interface tables, and importing the data from the interface tables into Oracle Applications.

Download the simplified Customer Import FBDI template and prepare your customer data. The template contains
an instruction sheet and sample data to help guide you through the process of entering your customer information:
Customers, Contacts, Reference Accounts, Customer Bank Accounts.

Note:  You can also use the Customer Import process to download a Customer Import FBDI template, available from
the FBDI Customer Data Model, to prepare and upload customer data into Receivables and the Trading Community
Model registry.

Set Up Related Customer Information
Set up the business objects you need in advance of the customer data upload.

This can include:

• Account address sets: Set up the reference sets you need for your customer account sites.

• Customer profile classes: Set up one or more profile classes for your customer records.
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• Reference accounts: Set up general ledger accounts that you intend to use as reference accounts for customers.

• Customer bank accounts: Set up banks and bank account information.

• Tax information: Set up tax registration numbers and tax rate codes using Oracle Tax.

• Descriptive flexfields.

Enter Data in the Spreadsheet Columns
Enter data in the designated columns in each of the four worksheets: Customers, Contacts, Reference Accounts,
Customer Bank Accounts.

These rules apply to entering data in columns:

• Column labels with an asterisk (*) denote required columns.

• Use the Show Extensible Attributes and Hide Extensible Attributes buttons to show or hide additional
columns.

• Don't move or delete existing columns, and don't insert new columns.

• Enter data in the correct format. In most cases, the columns will format the data that you enter according to the
requirements of the upload.

• To remove existing values from specific fields in an existing customer profile, enter the exclamation point
character (!) in the corresponding column.

• Each customer must have a unique combination of these values:

◦ Customer number.

◦ Customer account number.

◦ Customer site number.

• Each customer contact must have a unique person number.

Examples of Validations in Customer Spreadsheet
Upload Data  
During upload processing, the Upload Customers from Spreadsheet process checks for unique values in certain
columns of the Customers and Contacts worksheets. If the values are unique, the record is created. If the values aren't
unique, the record fails with an upload error.

The columns with this validation are:

• Customers worksheet:

◦ Customer Number

◦ Account Number

◦ Site Number

• Contacts worksheet:
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◦ Person Number

The following sections provide examples of the validation process. The assumption in these examples is that all records
have the same Source System value.

Customers Worksheet: Customer Number Validation
The Customer Number validation looks for a unique combination of values across the Customer Number, Customer
Source Reference, and Customer Name columns.

The records in the following table fail the uniqueness validation on the customer number, because, for the same
customer name, there are two different customer numbers and customer source references.

Customer Number Customer Source Reference Customer Name

VCORP 256113
 

VCORP 256113
 

Vision Corporation
 

VCORP 256114
 

VCORP 256114
 

Vision Corporation
 

The records in the following table also fail the uniqueness validation on the customer number, because, for the same
combination of customer number and customer source reference, there are two different customer names.

Customer Number Customer Source Reference Customer Name

VCORP 256113
 

VCORP 256113
 

Vision Corporation
 

VCORP 256113
 

VCORP 256113
 

Vision ABC Corporation
 

The records in the following table also fail the uniqueness validation on the customer number, because, for the same
customer number, there are two different customer source references.

Customer Number Customer Source Reference Customer Name

VCORP 256113
 

VCORP 256113
 

Vision Corporation
 

VCORP 256113
 

VCORP 256114
 

Vision Corporation
 

In like manner, the Account Number validation looks for a unique combination of values across the Account Number,
Account Source Reference, and Account Description columns. The Site Number validation looks for a unique
combination of values across the Site Number, Site Source Reference, and Site Name columns.

Contacts Worksheet: Person Number Validation
The Person Number validation looks for a unique combination of values across the Person Number, Person Source
Reference, and First Name and Last Name columns.
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The records in the following table fail the uniqueness validation on the person number, because, for the same
combination of person number and person source reference, there are two different first name and last name
combinations.

Person Number Person Source Reference First Name Last Name

1000228801
 

1000228801
 

Rodney
 

Jones
 

1000228801
 

1000228801
 

John
 

Jones
 

The records in the following table also fail the uniqueness validation on person number, because, for the same person
number, there are two different person source references.

Person Number Person Source Reference First Name Last Name

1000228801
 

1000228801
 

Rodney
 

Jones
 

1000228801
 

1000228802
 

Rodney
 

Jones
 

The records in the following table pass the uniqueness validation. The validation process allows a combination of two
different person numbers and person source references with the same first name and last name combination. This is
because two different people may have the same name.

Person Number Person Source Reference First Name Last Name

1000228801
 

1000228801
 

Rodney
 

Jones
 

1000228802
 

1000228802
 

Rodney
 

Jones
 

Budget Uploads to General Ledger  

Overview of Budget Uploads  
In Oracle General Ledger, you can load budget data to perform variance reporting.

If you use a third-party budgeting application or don't use a budgeting application, there are two ways to load budgets
into the GL Balances Cube.

• Importing Budget Data from a Flat File: Export budget data from your budgeting application to a comma
separated values .csv file. Use the Import General Ledger Budget Balances file-based data import (FBDI)
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to prepare and generate flat files in a .csv format. You can use Oracle ADF Desktop Integrator correction
worksheets to correct validation errors, delete rows with errors, and resubmit the corrected error rows.

Note:  For more information about FBDI, see the Oracle Fusion Cloud Financials File-Based Data Import
(FBDI) for Financials guide.

• Importing Budget Data from a Spreadsheet: You can access the budget load spreadsheet from the General
Accounting Dashboard. Enter, load, and correct budget data in the ADF Desktop Integrator spreadsheet
tool. Use this tool to prepare and load budget data for multiple ledgers and periods with a common chart of
accounts instance. The list of values and the web picker help you select valid values. This simplified data entry
reduces errors and alerts you to errors as you enter the data in the spreadsheet. Error correction is done in the
same spreadsheet.

Here are some points to consider when preparing your budget data.

• You can maintain budget amounts only for detail accounts. However, if you're also using budgetary control, you
can configure your setup to maintain budget amounts for summary accounts.

Note:  For more information about budgetary control setup, refer to the Budgetary Control chapter,
Enterprise Options section in the Oracle Fusion Cloud Financials Using Financials for the Public Sector guide.

• If you already uploaded your budget and you perform another upload using the same criteria, the upload
process overwrites the existing amounts with the amounts from the new upload.

The following figure shows the process flow for budget upload. Prepare your budget data, upload it using a spreadsheet
or flat file, and report on the budget data.
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CAUTION:  When the GL Balances Cube is rebuilt, the process retains the budget balances as well as the actual
balances. Only the budget balances loaded using the spreadsheet or flat file through the GL Budget Balances
interface table are retained. Create reports in Smart View or Financial Reporting to verify that the budget data was
loaded correctly.

Related Topics
• Import Budget Data from a Spreadsheet

• How General Ledger Budget Balance Import Data Is Processed

• Overview of Enterprise Options
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Import Budget Data from a Spreadsheet  
You can use the Create Budgets spreadsheet to enter, load, and correct budget data. To open the spreadsheet, navigate
to the General Accounting Dashboard and select the Create Budgets in Spreadsheet task.

Budget Import
The spreadsheet uses the Oracle ADF desktop integration add-in for Excel, which is the same add-in used by the Create
Journals spreadsheet. The spreadsheet uses an interface table called GL_BUDGET_INTERFACE and requires the Budget
Entry role. The budget import uses the Accounting Scenario value set for the budget being loaded. The Run Name is
used as an identifier for the imported data set.

The spreadsheet budget import:

• Supports multiple ledgers but a single chart of accounts instance

• Allows multiple calendars and periods

• Supports entered currencies in addition to the ledger currency

• Contains user-friendly lists of values

• Performs most validations on the worksheet

• Secures values by data access sets

Note:  The spreadsheet includes a Row Status column that shows if the rows upload successfully or with errors. Use
the spreadsheet where the data was entered to enter the corrections.

How General Ledger Budget Balance Import Data Is Processed  
Use the Import General Ledger Budget Balances file-based data import (FBDI) to load budget data from external
sources for upload to the GL balances cube. You can download a budget spreadsheet template to use to prepare your
budget data.

The template contains an instruction sheet to help guide you through the process of entering your budget information.

To access the template, complete the following steps:

1. Navigate to the Oracle Fusion Cloud Financials File-Based Data Import (FBDI) for Financials guide.
2. In the table of contents, click General Ledger.
3. Click Import General Ledger Budget Balances.
4. In the File Links section, click the Excel template.

Follow these guidelines when preparing your data in the worksheet:

• Enter the required information for each column. Refer to the tool tips on each column header for detailed
instructions.

• Don't change the order of the columns in the template.

• You can hide or skip the columns you don't use, but don't delete them.
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Settings That Affect the General Ledger Budget Balances Import Process
The Import General Ledger Budget Balances template contains an instructions tab and a tab that represents the table
where the data is loaded.

The Instructions and CSV Generation tab contains information about:

• Preparing the budget data.

• Understanding the format of the template.

• Entering budget data.

• Loading the data into the interface table and the GL balances cube.

The GL_BUDGET_INTERFACE tab is where you enter information about the budget data that you adding, such as the
ledger, budget name, periods, segment values, and amounts.

How General Ledger Budget Balance Import Data Is Processed
To load the data into the interface table:

1. Click the Generate CSV File button on the instructions tab to create a CSV file in a .zip file format.
2. Save the .zip file locally.
3. Navigate to the Scheduled Processes work area.
4. Select the Load Interface File for Import process.
5. For the Import Process parameter, select Validate and Upload Budgets.
6. For the Data File parameter, select the file that you saved in step 2.

To load the data from the interface table to the balances cube:

1. Navigate to the Scheduled Processes work area.
2. Select the Validate and Upload Budgets process.
3. Enter values for the Run Name parameter.
4. If the process ends in error or warning:

a. Review the log and output files for details about the rows that caused the failure.
b. Navigate to the General Accounting Dashboard work area.
c. Select the Correct Budget Import Errors task to download the budget corrections worksheet.
d. Correct the entries in the worksheet and resubmit the Validate and Upload Budgets process.

Related Topics
• Overview of External Data Integration Services for Importing Data

• Import Budget Data from a Flat File

• Load Budgets

• External Data Integration Services for Importing Data

Import Budget Data from a Flat File  
Use the upload budgets processes to integrate budget information from other budgeting applications such as Oracle
Hyperion Planning.
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Use the Import General Ledger Budget Balances file-based data import (FBDI) to load budget data from external
sources for upload to the GL balances cube.

You can load your budget amounts to the General Ledger balances cube by populating the GL_BUDGET_INTERFACE
table and running the Validate and Upload Budgets process. You can load budgets for multiple periods and for multiple
ledgers with the same chart of accounts in a single load process.

Note:  Budget data isn't loaded to the GL_BALANCES table and only loaded to the balances cube for variance
reporting purposes.

Assigning Values for Columns in the GL_BUDGET_INTERFACE Table
For budget import to be successful, you must enter values in the columns of the interface table that require values.

The following table describes the columns that require values.

Name Value

RUN_NAME
 

Enter a name to identify the budget data set being imported.
 

STATUS
 

Enter the value NEW to indicate that you're loading new budget data.
 

LEDGER_ID
 

Enter the appropriate ledger ID value for the budget amount. You can view the ledger ID for your
ledgers on the Manage Primary Ledgers page. The ledger ID column is hidden by default, but you can
display it from the View Columns menu. If you enter multiple ledgers for the same run name, all of the
ledgers must share the same chart of accounts.
 

BUDGET_NAME
 

Enter the appropriate budget name value for the budget line. You define the budget names in the
Accounting Scenario value set.
 

PERIOD_NAME
 

Enter the period name that you're loading the budget data for. You can load budget data to Never
Opened, Future Enterable, and Open periods only.
 

CURRENCY_CODE
 

Enter the currency for the budget.
 

SEGMENT1 to SEGMENT30
 

Enter valid and enabled account values for each segment in the chart of accounts.
 

BUDGET_AMOUNT
 

Enter the amount in the ledger currency for account types, expense and assets.
 

OBJECT_VERSION_NUMBER
 

For Oracle Cloud implementations, leave this field blank as the application automatically populates
this when you load the data from the secure FTP server. For other implementations, you can set the
column to a value of 1.
 

These columns remain blank because the budget import process either uses these columns for internal processing, or
doesn't currently use them.

• CHART_OF_ACCOUNTS_ID

• CODE_COMBINATION_ID
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• ERROR_MESSAGE

• CREATION_DATE

• CREATED_BY

• LAST_UPDATE_DATE

• LAST_UPDATE_LOGIN

• LAST_UPDATED_BY

• REQUEST_ID

• LOAD_REQUEST_ID

Related Topics
• Overview of External Data Integration Services for Importing Data

Budget Import to Budgetary Control  

Load Budgets  
You can load your enterprise-wide budget, including revenues and expenses, to General Ledger for analysis and
reporting.

If you implement Budgetary Control, you need to also load your expense budget to Budgetary Control to validate your
spending against the budget. Budget can be loaded for any combination of budget segment values for which you have
access to. Budget account combinations are different from the account combinations used in transactions and can be
subject to different validations.

How budget can be loaded into Budgetary Control depends on the source budget type of the control budget. Budget
loaded to certain control budgets can be synchronized with budget in General Ledger, reducing the need to separately
loading it to General Ledger.

Budget Balance Sources
This table explains how budget can be loaded into Budgetary Control and whether they're synchronized with General
Ledger based on the source budget type and processing type.

Source Budget Type Control Budget Processing Type Methods of Loading Budget
Balances

Synchronize Budget Balances
from Budgetary to General
Ledger

EPM Financials Module
 
See Set Up Financials Cloud for
Loading Budget from EPM.
 

Procure to pay • Enter Budget in EPM using
Planning and load using Data
Exchange

• Revise budget in EPM using
Budget Revisions and load it
using the Funds Reservation
action

• Yes
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Source Budget Type Control Budget Processing Type Methods of Loading Budget
Balances

Synchronize Budget Balances
from Budgetary to General
Ledger

Hyperion Planning
 
Can be reclassified to EPM
Financials module
 
See Set Up Oracle Fusion
Financials for Loading Budget from
EPM
 

Procure to pay • Enter budget in EPM using
Planning and load it to using
Data Exchange

• Load budget with File Based
Data Interface (FBDI)

• Enter budget using Enter
Budgets in Spreadsheet task

• Enter budget transfer using
Budget Transfer form from
the Review Budgetary Control
Balances page

• No (if loaded from EPM or use
Budget Transfer)

• Yes (optional, if use
FBDI or Enter Budgets in
Spreadsheet)

Project Management
 

Procure to pay Enter budget in Project
Management and load it during
budget baseline
 

• Not Applicable

Other
 
Can be reclassified to EPM
Financials Module
 

Procure to pay • Enter budget in a third-party
software and load it using
FBDI

• Enter budget using Enter
Budgets in Spreadsheet task

• Enter budget transfer using
Budget Transfer form from
the Review Budgetary Control
Balances page

• No (if use Budget Transfer)

• Yes (optional, if use
FBDI or Enter Budgets in
Spreadsheet)

Other Cash • Enter budget in a third-party
software and load it using
FBDI

• Enter budget using Enter
Budgets in Spreadsheet task

• Enter budget transfer using
Budget Transfer form from
the Review Budgetary Control
Balances page

• Receivables receipt

No

Control Budget
 
Control budget of this type is
known as summary control budget
and is linked to a control budget
of one of the above source budget
types
 

Procure to pay Automatically updated in the
summary control budgets when
the budget balances are imported
to the source detail control budget.
 

• Not Applicable

No Budget
 
Used to track transaction spending,
 not spending against budget
amounts
 

Procure to pay Budget can't be loaded
 

Not Applicable
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Budget Balance Classifications
Budgetary Control can maintain and report budget balances separating initial budget from budget adjustments. This
table explains how these two budget balance classifications are determined based on the methods of loading budget
balances.

Methods of Loading Budget Balances Budget Entry Classification

Load budget with File Based Data Interface
(FBDI)
 

• Initial budget (if you specify budget entry classification as initial budget)

• Budget adjustment (if you specify budget entry classification as budget revision)

Enter budget using Enter Budgets in
Spreadsheet task
 

• Initial budget (if you specify budget entry classification as initial budget)

• Budget adjustment (if you specify budget entry classification as budget revision)

Enter budget transfer using Budget
Transfer form from the Review Budgetary
Control Balances page
 

• Budget adjustment (always)

Enter Budget in EPM using Planning and
load using Data Exchange
 

• Initial budget (if budget period is available for budgeting)

• Budget adjustment (if budget period is open)

Revise budget in EPM using Budget
Revisions and load it using the Funds
Reservation action
 

• Budget adjustment (always)

Enter budget in Project Management and
load it during budget baseline
 

• Initial budget (if budget period is available for budgeting)

• Budget adjustment (if budget period is open)

Receivables Receipt
 

• Budget adjustment (always)

Related Topics
• Project and Grants Management

• Clear Budgetary Control Funds Check or Failures Requests

• Overview of Enterprise Performance Management

• Budgetary Control Validation of Receivables Receipts
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7  External Data Integration

Overview of External Data Integration Services for
Importing Data  
Use External Data Integration Services for Oracle Cloud to load data into the interface tables of Oracle Fusion
Applications from external sources, such as legacy systems and third-party applications.

External Data Integration Services uses file-based data import (FBDI) templates and processes to import data.

The External Data Integration Services components consist of:

• Templates to structure, format, and generate the data file according to the requirements of the target
application tables.

• File-based load process to load the data files into the interface tables.

• Application-specific data import processes to transfer data from interface tables to the application tables in
your Oracle Fusion Applications.

The following flow diagram outlines the steps involved in loading data from external sources.
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For further information, see Using External Data Integration Services for Oracle ERP Cloud (2102800.1) on My Oracle
Support at https://support.oracle.com.

Related Topics
• Using External Data Integration Services for Oracle ERP Cloud

Considerations for Integrating with Financial External
Systems  
Oracle Fusion Applications provides:

• Flexibility for external systems integration.

• Many spreadsheets as an easy method for entering and loading key setup data into the applications.

The following are some of the ways you might use external system integration.

• Tax and conversion rates

• Payroll processing

• Bank statement reconciliation

• Budget preparation

Tax and Conversion Rates
Tax rates may vary depending on the geographical location of the customer or supplier, the type of product, and other
factors.

• If your tax rates do not change frequently:

◦ Enter or copy a tax rate feed of new or updated tax rates into the spreadsheet loader.

◦ Upload the spreadsheet.

Note:  Similar processes are used for foreign exchange conversion rates, which can change daily.

• Few foreign currency transactions: Use the spreadsheet loader.

• Many foreign currency transactions: Use a supplier for a direct load into the Daily Rates open interface. The
application validates the rows in the interface table and then makes changes in the Daily Rates table.

Payroll Processing
If you are processing your payroll using an application other than Oracle Fusion Global Payroll:

• Use a spreadsheet template to load the data and create a postable journal entry in the Oracle Fusion General
Ledger.

• Post the journal entry to reflect the payroll expense on your financial statements.
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Set up the file from the payroll system to summarizes payments by cost center rather than detailed employee data.
Summarized balances data is the level of detail relevant for the financial reporting and provides the confidentiality
required for payroll information,

Note:  Oracle Fusion Financials marks the spreadsheet with clear error messages on the problematic rows, for
example, a new cost center that must be setup, for ease of correction.

Bank Statement Reconciliation
Bank statements are often received daily and follow a fixed format. With Oracle Fusion Cash Management:

• Establish a transfer of the statements from the bank to the open interface.

• Run the automated process to load the bank statement file.

• Run the reconciliation process.

Note:  If there are any errors in the file, the reconciliation process stops. The load process indicates the errors so you
can follow up with the bank and receive a corrected file.

Budget Preparations
There are two approaches to preparing your budgets:

1. For simple budgeting:

◦ Distribute the current actual results and prior budget numbers to the relevant finance professionals using
spreadsheets.

◦ Collect and consolidate the spreadsheets.

◦ Load the spreadsheets to the Essbase cube.

◦ Compare actual results against budgets using all of the Oracle Fusion Financials reporting and analysis
tools, including Account Monitor, Account Inspector, Smart View, and Financial Reporting.

2. For more complex budgeting use Oracle Hyperion Planning on the Oracle Cloud, alongside Oracle Fusion
Financials. Advantages include:

◦ Advanced tools to handle complex budgeting scenarios.

◦ Direct flow of data between the two applications.

◦ Simplified distribution and collection of budget data.

Note:  For more information on external data integration see: Oracle Financials Cloud Implementing Common
Features for Financials guide: External Integration chapter: External Data Integration Services for Oracle Cloud.
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8  Third-Party Integration

Embedded Banking Services with J.P. Morgan  
Embedded banking services with J.P. Morgan provides businesses with a comprehensive view of their financial position
to operate their day-to-day business finance effectively.

Before using this feature, you must first work with a J.P. Morgan implementation team to establish the bank accounts
and the related scope of the services you want to include. Please contact your J.P. Morgan sales/relationship manager.

Note:  This feature is currently in controlled availability and requires a promotion code. To inquire about the
promotion code, log a service request through My Oracle Support. You’ll need to provide the production pod names.

The solution provides integrated banking and payment services enabled from turnkey connectivity between Cloud
ERP and J.P. Morgan Payments for U.S. and Canada customers. It includes synchronization of all bank account master
data, the requisite setup needed to automate funds capture/disbursement, and continuous bank statement retrieval,
processing, and reconciliation.

The integration also provides a seamless onboarding experience by automatically configuring connectivity and
importing bank account master data.

The Banking Configurations functional area supports enablement of the following business flows:

• Banks and Bank Accounts: Configure security credentials and your J.P. Morgan bank, bank branches, and
bank accounts automatically with Oracle Cloud ERP.

• Funds Disbursement: Configure payment and acknowledgment processing setups for disbursements. Process
disbursements seamlessly with J.P. Morgan.

• Funds Capture: Configure direct debit, acknowledgment and lockbox processing setups for receipts. Process
receipts and lockbox seamlessly with J.P. Morgan.

• Bank Statement Processing: Configure bank statement formats and reconciliation setups, and quickly process
and reconcile J.P. Morgan bank statements.

Connectivity and Bank and Bank Accounts
Manage banks, bank branches, and bank accounts using the integration with J.P. Morgan. This maximizes efficiency
and eliminates time-consuming activities through automated maintenance of bank accounts and related reconciliation
configurations. The turnkey bank onboarding uses a J.P. Morgan-specific template to generate the banks, bank
branches, and bank accounts.

Through the integration, the onboarding process automatically retrieves the template from J.P. Morgan's secured SFTP
location and creates the bank master data. Once the bank accounts are created, the process automatically attaches
the business functions and business units, reconciliation configurations, and bank statement transaction creation
rules needed for payables and receivables processing. Users can review the onboarded bank accounts from the bell
notifications.
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Funds Disbursement
Process payment and acknowledgment files for funds disbursement using the integration with J.P. Morgan. Customers
can generate and send payment files in the J.P. Morgan preferred format and retrieve and process disbursement
acknowledgment files.

The integration uses the J.P. Morgan message format based on ISO20022 CGI standards. This format includes payment
by ACH, Wire, and check for the US and Canada. The integration provides the acknowledgment processing feature with
complete automation for file retrieval and processing. It processes L0, L1 and L2 acknowledgment files generated by J.P.
Morgan at various points in the clearing flow. The invoice status changes from Paid to Unpaid for rejected payments,
allowing users to take corrective action. Users receive bell notifications indicating the successful completion or failure of
the payment batch and acknowledgment processing.

Funds Capture - Direct Debit Processing
Process direct debit settlement batch and acknowledgment files using the integration with J.P. Morgan. Customers can
generate and send direct debit settlement batch files in the J.P. Morgan preferred format and retrieve and process direct
debit disbursement acknowledgment files.

The integration uses the J.P. Morgan message format based on ISO20022 CGI standards. This format includes ACH
direct debits for the US and Canada. The integration provides the acknowledgment processing feature with complete
automation for retrieval and processing of bank acknowledgment files. It processes L0, L1, and L2 acknowledgment files
generated by J.P. Morgan at various points in the clearing flow. The receipt status changes from Remitted to Confirmed
for rejected settlements, allowing users to take corrective action in Receivables. See How Receipts are Reversed for more
information. Users receive bell notifications indicating the successful completion or failure of settlement batch and
acknowledgment processing.

Funds Capture – Lockbox
Process intraday lockbox using the integration with J.P. Morgan to enable near real-time customer balances. J.P. Morgan
can provide a remittance service that includes payment advice processing and remittance advice collection from emails
and Excel files. Payment advice and remittance information are collated and combined with the lockbox file, eliminating
the need for manual entry and application.

Bank Statement Processing
Process and reconcile bank statements using the automated integration with J.P. Morgan. This maximizes efficiency
and eliminates time-consuming activities through automatic bank statement processing and reconciliation.

The integration uses the J.P. Morgan CAMT053 bank statement template, based on ISO20022 standards. The use of this
template enables seamless bank statement file retrieval and processing. Features include:

• Regular retrieval and processing of prior day bank statements.

• Automatic creation of new bank statement transaction codes reported on bank statement lines.

• Automatic creation of bank statement transaction creation rules and reconciliation of bank statement lines.

• Automatic unreconciliation and voiding of rejected payments, and reconciliation of the original and rejected
bank statement lines.

• Automatic reversal of rejected direct debit transactions and reconciliation of reversal bank statement lines.

• Automatic generation of bell notifications to confirm completion of the automatic reconciliation process,
including reconciliation exceptions, if any.
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Touchless Expenses with J.P. Morgan Corporate Cards  
The new generation mobile experience with J.P. Morgan corporate cards delivers touchless expense submission and
faster reimbursement.

Receive instant alerts when charges are incurred on J.P. Morgan corporate cards. Use guided correction, intelligent
recommendations, and correct receipt extraction to ease automatic expense submission and approval. Available to
customers with J.P. Morgan corporate cards.

Note:  This feature is currently in controlled availability and requires a promotion code. To inquire about the
promotion code, log a service request through My Oracle Support. You’ll need to provide the production pod names
and the business units that will be using Touchless Expenses.

The Touchless Expenses application is ideally suited for large companies looking to simplify their expense workflow
processes and reimbursement policies.

Key functionality of Touchless Expenses include:

• Real-time expense creation with J.P. Morgan corporate cards.

• Guided help for expenses that require more information.

• Automatic itemization of emailed hotel receipts.

• Automatic submission of completed expenses.

• Intuitive user interface and application experience.

Real-time Expense Creation with J.P. Morgan Corporate Cards
Touchless Expenses users benefit from real-time expense creation when they incur charges on a J.P. Morgan corporate
card.

When users incur charges on their J.P. Morgan corporate card, Touchless Expenses instantaneously creates the
expenses and notifies the user on their mobile device, clearly identifying the expenses requiring more information.
Users can click the notification to provide the missing information.

These corporate card expenses remain in the application with a "Pending final charge" status until the settled charge
arrives. The status is removed and the expense is now ready for submission if no other information is required. Users
see a message: "Final charge posted" at the top of the expense indicating the settled charge has arrived.

Guided Help for Expenses that Require More Information
Expense users follow guided prompts to quickly provide information for incomplete expenses. For example, in some
instances, expenses might require more user input to comply with company policies. There are two ways to access the
guided help: from the notification on the user’s mobile device or from within the Touchless Expenses application. When
an expense user receives a notification on their mobile device after a corporate card charge is incurred, they select the
notification which directs them to a guided experience to complete the expense. From within the application, the user
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selects the message on the top of the landing page indicating action is required on one or more expenses. The guided
help provides clear instructions on how to fill in the required information. This allows users to complete their expenses
easily and as soon as they're incurred.

The guided help supports the following common scenarios:

• Expenses missing simple fields such as expense type, amount, and currency.

• Expenses that require receipt or missing receipt justification.

• Expenses missing more information such as number of attendees and attendee names.

• Expenses violating corporate policies such as amount limits and card usage.

• Potential duplicate expenses.

Automatic Itemization of Emailed Hotel Receipts
The Touchless Expenses application automatically itemizes the hotel receipts emailed by expense users. This
functionality saves the user a significant amount of time and effort that’s typically required to manually itemize hotel
receipts into individual expense lines. To use this functionality, the user needs to email the hotel receipt to the email
address that the company administrator provides. The Touchless Expenses application reads the email receipt and
creates an expense with the individual line items that make up the total reimbursable expense. Once the itemized lines
are extracted from the email receipt, a notification is sent to the expense user’s mobile device showing a summary
of the itemization that’s been created. The application also automatically identifies hotel charges that have a high
probability of being personal expenses and includes them in the itemization.

Automatic Submission of Completed Expenses
Automatic submission allows the user to set up a specific day of the week to have their expenses compiled into a
report and submitted for approval. The company administrator configures this for each business unit and identifies
which days of the week are available for employees to select for automatic submission, after which employees can
turn on auto submission from the Settings page. On the selected automatic submission day, the Touchless Expenses
application compiles all eligible expenses into a single report and submits them for approval. Any expenses that require
more information remain in the application and aren't automatically submitted. By enabling automatic submission, the
expense user’s experience can be fully automated from expense creation to submission.

Intuitive User Interface and Application Experience
Touchless Expenses supports policy enforcement, configuration for company-specific information, attendee capture,
and various types of default values. The application is simplified into four main pages: expense landing page, manual
expense creation page, search page, and settings page. It also provides employees with a seamless first-time user
experience.

Related Topics
• Use Promotion Codes
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